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Abstract 

In the curricula for the Danish high school as well as for the written examination for mathematics 

(regardless of the level), it is evident that CAS tools have a significant role in connection with the teaching 

of mathematics. This thesis investigates the implementation of a CAS tool in a high school and the learning 

outcome of the students in relation thereto. The teacher’s way of organising and exploiting the CAS tool in 

his/her mathematics teaching is also considered since it has a great influence on the students’ work with 

the tool. The findings of the thesis are based on an observation study of high school teaching performed in 

the two mathematical themes Trigonometry and Power Functions, in two different classes, having different 

teachers, where GeoGebra (GG) functions as a CAS tool.  

For the observation study, four research questions (RQs) have been developed with the Anthropological 

Theory of Didactics (ATD) and the notions of instrumented techniques and orchestration as theoretical 

framework. Additionally, a reference praxeological model (RPM) for both of the themes has been 

established in order to answer the RQs. Each RPM consists of a profile of the theme, involving scholarly 

knowledge, and a presentation of the curriculum and teaching material. Finally, an a priori analysis of the 

CAS tool is included in the RPMs.  

The CAS tool, GG, is found to be a versatile tool where the visualisation and dynamic properties are 

considered a significant strength, in relation to examining several examples of a mathematical object. This 

thesis finds that it may however be difficult for the students to relate the praxis performed in GG to 
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Abstract 

In the curricula for the Danish high school as well as for the written examination for 

mathematics (regardless of the level), it is evident that CAS tools have a significant 

role in connection with the teaching of mathematics. This thesis investigates the 

implementation of a CAS tool in a high school and the learning outcome of the 

students in relation thereto. The teacher’s way of organising and exploiting the CAS 

tool in his/her mathematics teaching is also considered since it has a great influence 

on the students’ work with the tool. The findings of the thesis are based on an 

observation study of high school teaching performed in the two mathematical themes 

Trigonometry and Power Functions, in two different classes, having different 

teachers, where GeoGebra (GG) functions as a CAS tool. 

For the observation study, four research questions (RQs) have been developed with 

the Anthropological Theory of Didactics (ATD) and the notions of instrumented 

techniques and orchestration as theoretical framework. Additionally, a reference 

praxeological model (RPM) for both of the themes has been established in order to 

answer the RQs. Each RPM consists of a profile of the theme, involving scholarly 

knowledge, and a presentation of the curriculum and teaching material. Finally, an a 

priori analysis of the CAS tool is included in the RPMs.  

The CAS tool, GG, is found to be a versatile tool where the visualisation and dynamic 

properties are considered a significant strength, in relation to examining several 

examples of a mathematical object. This thesis finds that it may however be difficult 

for the students to relate the praxis performed in GG to mathematical conceptual 

knowledge in general. The observed students managed to perform techniques in 

relation to GG to a greater extent than establishing a knowledge block. In relation to 

GG related work, both teachers were observed to make use of a projector but, apart 

from this, their orchestrations were very different with regards to how GG could be 

approached as a CAS tool.  
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1.0 Introduction 

The implementation of computer programs1 functioning as digital tools for doing 

mathematics in Danish high schools (henceforth referred to as high schools) is very 

current, as it has a significant priority in the curricula. CAS tools should not only 

function for more complicated symbolic calculations but should also function as 

support for mathematical conceptualisation and skill learning.2  

The question has been raised, though, especially by Jessen, Holm and Winsløw 

(2015), to whether this implementation is favourable, especially when concerning the 

students’ conceptual knowledge of mathematics. Dubinsky and Tall (1991) states, in 

alignment with this problematique: Having a computer to perform the algorithms, 

even to show how those algorithms work is one thing, being able to cope with these 

concepts meaningfully is another (Dubinsky & Tall, 1991, p. 7).   

Moreover, a Danish high school teacher has expressed that (translated from Danish): 

...”as a teacher you have to be idealistic in order to keep up the spirit and teach your 

students such that they are going to be good at doing mathematics when the students 

can do just as good at the exam through a teaching focused on CAS-commands and 

template answers”... (Jessen, Holm, & Winsløw, 2015, p. 13). 

Jessen, Holm and Winsløw (2015) hereby put a focus towards the written 

examination as an influencing factor on the teacher’s orchestrations and the students’ 

instrumented work with CAS tools. 

The teacher’s planning and realisation of the implementation of CAS tools in his/her 

mathematics teaching has evidently got a great influence on what the students learn 

through the work with the tools - especially on which praxeologies the students get to 

establish. Do they only learn how to use the tool, or do they also learn to connect this 

praxis to relevant corresponding mathematical knowledge and vice versa? 

                                                        

1 Such programs cover both CAS tools (understood as programs which can operate with symbolic 

(algebraic) mathematical expressions), spreadsheets, calculators, graphic calculators and geometric 

drawing programs (Jessen, Holm, & Winsløw, 2015, p. 5). 

2 To be noted, it is not necessarily the same CAS tool which is used in all high schools. 
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On this basis, this thesis concerns the study of how the teaching in a high school, in 

two specific mathematical themes (Trigonometry at A-level and Power functions at B-

level) in two separate classes, is performed with respect to the prioritised CAS tool, 

being GeoGebra (GG).3 Especially, the approach of the students towards the CAS tool 

and their development of gestures and instrumented techniques and further which 

type of knowledge they gain in these situations will be studied. This will be analysed 

in order to determine which observable skills, the students establish with respect to 

the CAS tool and to which extent the work with the tool contribute to mathematical 

conceptualisation. The study will be made with reference to the term of praxeologies 

in the Anthropological Theory of Didactics (ATD). Moreover, since the work of the 

students is influenced by how the teacher choose to implement the CAS tool, the 

teacher’s instrumental orchestrations will be studied, as an inevitable perspective for 

the praxeologies established by the students. 

1.1 Structure of the Thesis 

The structure of the thesis is affected by the fact that it concerns an observation study 

of two mathematical themes. On this note, the thesis consists of a common theory 

section (2.0) in which both theory concerning implementation of the CAS tool, 

especially with respect to instrumental genesis and orchestration (section 2.1), as 

well as theory concerning the notions of a reference praxeological model (RPM) and 

mathematical praxeologies (MOs) drawn from ATD (section 2.2). Based on the theory, 

the four research questions (RQs) relating to both of the themes are raised (section 

3.0). Thereafter, the RPMs for the two themes are presented, each involving both a 

profile of the theme based on scholarly knowledge as well as the knowledge to be 

taught in terms of the curriculum, the written examination on the specific level and 

teaching material (sections 4.1 and 4.2). Further, two a priori analyses of the CAS tool 

in relation to the themes are given with a focus on elaborating the main specific 

features in relation to performing instrumented techniques for solving exercises 

within each of the themes (section 4.3). In section 5.0, an introduction of the 

                                                        

3 This is what is chosen as CAS tool in the specific high school and is further elaborated in section 4.3. 
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observation study is given and in section 6.0, the methodology for both performing 

the observations and for analysing the empirical data collected is presented. 

Subsequently, analyses of the empirical data related to each theme are made based on 

the theory and the RPM (sections 7.1 and 7.2). In the sections 8.1 and 8.2, discussions 

related to each of the analyses are made and in section 8.3, a common discussion and 

perspectives is reviewed. Finally, a common conclusion on the results of the thesis is 

given in section 9.0. A figure sketching the structure of the thesis is presented in 

appendix section A.1. It should be noted that references to appendix sections 

henceforth will be denoted by “A.n” (n being a specific number indicating the section), 

throughout the thesis. 

References to webpages in the Bibliography (section 10.0) are shown in brackets with 

a unique reference inside, e.g. “(Webpage: GG-worksheets, 2016)”. 

Even though the thesis splits into two RPMs, two analyses of empirical data and two 

discussions, it is referred to as one observation study because of the common RQs. 

Furthermore, it will be denoted if a section is written by only one researcher. This, in 

the sense that (A) or (L) is put in prolongation of the title of the section, representing 

Anne Kathrine Wellendorf Knudsen and Line Steckhahn Sørensen, respectively. 

 

Navigation 

Tasks presented in the sections 4.1.2 and 4.2.2, concerning the curriculum and the 

written examination in relation to each theme, are coloured green. 

Tasks and techniques presented in the sections 4.3.2 and 4.3.3, concerning the CAS 

tool in relation to each theme, are coloured blue. 

Tasks and techniques presented in the sections 7.1 and 7.2, concerning the analyses 

of the empirical data of the two courses, are coloured black. 
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2.0 Theory 

The purpose of this section is to provide a theoretical framework for analysing and 

discussing the observed teaching courses of this observation study. In particular, the 

notions of instrumental genesis and instrumental orchestration as well as the elements 

of ATD concerning RPMs and MOs will be introduced. This, in order to constitute the 

RQs sought to be answered. 

2.1 Implementation of CAS Tools in Mathematics Teaching 

This section is mainly concerned with theory applicable to describe situations in a 

class room where a CAS Tool is implemented, to be used for both the a priori analysis 

of the CAS tool (section 4.3) and for the analyses of the empirical data (section 7.0). 

To begin with, the historical context of implementation of technology4 in mathematics 

teaching will be elaborated to provide a framework (section 2.1.1). Thereafter, the 

notion of a CAS Tool to be applied in this thesis is established (section 2.1.2) and 

finally, it is elaborated which theoretical terms are chosen to describe both the 

students’ and the teacher’s approaches towards the CAS tool (section 2.1.3). 

2.1.1 Historical Context of the Use of Technology in Mathematics Teaching 

The use of technology in mathematics teaching has been developed and practiced 

over several years, since the late 1960s, ...when, according to Fey [...], mathematicians 

and mathematics educators began to feel that computing could have significant effects 

on the content and emphases of school-level and university-level mathematics (Drijvers 

et al., 2010, p. 91).5  The fascination of the potentials of technology, developed by 

mathematicians and mathematics educators, was triggered from ...the time of the 

development of the mainframe computer in 1942, the first four-function calculator in 

1967, the microcomputer in 1978, and the graphing calculator in 1985 (Drijvers et al., 

                                                        

4 Throughout this subsection the notion technology refers to IT-tools and calculators and is not to be 

confused with the notion of technology presented in ATD (see section 2.2.2). 

5 James T. Fey is an American professor of mathematics education at the University of Maryland and is 

well known for his work on didactics of mathematics (Webpage: James T. Fey, 2016). 
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2010, p. 91). From the mid-1980s, ICMI (International Commission on Mathematical 

Instruction) studies was initiated with the theme of “The Influence of Computers and 

Informatics on Mathematics and Its Teaching at University and Senior High School 

Level”. Here, conjectures were made around to which extent the learning of 

mathematics could be supported by the use of computers, and ...activities of 

exploration and discovery were particularly pointed to (Drijvers et al., 2010, p. 92). A 

great amount of optimism existed towards ...the educational potentialities and 

capabilities of computing technology - such as, visualizing, modeling, and programming 

- [...] not yet supported by evidence (Drijvers et al., 2010, p. 92). Alongside to the ICMI 

studies, where the study papers did not reflect upon theory ...with respect to 

technology and its use in mathematics education... (Drijvers et al., 2010, p. 93), such 

theory was developed during the 1980s. An example of a terminology, describing the 

possibilities and constraints of the use of technology, are the terms of white box and 

black box, introduced by Buchberger6 around 1990. These terms describe the cases 

where the students ...are aware of the mathematics they are asking the technology to 

carry out (Drijvers et al., 2010, p. 93) (white box approach) and when this is not the 

case, the use is that of a black box. Throughout the 1990s, further attention was given 

to the development of the use of technology in the classrooms of mathematics 

teaching (Drijvers et al., 2010, p. 98). Nowadays, the technology devices have become 

smaller and handheld and the possession of a calculator as well as a computer is 

widespread. Furthermore, ...communication has become a more integrated part of 

technology use: software can be distributed using the Internet, and students can work, 

collaborate, and communicate with peers and teachers in digital learning environments 

(Drijvers et al., 2010, p. 98). It remains however an unanswered question what a 

beneficial approach, towards obtaining a learning environment involving technology 

in mathematics teaching, is. Here, beneficial approach relates to cases where the 

potentials of the technology is utilised in an advantageous way. (Drijvers et al., 2010, 

p. 98). 

                                                        

6 Bruno Buchberger is an Austrian professor of Computer Mathematics at Johannes Kepler University 

in Linz (Webpage: Bruno Buchberger, 2016). 
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As an end note for this section, the development of the use of technology for learning 

mathematics in school is noted to be traceable to a significant extent in the teaching 

plans of mathematics in the high school of today (level A and B). Especially, in the 

section of organisation (“3. Tilrettelæggelse”), there is a note under the first 

subsection (“3.1. Didaktiske principper”), concerning didactical principles. Here it 

says that CAS tools should not only be used for the more complicated symbolic 

calculations but should also support skill learning and mathematical 

conceptualisation. Furthermore, there exists a separate subsection called “3.3. It” 

within in the same section, supporting the fact that IT has a significant priority. 

(Undervisningsministeriet, 2013a, 2013b).  

2.1.2 The Notion of CAS Related to This Study 

The classical understanding of CAS is that of a Computer Algebra System, covering the 

algebraic, symbolic aspects of the computer program as a tool and not immediately 

potential graphic, dynamic geometric and spreadsheet aspects (Webpage: Computer 

algebra system, 2016). Nonetheless, in addition to the symbolic, algebraic aspect, 

both the graphic, dynamic and spreadsheets aspects of a computer program are 

considered as covered by the term CAS within this study. This priority is based on the 

fact that the observed classes in this study work with the program GG which both 

functions as a dynamic geometric, a graphical, a spreadsheet and, to some extent, a 

symbolic, algebraic tool (Misfeldt, 2014, p. 27) (see section 4.3). 

Noticeably, there lies a great potential of visualisation when working with this 

program because of the above mentioned features, especially those of the dynamic 

geometric- and graphical tool (Artigue, 2005, pp. 252–253). The option of 

visualisation has the potential of aiding ...more varied access to mathematical problems 

and concepts (Lagrange, 2005, p. 74). For instance, the concept of sine with respect to 

an angle can be visualised to be both a ratio of two sides of a right triangle and a 

second coordinate of a point on the unit circle. Regarding a power function (𝑓(𝑥)), the 

functional value with respect to a given x-value can be accessed through its graphical 

representation and not only analytically. Dubinsky and Tall (1991) further propose 

that visualisation can provide a conceptualisation of the mathematics, since when ...an 

abstract idea is implemented or represented in a computer, then it is concrete in the 
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mind at least in the sense that it exists (electro-magnetically, if not physically) 

(Dubinsky & Tall, 1991, p. 5). In continuation thereof, Dubinsky and Tall point out 

that ...it is generally agreed that ideas are easier to understand when they are made 

more “concrete” and less “abstract” (Dubinsky & Tall, 1991, p. 5). Further, when GG is 

functioning as a dynamic geometric as well as a graphical tool, the visualisation lying 

herein can help provide an acceptance of the existence of the results visually and not 

only through algebraic representations (for instance a formula) (Dubinsky & Tall, 

1991, p. 10). There are however also performed studies with an alertness towards the 

risk that the use of computer software may lead to hiding mathematical concepts 

behind the action made (Confrey et al., 2010, pp. 30–31). For instance, when sin, cos 

and log are solely considered as being commands related to a CAS tool when solving 

problems involving these functions - with a black box effect as a result. 

Further, there exists the option of making exploratory environments when using a 

CAS tool like GG for mathematics teaching. Especially, there is the opportunity of 

studying several examples, …using varied representations of objects and inductive as 

well as deductive approaches (Lagrange, 2005, p. 74). More generally, when students 

learn through exploration, there is, according to Miller, Lehman and Koedinger7, a 

focus ...on stimulating the student’s initiative in gaining knowledge about the domain 

(Confrey et al., 2010, p. 23). 

2.1.3 Managing a CAS Tool 

Students’ approach 

For describing the students’ approach towards the CAS tool GG of this study, the 

notion of instrumented techniques (to be denoted 𝜏𝑖) introduced by Guin and Trouche 

(2002) is found especially relevant. The separate notion of techniques will be further 

elaborated within the term of praxeologies in the theory of ATD, in section 2.2.2. 

                                                        

7 With reference to (Miller, Lehman, & Koedinger, 1999). 



8 

 

For the definition of an instrumented technique to be used in this study, Guin and 

Trouche (2002) are followed in adopting Lagrange’s8 definition of a technique as 

being a set of gestures ...built by the subject to accomplish a given task (Guin & 

Trouche, 2002, p. 206). The subject is considered to be a high school student or 

teacher in this study. The function of a gesture can be understood within the action 

required of the subject to solve a specific task and noticeably it must not be 

...considered in isolation… (Guin & Trouche, 2002, p. 206) since it depends on human 

activity. A gesture is more specifically the observable part of human activity (Trouche, 

2004, p. 286). As an example, a gesture can be considered as a combination of 

keystrokes on a symbolic calculator in order to get an output (Trouche, 2005, p. 151). 

Especially, if the gestures are instrumented, i.e. …’articulated’ to an instrument… (Guin 

& Trouche, 2002, p. 206), they constitute an instrumented technique. An example of 

such a technique (within the theme of Trigonometry) is when the students realise the 

relationship between a point on the unit circle and cosine and sine to the reference 

angle by both entering the coordinates of the point and dragging it in GG. Within the 

theme of Power Functions, an example of an instrumented technique is when the 

students drag a slider for the value of 𝑎 in GG (in the functional equation  

𝑓(𝑥) = 𝑏 · 𝑥𝑎) in order to realise the relation between this value and the look of the 

graph. 

For the notion of an instrument, Guin and Trouche (2002)’s understanding (inspired 

by Verillon and Rabardel9) is to be used. Namely that of a psychological construct 

which can solely be said to exist if it is integrated within the activity of a subject and 

appropriated for the subject as an individual (Guin & Trouche, 2002, p. 205). More 

specifically, Verillon and Rabardel distinguish an instrument from an artifact in such 

a way that an ...instrument is what the subject ‘builds’ from the artifact (Trouche, 2005, 

p. 144) whereas an ...artifact is a material or abstract object, aiming to sustain human 

activity in performing a type of task (a calculator is an artifact, an algorithm for solving 

quadratic equations is an artifact)… (Trouche, 2005, p. 144). Furthermore, an artifact 

                                                        

8 Jean-Baptiste Lagrange is a French professor in Mathematics Education (Webpage: Jean-Baptiste 

Lagrange, 2016). 

9 With reference to (Verillon & Rabardel, 1995). 
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has both potentialities and constraints (characteristics) influencing the subject’s 

activity through his/her former working habits and knowledge, in the construction of 

an instrument; the instrumental genesis (Guin & Trouche, 2002, p. 205). The process 

of instrumental genesis consists of the two components instrumentalization and 

instrumentation where the former is related to the artifact and the latter is ...related to 

the organization of the subject’s behaviour (Guin & Trouche, 2002, p. 205). The 

processes of instrumentalization and instrumentation concern elaboration of 

schemes, linking concrete gestures and mathematical thinking, and thus these 

processes are mind related (Guin, Ruthven, 

& Trouche, 2005, p. 3). The latter aspect of 

instrumental genesis will not be considered 

further since this study only concerns the 

concrete gestures performed in praxis by 

subjects (being students and teacher) in 

relation to an artifact (being a computer 

with GG); i.e. the instrumented techniques. 

Figure 1, offered by Guin and Trouche 

(1999), provides an overview of how the 

artifact, the subject, the instrumental genesis 

and the instrument are related. 

Teacher’s approach 

The teacher has a great influence on how the CAS tool is made effective as a learning 

tool in his/her teaching. Especially, the students’ specific work with the CAS tool in 

correspondence with the mathematical theme is influenced by how the teacher plans 

and executes the teaching. The term of instrumental orchestration is used for 

describing the teacher’s actions towards guiding the individual instrumental geneses 

in the classroom with the intention of constituting a collective instrumental genesis 

(Drijvers et al., 2010, p. 112). As for the use of terms, the teacher can be said to 

function as …an orchestra conductor rather than a one-man band (Trouche, 2004, p. 

299) with the purpose of making ...the different student instruments playing together… 

(Trouche, 2014, p. 4) when working with the artifact. The notion is introduced by 

Figure 1 The relation between artifact, subject, 

instrumental genesis and instrument.  

 (Guin & Trouche, 1999, p. 202). 
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Trouche (2004) in order ...to point out the necessity (for a given institution – a teacher 

in her/his class, for example) of ‘external steering’ of students’ instrumental genesis 

(Trouche, 2004, p. 296). Further, this notion is often put in connection with learning 

environments involving the computer as an artifact (Drijvers et al., 2010, p. 112) 

which is exactly the case in the observation study of this thesis.  

Regarding the definition of the notion instrumental orchestration, Trouche (2004) 

asserts it to encompass didactic configurations and exploitation modes of these 

configurations performed by the teacher. The didactic configurations can more 

specifically be said to refer to ...the layout of the artifacts available in the 

environment… (Trouche, 2004, p. 296). An example of an orchestration could be when 

the teacher sets up a situation where a student gets to present for the whole class 

how to solve a specific task using the CAS tool GG, via a projector, keyboard and 

mouse - similar to sherpa-student situation presented by Guin and Trouche (2002).  

For analysing situations involving instrumental orchestration, it can be said to act on 

three levels, inspired by Trouche (2004, p. 297). The first level is where the 

orchestration acts on the artifact itself, for instance on specific possible commands to 

type in GG in order to construct a triangle or plot the graph of a function. This level is 

oriented towards instructions in how to use the specific artifact, keeping in mind that 

such instructions can change relative to the teacher's experience. In a second level 

orchestration, the focus is put on the instrument (or a set of instruments) and more 

specifically on the instrumented techniques used for solving specific tasks. As an 

example of a second level orchestration, the example of an orchestration presented in 

the above sherpa-like situation can be used, since the student gets to share his/her 

instrumented techniques. A third level orchestration is concerned with the subject’s 

relationship with the instrument (or set of instruments) and, more concretely, the 

subject’s reflection on choice of instrumented techniques in his/her approach 

towards the artifact. This type of orchestration can be made both towards the 

individual student (subject) or in a collective environment. An example of this type of 

orchestration could be when the teacher asks the students to compare the presented 

instrumented techniques (in a second level orchestration) or to reflect on 
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instrumented techniques alternative to the ones presented and to discuss which 

techniques are the most convenient (either individual or in plenum). 

This section ends by noting that … instrumentation theory is double-layered… (Drijvers 

et al., 2010, p. 112) since the teacher, when carrying out teaching involving work with 

an artifact, him-/herself concurrently develops an instrument from the artifact (i.e. 

s/he undergoes a process of instrumental genesis as well) (Drijvers et al., 2010, p. 

112). 

2.2 The Anthropological Theory of Didactics (ATD) 

This section is concerned with elaborating the process of the didactic transposition 

(section 2.2.1) which can work as a first framework to be further developed into the 

terms of praxeologies (section 2.2.2) in order to model the transposed mathematical 

knowledge. Further, the terms of praxeologies works as to give a perspective on the 

accomplishment of solving a task through instrumented techniques using a CAS tool 

involving the questions of how to solve the task and why. 

2.2.1 The Didactic Transposition 

The process of didactic transposition works as a model for considering the taught 

mathematical knowledge in school as being ...in a certain way, an exogenous 

production, something gathered outside school that is moved - ‘transposed’ - to a school 

out of a social need of education and diffusion (Bosch & Gascón, 2006, p. 53). The 

taught mathematical knowledge includes here the practice as well, i.e. it is both 

practical and theoretical. Winsløw (2011) states in a wider sense: 

The whole point of didactic transposition theory is to exhibit and analyse 

  the profound ‘changes’ which knowledge and practice undergoes as it is 

  “transposed” from one institution to another, or, within the school, from 

  the “official” curriculum to the “implemented” curriculum  

  (Winsløw, 2011, p. 123). 

As a final note, before describing the specific steps of the process of didactic 

transposition, this transposition should be seen as ...“the travel of knowledge from 

source(s) to students” (Winsløw, 2011, p. 123).  



12 

 

 
Figure 2 The process of didactic transposition and the position of the researcher in relation thereto. 

Figure 2 is made with great inspiration from Bosch and Gascón (2006, p. 57). This, 

with an awareness of the character of the study of this thesis being observations of 

praxeologies set up by the teacher and established by the students, why the notion of 

praxeological rather than epistemological has been chosen in relation to the reference 

models. The figure shows the process of didactic transposition which can be said to 

contain four steps (referring to the four boxes between which the knowledge is 

transposed, indicated by the three arrows pointing right). The first step is where the 

scholarly knowledge is produced and used by a mathematical community. This 

influences the knowledge to be taught which is based on official programs, textbooks, 

didactical materials etc. (illustrated through the first arrow). The second arrow 

indicates the transposition of the knowledge to be taught to the knowledge actually 

taught which is what happens in the classroom - i.e. how the specific teacher executes 

his/her teaching in a specific classroom. The third arrow illustrates the transposition 

to the learned, available knowledge which is the mathematical knowledge learned by 

the students. 

As a final remark for the figure (Figure 2), the reference praxeological models (RPMs) 

...constitutes the basic theoretical model for the researcher (Bosch & Gascón, 2006, p. 

57). The double arrows indicate a correspondence between the reference 

praxeological models and …the empirical data of […] the mathematical community, the 

educational system and the classroom (Bosch & Gascón, 2006, p. 57). In the case of this 

observation study the RPMs encompass both an analysis of each of the two 

mathematical themes with respect to scholarly knowledge and knowledge to be 

taught (sections 4.1 and 4.2) as well as an a priori analysis of the CAS tool GG in 

relation to each theme (section 4.3).  
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Now, since this study is anthropological and concerns the teaching of - and especially 

the learned mathematical knowledge in the classroom, use of the notion of 

mathematical praxeology/mathematical organisation, proposed by Chevallard within 

ATD, will be made. This, in order to model mathematical practice considered to 

include both a material/praxis dimension as well as a theoretical/knowledge 

dimension (Barbé, Bosch, Espinoza, & Gascón, 2005, pp. 236–237; Bosch & Gascón, 

2006, p. 58). 

2.2.2 Mathematical Organisations (MOs) and Didactical Organisations (DOs) 

ATD proposes that mathematics can be considered as a human activity which can be 

described in terms of the notion of mathematical organisation/mathematical 

praxeology (MO). Two aspects of mathematical activity are considered when 

describing an MO, namely a practical block and a knowledge(/theory) block. The 

practical block is formed by types of tasks (𝑇) and by techniques (𝜏) which are the 

methods used to solve and carry out the tasks. Noticeably specific tasks will be 

denoted (t) and specific set of tasks t will be denoted an exercise. The knowledge 

block also consists of two elements, namely technology (𝜃) and theory (Θ). The 

element of technology intends to justify the techniques used, and the theory element 

...constitutes a deeper level of justification of practice (Barbé et al., 2005, p. 237). To 

sum up, the knowledge block brings the ...mathematical discourse necessary to justify 

and interpret the practical block (Barbé et al., 2005, p. 237) and a knowledge block is 

especially established when the students try to generalise the outcome of their praxis.  

More generally, these two blocks refer to the two main components of human activity, 

called praxis (practical part) and logos (referring to human thinking and reasoning) 

which are intertwined (Bosch & Gascón, 2006, p. 59). To be noted, an MO can be 

considered as a quadruple (𝑇, 𝜏, 𝜃, Θ). 

Now, in order to argue for Trigonometry and Power Functions both being themes, the 

classification of MOs to be either punctual, local, or regional and especially the relation 

of MOs to the levels of codetermination, proposed by Chevallard, is needed.  

The classifications of MOs are said to be  ...of increasing complexity (Bosch & Gascón, 

2006, p. 59). MOs are called punctual ...if they are based around what is considered a 

unique type of problems… (Barbé et al., 2005, p. 237). A local MO is a set of punctual 
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MO’s belonging to the same technological discourse, i.e. tasks possible to solve 

through similar explanations (i.e. the knowledge block (𝜃, Θ) is common for the 

punctual MOs constituting a local MO). Similarly, a regional MO can be described as a 

set of local MO’s ...accepting the same theoretical discourse (Barbé et al., 2005, p. 238) 

i.e. tasks possible to solve through explanations within the same theory (Θ). In a 

mathematical set theory sense, it is noted that the relationship between a specific 

punctual MO and the other types of MOs in some cases can be written as follows: 

𝑝𝑢𝑛𝑐𝑡𝑢𝑎𝑙 𝑀𝑂 ⊂ 𝑙𝑜𝑐𝑎𝑙 𝑀𝑂 ⊂ 𝑟𝑒𝑔𝑖𝑜𝑛𝑎𝑙 𝑀𝑂. 

For instance, when a cathetus10 (b) and a hypotenuse (c) of a right triangle are given 

and one has to determine the unknown cathetus (a) (i.e. a punctual MO), then the 

Pythagorean theorem is applicable as technology within the Synthetic Geometry (see 

section 4.1.1) (as a regional MO). 

It is further noted that it is possible for a punctual MO to exist in several local MOs 

and that a local MO can exist in several regional MOs. Each of the 

above mentioned types of MOs can, respectively, be related to the 

following three lower levels of determination (proposed by 

Chevallard): subject, theme and sector. They are codetermined and 

one may refer to this relationship as levels of (didactic) 

codetermination (Artigue & Winsløw, 2010, pp. 4–7). The levels of 

determination are institutional and has been introduced to ...help 

researchers to identify conditions that go beyond the narrow space of 

the classroom and the subject that has to be studied in it (Bosch & 

Gascón, 2006, p. 61). 

Figure 3 presents the scale of levels of determination, where the 

upper levels domain, discipline, pedagogy, school, society and 

civilisation are of a character going beyond what is happening in the 

classroom and will not be considered further in this study (Winsløw, 

2011). The categorisation of Trigonometry as being a theme is made 

                                                        

10 The notion of a cathetus is throughout the thesis used to denote a side of a right triangle not being 

the hypotenuse. 

Figure 3 Levels of 

determination 
(Bosch & Gascón,  

2006, p. 61) 
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on the basis that it can be practiced within Analytical Geometry and Synthetic 

Geometry (to be elaborated further in section 4.1.1) both being considered as sectors 

since they do not represent the same technological-theoretical discourse. The work 

with the unit circle is related to the first mentioned and construction of triangles is 

related to the latter. Noticeably, the domain (which can be described to embrace …a 

collection of regional organisations involving several theories forming a larger part of 

the discipline (Artigue & Winsløw, 2010, p. 5)) embracing the two above mentioned 

sectors can be said to be Geometry. 

Power Functions is considered a theme as well, within the sector of Elementary 

Functions11 embraced by the domain of Functions12. 

Within the levels of codetermination there noticeably lies the important aspect of the 

didactic organisation (abbreviated DO) concerning the MO’s in the classroom. 

(Artigue & Winsløw, 2010, p. 6). A didactic organisation also called a didactic 

praxeology, is targeted towards the teaching of a specific MO and can be classified as 

punctual, local or regional as well (Winsløw, 2011, p. 125). In a more general sense, 

DOs seek to engage students through MOs in a teaching situation. DOs are performed 

by the teacher when he/her seeks to help the students perform an MO but can also be 

performed by the students in the process of studying and learning an MO (Artigue & 

Winsløw, 2010, p. 6; Barbé et al., 2005, p. 239).  

The notion of DOs hereby provides a perspective on the set up of MOs occurring in 

the classroom - namely that of organising and intermediating the MOs. 

On the basis of the presented theory, the following section concerns the established 

RQs sought to be answered in relation to the observations. The focus will mainly be 

                                                        

11 Elementary functions are functions ...built up of a finite combination of constant functions, field 

operations (addition, multiplication, division, and root extractions--the elementary operations)-- and 

algebraic, exponential, and logarithmic functions and their inverses under repeated compositions 

(Webpage: Elementary Function E. W. Weisstein, 2016). 

12 A function, f, is in this thesis understood as a non-multivalued relation from a set A (domain) to a set 

B (range) ...such that every 𝑎 ∈ 𝐴 is uniquely associated with an object 𝑓(𝑎) ∈ 𝐵 (Webpage: Function C. 

Stover & E. W. Weisstein, 2016). It is either a many-to-one or one-to-one but never a one-to-many 

relation (Webpage: Function C. Stover & E. W. Weisstein, 2016). 
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put on the taught and learned mathematical knowledge in relation to GG in the two 

specific courses (concerning Trigonometry and Power Functions).  
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3.0 Research Questions (RQs)  

The RQs related to this observation study concerning both of the themes are 

formulated to be: 

RQ0:  What are the main specific features of the CAS tool, and what specific 

  techniques does it offer for the two mathematical themes? 

RQ1:  In the observed teaching; what types of tasks are the students explicitly 

  instructed to solve using the CAS tool? What types of tasks do they 

  spontaneously solve using the CAS-tool? 

RQ2:  What mathematical praxeologies do the students establish in their work 

  with the CAS tool (i.e. instrumented techniques, technology and theory 

  based on the tasks identified in RQ1)? What are the strengths and 

  shortcomings at the level of mathematical theory? 

RQ3:  How does the teacher orchestrate students’ use of instrumented 

  techniques (i.e. how does s/he undertake instrumental orchestration, e.g. 

  what use of didactical configurations, use of GG worksheets, emphasis of 

  specific command frames, etc.)? 

The denotation ‘0’ for RQ0 has been selected in this manner since it is to be answered 

through the a priori analysis of the CAS tool (in section 4.3) in relation to the themes. 

The RQ1-RQ3 will however be answered through the analyses of the empirical data 

achieved via the observations in the two specific classes (sections 7.1 and 7.2) as well 

as the discussion sections related thereto (8.1 and 8.2, respectively).  

In relation to RQ1, it is to be noted that spontaneously solved tasks by the students is 

to be understood as cases where the students use techniques in which they are not 

explicitly instructed by the teacher. 

Next, in order to set up a framework of reference mathematical knowledge 

(concerning both the knowledge block and the praxis block) for answering the above 

presented RQs, the RPMs for each of the two themes (Trigonometry and Power 

Functions) is established.  
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4.0 Reference Praxeological Models (RPMs) 

In this section, the RPMs in relation to each of the themes will be established, 

involving both scholarly knowledge (sections 4.1.1 and 4.2.1) and knowledge to be 

taught (both in the version of the curriculum (sections 4.1.2 and 4.2.2) and the 

teaching material (sections 4.1.3 and 4.2.3)).  

For the sections on the curriculum connected to each of the themes (4.1.2 and 4.2.2) 

there are some commonalities (appearing in both A- and B-level curriculum) to be 

noted before continuing to the RPMs of the themes. First of all, the academic 

objectives concerning the ability to manage simple formulas and to translate between 

symbolic and natural language as well as the ability of completing simple 

mathematical reasoning and proofs are common. Not least, the academic objective of 

the ability to apply IT tools for solving given mathematical problems is common as 

well. In the core substance of the curricula, both the order of operations and equation 

solving are common. Regarding the priority of CAS tools, it is common for both 

curricula that calculators, IT and mathematical (computer) programs are to be 

essential aids for both acquisition of mathematical concepts and problem solving. The 

organisation of the teaching of mathematics is further to be influenced by the fact that 

the use of the just mentioned aids should be involved in an experimental approach to 

mathematical subjects and problem solving. (Undervisningsministeriet, 2013a, 

2013b). Finally, since the oral examination does not involve the use of a CAS tool, it is 

the tasks of the written examinations related to the themes which will work as a 

reference for which types of tasks the students should be able to solve (presented in 

the sections 4.1.2 and 4.2.2 as well). Noticeably, for both A- and B-level, there exists 

both a part with aids and a part without aids of the written examination, where the 

part with aids is dominant and noticeably it is only in this part that the student may 

use all types of aids including a (classical) CAS tool for performing symbolic 

manipulation. (Undervisningsministeriet, 2013a, 2013b; section "4.2. Prøveformer"). 

In both of the sections 4.1.2 and 4.2.2, types of tasks drawn from both the part with 

aids and the part without aids are however considered (it is only noted when the 

exam exercises are from the part without aids). This is due to the consideration that 



19 

 

the part without aids, as well as the part with aids, indicates which mathematical 

knowledge (both in relation to the praxis block and to the knowledge block) the 

students shall learn within the mathematical theme. 

4.1 Trigonometry (L) 

This section is concerned with the establishment of the RPM connected to the theme 

of Trigonometry. 

4.1.1 A Profile of the Theme 

The Greek’s need for dealing with computation of angles and distances and circle 

rotation of the Sun, Moon and planets around the earth led to the development of 

Trigonometry. The Greeks did what no one earlier had done and inspired others in the 

use of their geometry; they …geometrized the heavens (Webpage: Geometry 

mathematics, 2016). 

Hence the Greeks used geometry to develop trigonometry.  

Geometry is one of the oldest branches of mathematics and means “Earth 

measurement”. It arose in relation to practical problems and is ...concerned with the 

shape of individual objects, spatial relationships among various objects… (Webpage: 

Geometry mathematics, 2016). The largest contribution to the development of 

Geometry was given by Euclid13 in his Euclid’s Elements14. 

Geometry I, II, and III 

According to a study made by Catherine Houdement and Alain Kuzniak (2003), 

elementary geometry can be split into three different paradigms, namely natural 

geometry (Geometry I), natural axiomatic geometry (Geometry II) and formalist 

axiomatic geometry (Geometry III) (Houdement & Kuzniak, 2003, p. 1). 

                                                        

13 Euclid was a great Greek mathematician born around 330 B.C (Webpage: Euclid, 2016) 

14 It is a mathematical and geometric treatise consisting of thirteen books written by Euclid in 300 BC. 

The book is a collection of definitions, postulates (axioms), propositions (theorems and constructions), 

and mathematical proofs of the propositions (Webpage: Euclid’s “Elements,” 2016). 
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Geometry I is closely related to reality in such a way that it is based on concrete 

figures. The validity of this Geometry is very sensitive since ...immediate perception, 

experiment and deduction act on material objects (Houdement & Kuzniak, 2003, p. 4) 

when deductions are made. Conclusions are therefore solely based on manipulations 

of the figures. Dynamic proofs are fully valid and accepted in Geometry I (Houdement 

& Kuzniak, 2003, p. 4). As an example, if an angle (which will be further elaborated) of 

a triangle is to be determined then the use of a protractor for measuring the angle and 

give an answer, is considered enough. The notions of trigonometric functions like 

cosine and sine are not defined at this point. Even though, drawing a solution as a 

final answer to a trigonometric problem (without the use of any formulas) nowadays 

is considered imprecise, the situation is about to change with the implementation of 

the digital tools such as GG in high school. Digital tools namely offer some ...precise, 

practical and intellectually challenging ways to deal with triangle problems without the 

use of the trigonometric functions (Misfeldt, 2014, p. 31; translated from Danish). 

Examples of this type of contribution will be presented in the section on a priori 

analysis of GG in relation to Trigonometry (section 4.3.2). 

Geometry II is based on an axiomatic system in order to hypothetical deduce 

something desired from the figure. Here, the axiomatic system is used for the purpose 

of manipulating the material figure. This makes the 

validation of this geometry more rigorous and formal than 

Geometry I since it is possible to reach more general 

conclusions. As an example, when given two similar 

triangles, one can measure the ratio of two corresponding 

side lengths to be a constant equal to the ratio of another 

pair of corresponding sides of the same pair of triangles 

regardless of which pair of sides are chosen - see Figure 4.  

By measuring the corresponding side lengths of the two 

Figure 4 Two similar triangles 

with congruent angles. 
With inspiration from (Webpage: 

Similar Triangles, 2016) 
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triangles with congruent angles the scale factor can be expressed algebraically15 as 

𝑘 =
𝑎

𝑑
=

𝑏

𝑒
=

𝑐

𝑓
     (1) 

In Geometry III ...the umbilical cord is cut between reality and axiomatic... (Houdement 

& Kuzniak, 2003, p. 4) meaning that the axiomatic system has no relation to the 

reality and is completely separated from manipulating with figures. Within this 

Geometry it is only possible to draw conclusions on the basis of the axiomatic system 

(Houdement & Kuzniak, 2003, p. 4). This Geometry is very Euclidian since in the 

mathematics of Euclid there are no examples, just definitions, axioms, theorems and 

proofs. However, it is worth mentioning that Euclid did not use any symbols, only 

actual language, which means that there are no numbers (apart from some positive 

integers) and no units of measurements such as cubits or degrees (Katz, 2009, pp. 51–

52). However, Geometry III is not prioritised in the high schools (see section 4.1.2), 

hence it will not be considered further in this thesis.  

In high school, some of the mathematical conceptual difficulties can lie within the 

transition from Geometry I to II such as the transition from perceiving an angle as a 

space between two lines, probably measured with a protractor, to define the angle 

measure in Analytical Geometry16 as a rotation from one ray to another ray. This is to 

be elaborated further down. Likewise, it can be just as challenging for the students to 

link algebra to the figure - for instance to comprehend the expression of the scale 

factor based on figures (similar triangles).  

What is Trigonometry? 

So, what exactly is Trigonometry? Trigonometry is a branch of mathematics dealing 

with: The study of angles and of the angular relationships of planar and three-

dimensional figures... (Webpage: Trigonometry E. W. Weisstein, 2016). Noticeably, the 

first part of the word trigonometry, trigon, means “triangle” and the second part; 

                                                        

15 An algebraic method is within this thesis understood to be performed when one deals and operates 

with letters and symbols in order to represent numbers and values (Webpage: Algebra, 2016). 

16 Analytical Geometry is also known as coordinate geometry or Cartesian Geometry which is the study 

of geometry using a coordinate system(Webpage: Analytic Geometry E. W. Weisstein, 2016). 
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metron means “a measure” in Greek (Webpage: What Is Trigonometry?, 2016). To 

understand what a triangle is, the definition of a polygon is needed which is a plane 

figure  

   ...that is bounded by a finite chain of straight line segments closing in a 

  loop to form a closed chain or circuit. These segments are called its edges 

  or sides, and the points where two edges meet are the polygon's vertices 

  (singular: vertex) or corners. (Webpage: Polygon, 2016). 

Hence, an n-gon has 𝑛 sides and 𝑛 vertices, i.e. a triangle is a 3-gon since a triangle per 

definition is ...a closed plane figure having three sides and three angles (Webpage: 

Triangle, 2016). However, this definition does not say much about what an angle 

exactly is. This will be elaborated further down. 

Before going further it is to be noted, that there exist seven different types of 

triangles, namely: 1) Isosceles triangles (having two sides of equal length), 2) 

Equilateral triangles (where all three sides are of equal length), 3) Scalene triangles 

(where none of the three sides are of equal length), 4) Obtuse triangles (having one 

interior angle over 90°), 5) Acute triangle (where one of the interior angles is less 

than 90°), 6) Equiangular triangles (where all the interior angles are equal) and 7) 

Right triangles (where one of its interior angles is equal to 90°) (Webpage: Triangle 

definition and properties, 2016). The triangles of the types 1)-6) are henceforth 

denoted arbitrary triangles.  

Three contexts in connection with Trigonometry 

In high school, there are three different and often disjoint presented approaches to 

the introduction of Trigonometry, namely the Triangle context, the Unit circle context 

and the Function context. In the Triangle context, which is embraced by the sector of 

Synthetic Geometry17, sine, cosine and tangent are defined by the ratios of sides in a 

right triangle. Hence, trigonometry in relation to this context is solely a toolbox for 

solving problems concerning triangles in plane geometry. In the Unit circle context, 

                                                        

17 Synthetic Geometry ...is the study of geometry without the use of coordinates… (Webpage: Synthetic 

geometry, 2016). 
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within Analytical Geometry, cosine and sine with respect to an angle are respectively 

the 𝑥 and 𝑦 coordinate to a point on the unit circle. In the Function context 

 sine and cosine possess the properties of a function such as range, domain, zeroes, 

periodicity. (Winsløw, 2016, p. 4).  

The risk of the incoherent presentation of the above mentioned contexts is very much 

consistent with Felix Klein's Plan A18, which ...divides the total field into a series of 

mutually separated parts and attempts to develop each part for itself with a minimum 

of resources and with all possible avoidance of borrowing from neighbouring fields 

(Winsløw, 2016, p. 2). Whereas Klein’s Plan B ...involves a more holistic approach 

which emphasises and exploits connections between different sectors (Winsløw, 2016, 

p. 2) and seeks to see mathematical science as a connected whole. The three contexts 

are presented in Figure 5 below.  

 

 

 

 

 

 

Figure 5  

The three 

contexts; the 

Triangle context, 

the Unit circle 

context and the 

Function 

context, in 

relation to 

Trigonometry. 

                                                        

18 Felix Klein was a German mathematician who lived from 1849-1925 (Webpage: Klein biography, 

2016). Klein discovered that two Plans (Plan A and Plan B) can be identified when a new subject (here 

understood as a theme) is to be developed in high school (Winsløw, 2016, p. 2). 
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Regarding the Function context, there exist six trigonometric functions being cosine, 

sine, tangent and their reciprocal functions19, cotangent, secant and cosecant. The 

trigonometric functions ...are used in obtaining unknown angles and distances from 

known or measured angles in geometric figures (Webpage: Trigonometry, 2016) and 

are especially connected to triangles and the unit circle. The functions used in the 

present time can be traced back to 320 to 550 CE and the first publication of the 

abbreviations cos, sin and tan are from the 16th century, made by Albert Girard20. 

Nowadays, the use of trigonometry exists in fields as chemistry, architecture, 

meteorology, engineering and astronomy biology, just to mention a few (Sultan & 

Artzt, 2011, p. 513). It is noticeably only the functions of sine and cosine which are to 

be considered within the theme of Trigonometry in this thesis, since tangent is not 

involved in the work with GG (and is only introduced very briefly by TT). Moreover, 

the function context is not considered further since this aspect is not prioritised on 

the observed level of high school (see section 4.1.3). 

One of the obstacles in relation to the contexts is especially whether the students are 

capable of seeing the connection between the triangle context and the unit circle 

context on the level of the mathematical theory. Do they know why sine respectively 

cosine to an angle are relationships between specific sides of the right triangle when 

being introduced to sine and cosine in relation to the unit circle or do sine and cosine 

just function as tools that appears to be magical when calculating angles and sides in 

triangles? Within this transition, the notion of an angle is expanded to go beyond 

what meets the eye, which is to be elaborated in the following.  

 

 

 

 

 

                                                        

19  𝑥 and 
1

𝑥
 for 𝑥 ≠ 0 are reciprocal functions since their product is 1 (Webpage: Reciprokfunktionen, 

2016) 

20 Albert Girard (1595-1632) is a French mathematician (Webpage: Albert Girard biography, 2016). 
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The notion of an angle 

The triangle context: 

The notion of an angle is very complex and can be considered as much more than just 

the space between two lines, which continuously will be discovered throughout this 

section. The word angle stems from the Latin 

word “Angulus” which means “a little 

bending”. It is seen in the English word “ankle” 

which is the bend between the leg and the foot 

(Webpage: What Is Angle?, 2016). Within 

plane geometry, an angle is the measure of the 

space between two rays with a common 

vertex. The rays can be called the initial side 

respectively the terminal side in order to describe the measure of the angle, as seen 

on Figure 6 (Sultan & Artzt, 2011, p. 524). 

Thus, the angle can be seen as the space between the two sides and it can also be seen 

as the rotation from the initial side to the terminal side.  

Now, considering the angle of a triangle, it is noted that it can be both interior and 

exterior. The sum of the interior angles is 180° (the straight line), π radians, two right 

angles (cf. the Triangle Postulate) or a half turn of a circle. What exactly is meant by 

radians of a circle will also be further examined in the subsection below; The unit 

circle context. 

The Triangle Postulate is equal to the Parallel 

Postulate which states that: Given any straight line 

and a point not on it, there "exists one and only one 

straight line which passes" through that point and 

never intersects the first line, no matter how far they 

are extended (Webpage: Parallel Postulate E. W. 

Weisstein, 2016). This postulate is equivalent to 

Euclid’s fifth postulate which, in two-dimensional 

geometry, states the following (see Figure 7): 

Figure 6 A positive angle, 𝜽, between two rays. 

(Sultan & Artzt, 2011, p. 524) 

 

Figure 7 Two line segments n and k 

intersect each other since the angles 𝒘𝟏 

and 𝒘𝟐 are less than two right angles 

(Webpage: Parallelaksiomet, 2016). 
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  If a line segment intersects two straight 

  lines forming two interior angles on the same side that sum to less than 

  two right angles then the two lines, if extended indefinitely, meet on that 

  side on which the angles sum to less than two right angles (Webpage: 

  Parallel postulate, 2016). 

On Figure 8, it is seen how the Parallel Postulate is 

used in the proof of the theorem saying that …the sum 

of the angles of a triangle is 180 degrees (Sultan & 

Artzt, 2011, p. 687). It is clearly seen that the sum of 

the three angles (red, green and blue) on the top of the 

line segment DE constitutes an angle equal to 180° 

since a straight angle has 180°. It is also noted that 

through the point A, located outside the line BC, line 

DE is drawn which is parallel to BC according to the Parallel Postulate. The blue angle 

at C and the other blue angle are equal and the red angle at B and the other red angle 

are equal because DE and BC are parallel to each other. This is due to the fact that 

...when two parallel lines are cut by a transversal, the alternate interior angles are equal 

(Sultan & Artzt, 2011, p. 687). The two green angles are apexes to the same point A 

which makes them of equal size. This means that the angles of the triangle ABC are 

equal to the angles on top of the line DE, i.e. 180°. (Sultan & Artzt, 2011, p. 687). 

A triangle noticeably has interior angles as well as exterior angles. The measure of 

exterior angles of a triangle ...is greater than either of the measures of the remote 

interior angles (Webpage: Exterior angle theorem, 2016), according to the exterior 

angle theorem (Proposition 1.16 in Euclid’s Elements).  

In the triangle context, sine with respect to an angle and cosine with respect to an 

angle are defined as sin(𝜃) =
𝑜𝑝𝑝𝑜𝑠𝑖𝑡𝑒 𝑐𝑎𝑡ℎ𝑒𝑡𝑢𝑠

ℎ𝑦𝑝𝑜𝑡𝑒𝑛𝑢𝑠𝑒
 and cos(𝜃) =

𝑎𝑑𝑗𝑎𝑐𝑒𝑛𝑡 𝑐𝑎𝑡ℎ𝑒𝑡𝑢𝑠

ℎ𝑦𝑝𝑜𝑡𝑒𝑛𝑢𝑠𝑒
, for right 

triangles, where 0 ° ≤ 𝜃 ≤ 90 °. For arbitrary triangles sine to an angle can be found 

by the Law of Sine: 

 
𝑎

sin(𝐴)
=

𝑏

sin(𝐵)
=

𝑐

sin(𝐶)
    (2) 

Figure 8 The angle sum in a triangle. 
With inspiration from (Webpage: Trekanter 

og vinkler (Matematik C), 2016). 
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Further, cosine to an angle can be found by the Law of Cosine:  

cos(𝐴) =
𝑏2+𝑐2−𝑎2

2𝑏𝑐
, cos(𝐵) =

𝑎2+𝑐2−𝑏2

2𝑎𝑐
  and  cos(𝐶) =

𝑎2+𝑏2−𝑐2

2𝑎𝑏
   (3) 

Noticeably, a, b and c are the sides and A, B and C are the angles of the triangle in both 

of the presented laws and 0° ≤ 𝜃 ≤ 180 °, where 𝜃 is one of the angles (A, B and C) of 

the triangle. 

Within Analytic Geometry, sine and cosine (considered as functions of a variable x) 

are however defined on the entire ℝ, meaning that the output also can attain all real 

values which will be elaborated further in the subsection below. 

The unit circle context: 

In Analytic Geometry, the space between two 

sides can be considered as a rotation from the 

initial side to the terminal side and if the rotation 

is counter clockwise, the angle is said to be 

positive. Conversely, if the rotation is clockwise, 

the angle is negative (see Figure 9). In fact, the 

following trigonometric relationships hold which 

can be seen from Figure 9:  

cos(𝜃) = cos(−𝜃) 

sin(−𝜃) = − sin(𝜃) 

These relationships will also hold in any other 

quadrant since 𝜃 and −𝜃 always are reflections of 

each other around the x-axis. In Figure 10, both the 

angles 𝜃 and 180 − 𝜃 are presented and it follows 

immediately that 

cos(180 − 𝜃) = − cos(𝜃) 

sin(180 − 𝜃) = sin(𝜃) 

 

 

Figure 9 Clockwise versus counter 

clockwise rotation and the sign of an angle 𝜽 

having the x-axis as the initial side. 

(Sultan & Artzt, 2011, p. 528) 

 

Figure 10 Coordinates with respect to 𝜽 

and 𝟏𝟖𝟎 − 𝜽.  

(Sultan & Artzt, 2011, p. 529) 
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Hereby, it is seen how it is possible, within this context, for 

an angle to be less than zero degrees which is not possible in 

the triangle context. 

The Figure 11 below presents an example of an angle being 

more than 180° as was used as an upper limit of an angle in 

the triangle context. Here, the angle is 800° since there are 

two full counter clockwise rotations of 360° and 80° in 

addition. 

The above presented trigonometric relationships and the 

option for an angle to be more than 360° may be an aspect which the students find 

challenging.  

When considering angles in a circle, one may talk of both a central angle and an 

inscribed angle21, but the latter will not be considered further on. A central angle (𝜃) 

has its vertex in the centre of the circle, illustrated in Figure 12 below, and it has the 

same degree measure as the arc subtended by the central angle which is the arc AB 

with length s as also shown on the figure (Sultan & Artzt, 2011, p. 180).  

This means that the arc subtended by 𝜃 is defined to also be 𝜃. When thinking about 

it, this actually does make sense since a full rotation 

of the circle is 360° which makes it possible to 

consecutive have 360 central angles of 1°. This leads 

to the circumference of the circle being divided in 

360 parts which makes the number of central angles 

equal to the number of parts of the circle, as they are 

both 360. From this, it follows that ...any arc will have 

the same number of degrees as its central angle 

(Sultan & Artzt, 2011, p. 180). 

                                                        

21 If the angle is not central but inscribed, it has its vertex on the circumference of the circle and its 

initial side and terminal side terminates on the circumference of circle (as chords of the circle). An 

angle inscribed in a circle is measured by 
1

2
 of its degree arc (Sultan & Artzt, 2011, p. 181). 

Figure 11 An angle of 𝟖𝟎𝟎°. 
(Sultan & Artzt, 2011, p. 524) 

 

Figure 12 A central angle of a circle. 
(Webpage: Degree and Radian 

Measure, 2016) 

 



29 

 

Like there exist several units for describing length, such as meter and feet, and 

temperature, such as Fahrenheit and degree Celsius, degrees and radians both 

function as units for describing angles. When dealing with the unit circle which has its 

center in origo 𝑂 = (0,0) and radius 1, it is more preferable to use radians instead of 

degrees. When considering Figure 12, a radian of a central angle (𝜃) can be defined to 

be the ratio of the distance along the circumference of the circle (arc length), s, and 

the circle radius, r as  

𝜃 =
𝑎𝑟𝑐 𝑙𝑒𝑛𝑔𝑡ℎ

𝑟𝑎𝑑𝑖𝑢𝑠
=

𝑠

𝑟
  (Sultan & Artzt, 2011, p. 537). 

The arc length of the entire circle is 2𝜋 since the radius in the unit circle is 1 which 

makes the circumference of the circle,  

𝐶 =  2𝜋𝑟 = 2𝜋 · 1 = 2𝜋, where 𝜋 =
𝑐𝑖𝑟𝑐𝑢𝑚𝑓𝑒𝑟𝑒𝑛𝑐𝑒 𝑜𝑓 𝑡ℎ𝑒 𝑐𝑖𝑟𝑐𝑙𝑒

𝑑𝑖𝑎𝑚𝑒𝑡𝑒𝑟 𝑜𝑓 𝑡ℎ𝑒 𝑐𝑖𝑟𝑐𝑙𝑒
. 

This information gives the possibility of converting angle measures between degrees 

and radians. A central angle is known to be of 360° and has a radian measure of 2𝜋, 

i.e. 360° = 2𝜋 𝑟𝑎𝑑𝑖𝑎𝑛𝑠. When dividing this by 2, the outcome is 180° = 𝜋 𝑟𝑎𝑑𝑖𝑎𝑛𝑠 

which makes 1 𝑟𝑎𝑑𝑖𝑎𝑛 =
180

𝜋
 𝑑𝑒𝑔𝑟𝑒𝑒𝑠 and 1 𝑑𝑒𝑔𝑟𝑒𝑒 =

𝜋

180
 𝑟𝑎𝑑𝑖𝑎𝑛𝑠. Hence, this is the 

way to convert from radians to degrees and vice versa. To sum up, when converting 

from degrees to radians; multiply by 
𝜋

180
 radians and when converting from radians to 

degrees; multiply by 
180

𝜋
 degrees. (Sultan & Artzt, 2011, p. 180). 

Radians is to prefer when describing angles since ...it makes certain formulas in 

calculus much simpler (Sultan & Artzt, 2011, p. 538) such as finding the derivative of 

cos(𝑥). If x is measured in degrees, the derivative of cos(𝑥) is −
𝜋

180
· sin(𝑥) whereas, if 

x is measured in radians, the derivative of cos(𝑥) is − sin(𝑥) which is a much simpler 

expression and easier to work with prospectively. This is, however, not the only 

reason to use radians. Radians are noticeably dimensionless quantities which makes 

it possible to use them in all contexts regardless of the unit one work with when 

measuring (for instance cm, m etc.). This is due to the way radians are defined, 

namely as the ratio of the arc length and the radius which cancel out the units of 

measurement. (Sultan & Artzt, 2011, p. 538; Webpage: Radian, 2016). This means 
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that angles can be described through real numbers and when sine or cosine is 

evaluated on such input it can also attain any real number, ℝ. However, there may lie 

a conceptual challenge as to understand the fact that the measure of an angle 

corresponds to the length of an arc and not just to a degree measure. Even at 

university level the notion of an angle remains somewhat a mystery, especially to 

think of angles as numbers and where those numbers come from (Winsløw, 2016, pp. 

8–9). In continuation hereof, the remarkable notions of sine and cosine are to be 

considered - what exactly do they mean?  

Sine comes from the Latin word “sinus” and means “bowstring” from the Sanskrit 

word “jiva”. Figure 13 below gives an explanation of this, namely that sine to an angle 

is half of the corresponding “bowstring” to which the bow (CAE on the figure) spans - 

i.e. CE on the figure; which may look like a bowstring in relation to CAE. In the figure, 

this means that sine to the angle 𝑣1 is the line segment 𝐶𝐷. The sine of 𝑣1 is the ratio 

of 𝐶𝐷 the radius of the circle, OA, thus sin(𝑣1) =
𝐶𝐷

𝑂𝐴
 . 

Originally cosine was written 

co.sine; an abbreviation for sine of 

the complement. Revisiting Figure 

13, it is observed that cosine of 

the angle 𝑣1 is the sine of ∠𝑂𝐵𝐴 

which is 𝑣2 (the complementary 

angle22). Because of the Parallel 

Postulate, ∠𝑂𝐵𝐴 and ∠𝑂𝐶𝐷 are of 

equal size, hence ∠𝐶𝑂𝐷′ are also 

of the same size. So,  

cos(∠𝐴𝑂𝐵) = cos(𝑣1) =

sin(∠𝑂𝐵𝐴) = sin(𝑣2) which gives 

cos(𝑣1) =
𝐶𝐷’

𝑂𝐴
. 

                                                        

22 A complementary angle to an angle (v) is of a size which, when added to v, gives 90 ° or 
𝜋

2
 radians 

(Webpage: Complementary Angles E. W. Weisstein, 2016). 

Figure 13 An illustration of cosine and sine with respect to 𝒗𝟏. 
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(Webpage: Latin Origins of Trig Functions, 2016). Hereby, it is seen that angles and 

their measures are related to sine and cosine just as it applies in the triangle context.    

4.1.2 The Curriculum in Relation to the Theme 

This section will present an overview of what the students should know how to do in 

the high school concerning what is especially relevant in relation to the theme of 

Trigonometry. This overview will be based on the curricula for Mathematics A-level 

(C-A) and B-level (C-B) Stx (Undervisningsministeriet, 2013a, 2013b) as well as a trial 

curriculum for Mathematics A-level (C-TA) (Digital eksamen i matematik A - 

forsøgslæreplan, 2009) which is noted to be an expanded version of the C-A, i.e. C-A is 

included in C-TA why this program will be referred to henceforth. The choice of 

including C-TA is due to the fact that the teacher teaching the Trigonometry course 

(TT) uses this as curriculum. As a supplement, the teacher’s guide (TG) for A-level and 

B-level (respectively TG-A and TG-B: (Matematik A - stx vejledning, 2010; Matematik 

B - stx vejledning, 2010)) and what is expected of the students for the written 

examinations (A-level) in relation to Trigonometry will be presented. The choice of 

including both the C-B and the TG-B, despite of the class having mathematics on A-

level, is due to the fact that the class is of first grade of high school, and that the 

teaching material (see section 4.1.3) does not extend to more than B-level at this 

point.    

The core substance (section 2.2 of C-A and C-B) in relation to the theme is the same for 

both of the EPs, namely: 

(1) Ratio calculations in similar triangles and trigonometric calculations in 

 arbitrary triangles. 

However, the academic objectives (section 2.1 of C-A and C-B), i.e. what the student 

must have achieved academically, at the two levels are slightly different from each 

other. On B-level the student must be able to: 

(2) Establish and explain geometric models and solve geometric problems. What 

exactly is meant by this is further elaborated in TG-B. Here, concepts like altitude, 

medians and angle bisecting lines are mentioned in order for the students to explain 

geometric models and solve geometric problems. Further, TG-B states that students 
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should have the ability to handle and implement trigonometry including knowledge 

of the Law of Sine and the Law of Cosine in order for the students to reach the 

academic objective. 

Regarding the academic objectives to be found in C-TA, the students should, besides 

from establishing geometric models and solving geometric problems (like on B-level), 

further be able to: 

(3)  Establish and explore geometric models and solve geometric problems both by 

means of a dynamic geometry program and on the basis of calculations concerning 

triangles as well as providing an analytical description of geometric figures in a 

coordinate system and utilise this to answer given theoretical and practical problems. 

(4) Use CAS-tools to explore and solve given mathematical problems. 

Noticeably, the academic objective of giving analytical descriptions is only partly 

covered in the teaching course by TT, namely in relation to the use of the unit circle 

and therefore the further aspects of the objective covering all three years of the A-

level mathematics will not be considered in the following (where the references are 

C-B, C-TA, TG-A). 

TG-A gives the same detailed description of what the students should be able to as for 

B-level. However, TG-A also states that the students need to be able to determine 

angles between lines. 

In the following, a list of types of tasks (T) has been established on the basis of exam 

exercises for the written examination related to the theme of Trigonometry (and are 

denoted 𝑇𝐸𝑇). The explored exam exercises can be referred to the written 

examinations from 2013-201623 - more specifically six exam assignments. The types 

of tasks have been established by exploring specific tasks (t) in the given exam 

exercises which can be solved by applying the same technique. 

𝑻𝑬𝑻𝟏
:  Given an arbitrary triangle, where two sides and the angle between them 

  are known. Determine the unknown side. 

                                                        

23 Noticeably the written examinations from earlier years are not publicly accessible why there is made 

no explicit references thereto, besides from the specific examples of exercises and tasks from some of 

the written examinations. 
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𝑻𝑬𝑻𝟐
:  Given an arbitrary triangle where all three sides are known. Determine 

  one of the angles. 

𝑻𝑬𝑻𝟑
:  Given an arbitrary triangle. Two angles and the side between them are 

  known. Determine one of the unknown sides. 

In Figure 14 an exam exercise with tasks of the types 𝑇𝐸𝑇1
, 𝑇𝐸𝑇2

 and 𝑇𝐸𝑇3
is presented. 

 

Figure 14  Exercise from 2013 (August) involving tasks of type 𝑻𝑬𝑻𝟏
 and 𝑻𝑬𝑻𝟐

 (in exercise a)) and 𝑻𝑬𝑻𝟑
 (in 

exercise b)). 

An interesting example of an exam exercise involving a task of the type 𝑇𝐸𝑇1
is 

presented in Figure 15 and involves the construction of a median as well. 

 

Figure 15 Exercise from exam in 2014 (May) where b) relates to 𝑻𝑬𝑻𝟏
when one has constructed the median. 
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𝑻𝑬𝑻𝟒
:  Given an arbitrary triangle where two sides and the intermediate angle 

  are known. Determine the area of the triangle. 

In Figure 16 an exam task of type 𝑇𝐸𝑇4
 is presented. 

 

Figure 16 Exam task from 2015 (August) - modified in order to not present the whole exercise involving a part a) 

- of the type 𝑻𝑬𝑻𝟒
. 

𝑻𝑬𝑻𝟓
:  Given two similar triangles, triangle 1 and triangle 2. Two sides are 

  known in triangle 1 and one side, corresponding to one of the sides in 

  triangle 1, are known in triangle 2. Determine the side of triangle 2 

  which corresponds to one of the sides which is known in triangle 1.  

In Figure 17 an exam task related to the task of type 𝑇𝐸𝑇5
 is presented.  

 

Figure 17 Exam task from 2014 (May) (the part without aids) including a task of type 𝑻𝑬𝑻𝟓
. 

Noticeably, these exam tasks only require the establishment of a practical block by 

the students (as a minimum) since there are no questions directly relating to a 

technological discourse. Regarding the techniques applicable for solving the types of 

tasks presented in the above, they will be briefly sketched in the following whereas 

section 4.3.2 presents more detailed (instrumented) techniques therefor. 

The students should be able to apply the Law of Cosine (point (2)) in order to answer 

both 𝑇𝐸𝑇1
 and 𝑇𝐸𝑇2

. For 𝑇𝐸𝑇1
one should isolate the unknown side in one of the 

formulas (3) in section 4.1.1 (subsection: The notion of an angle) and insert the 
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known sides and angle before calculating. For 𝑇𝐸𝑇2
 one should solve with respect to 

the angle to be found after having inserted the known values of the three sides in one 

of the formulas (3) in section 4.1.1 as well. The Law of Sine (point (2)) is to be applied 

in order to answer 𝑇𝐸𝑇3
, after having determined the last and unknown angle 

(knowing that the sum of angles is 180° in a triangle). That is, the formula (2) in 

section 4.1.1 (subsection: The notion of an angle) is to be used by isolating an 

unknown side, and thereafter the known values for sides and angles are inserted in 

the formula, before calculating.  𝑇𝐸𝑇4
 is to be solved based on the student's ability to 

handle and implement trigonometry (point (2)), which in this case is the area formula 

1

2
𝑏𝑐 sin(𝐴) =

1

2
𝑐𝑎 sin(𝐵) =

1

2
𝑎𝑏 sin(𝐶) (Webpage: Triangle Area, 2016). The known 

sides and angle are inserted in the formula, before calculating. The exercise presented 

in Figure 15 can noticeably only be solved by knowing how to construct a median 

(this should be well known for the students since they are already familiar with the 

term in elementary school (Beck, Kaas, Fink, Danmark, & Styrelsen for Evaluering og 

Kvalitetsudvikling af Grundskolen, 2010, p. 22)). To answer  𝑇𝐸𝑇5
, the students need 

to know about ratio calculations in similar triangles (point (1)). More specifically, the 

ratios presented in (1) in section 4.1.1 (subsection: Geometry I, II, and III) are to be 

applied where the known sides of the similar triangles are inserted and the side to be 

determined is isolated, followed by calculation. Similar triangles and scaling are 

neither unknown concepts since it is also knowledge gained from elementary school 

(Webpage: Fælles mål 2009 (historiske) Folkeskolen, 2016, p. 60 accessed by 

selecting "Matematik" and then via the link "Matematik (Fælles Mål 2009)(pdf)"). 

Noticeably, trigonometric calculations in arbitrary triangles (point (1)) is recurring 

throughout the methods used to solve the tasks given in the written examinations.  As 

an endnote, exam exercises/tasks involving tasks of the types 𝑇𝐸𝑇1
- 𝑇𝐸𝑇5

 may require 

that the students can use dynamic geometry programs or CAS-tools (classic) in order 

to solve the tasks (point (3) and (4)). 

4.1.3 Teaching Material  

In this section, the content of trigonometry on C and B level in the teaching material 

will be presented since they are intertwined at the point of high school current for the 
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students of this observation study. TT uses two different web pages as teaching 

material, namely webmatematik.dk (Webpage: Gratis online hjælp - Webmatematik, 

2016) and a webpage created by TT (TTW), of which the latter is created by the 

teacher and contains supplementary materials as well as exercises for the lessons in 

mathematics24. The web page is primarily directed towards the students studying on 

the observed high school. To be noted, all the students of this class has a formula 

collection as well; (Dejgaard & Schomacker, 2007) which will not be described here. 

Webmatematik.dk is a web page providing free online help in mathematics. On the 

page mathematics on C, B and A level (stx) can be selected by clicking on the different 

levels. This click will then lead to a presented overview of the mathematical content 

at the specific level. On C level by clicking on Trigonometry (“Trigonometri”), it will 

be presented by yet another overview which is a list of the following headlines: 

Triangles and angles, Similar triangles, Isosceles and equilateral triangles, Right 

triangles, Cosine and Sine (defined with respect to the unit circle), Tangent (defined 

with respect to the unit circle), Cosine, Sine and Tangent in relation to the right 

triangle. Noticeably, it seems that this web page presents Trigonometry as a domain 

(and not a theme like in section 2.2) where each of the above mentioned are 

considered themes which therefore will be done throughout this section (4.1.3).  

By clicking on each of the themes, an explanatory text will appear including 

illustrations. At the bottom of the page, a video is to be found in most cases, in which 

the theme is presented orally (the same applies for B-level). Hence, Trigonometry at 

this level deals with cosine, sine and tangent in relation to right triangles, thus the 

application of the formulas: 

cos(𝑣) =
𝑎𝑑𝑗𝑎𝑐𝑒𝑛𝑡 𝑐𝑎𝑡ℎ𝑒𝑡𝑢𝑠

ℎ𝑦𝑝𝑜𝑡𝑒𝑛𝑢𝑠𝑒
, sin(𝑣) =

𝑜𝑝𝑝𝑜𝑠𝑖𝑡𝑒 𝑐𝑎𝑡ℎ𝑒𝑡𝑢𝑠

ℎ𝑦𝑝𝑜𝑡𝑒𝑛𝑢𝑠𝑒
  and  tan(𝑣) =

𝑜𝑝𝑝𝑜𝑠𝑖𝑡𝑒 𝑐𝑎𝑡ℎ𝑒𝑡𝑢𝑠

𝑎𝑑𝑗𝑎𝑐𝑒𝑛𝑡 𝑐𝑎𝑡ℎ𝑒𝑡𝑢𝑠
,  

where v denotes an angle. Noticeably, measures of angles are described only in 

degrees at this level. The web page thus presents trigonometry both within the 

Synthetic Geometry and the Analytic Geometry and makes an effort for presenting the 

                                                        

24 In order to keep TT anonymous throughout the thesis no direct reference is made to TTW. 



37 

 

transition between the two. On B-level, the overview of themes under the domain of 

Trigonometry are: 

The Basics (contains information concerning the definitions of cosine, sine and 

tangent and their relation to the right triangle at C-level), The Law of Cosine, The Law 

of Sine, the Law of Sine in obtuse triangles, The Area formula, and The basic relation 

between sine and cosine25 (including a brief presentation of the unit circle). Here, 

Trigonometry therefore also contains the arbitrary triangles in relation to the 

definitions of cosine, sine and tangent (as opposed to C-level), and angles still remain 

measured in degrees at this level. 

What is common for each level is that few tasks are available, however these tasks are 

not used by TT. TT uses tasks on TTW. 

On TTW, tasks can be found within the themes for both levels. The tasks are oriented 

towards GG, such that the dynamically aspect of GG is required to solve the specific 

task. A few examples hereof are listed below. 

𝒕𝑻𝑻𝑾𝟏
:  Given the constructed unit circle and the directional point P=(Px,Py), 

  where Px=cos(v) and Py=sin(v). Drag the point P and answer, what is 

  cos(45)?  

  (Task 6. a. in TTW 1, A.2). 

𝒕𝑻𝑻𝑾𝟐
:   Given the constructed unit circle and the directional point P=(Px,Py), 

  where Px=cos(v) and Py=sin(v). Drag the point P and answer, what is 

  sin(75)? 

  (Task 6. b. in TTW 1, A.2). 

If the students have difficulties in answering 𝑡𝑇𝑇𝑊1
 and 𝑡𝑇𝑇𝑊2

 from their own 

construction work in GG there is a GG worksheet which has all the required 

information to help the students solve the tasks. This worksheet is described in the a 

priori analysis in connection with Trigonometry (section 4.3.2). Some other examples 

of tasks on TTW are tasks related to the actual construction work, such as: 

                                                        

25 The basic relation is cos2(𝑣) + sin2(𝑣) = 1 (Webpage: Grundrelationen (Matematik B, 

Trigonometri), 2016). 
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𝒕𝑻𝑻𝑾𝟑
: Construct a triangle ABC, where a = 9, b = 7 and c = 5. You may only use 8 

  features of GG (presented in A.2 as TTW 4). 

  (Task in TTW 2, A.2). 

𝒕𝑻𝑻𝑾𝟒
: Construct a triangle ABC, where A = 30°, b = 7 and a = 5. You may only 

  use 8 features of GG (presented in A.2 as TTW 4).  

  (Task in TTW 3, A.2)26. 

𝒕𝑻𝑻𝑾𝟓
:  Draw an arbitrary triangle in GG. 

𝒕𝑻𝑻𝑾𝟔
: Construct the median to each of the three sides of the arbitrary triangle 

  constructed in 𝑡𝑇𝑇𝑊5
. 

  (The tasks 𝑡𝑇𝑇𝑊5
 and 𝑡𝑇𝑇𝑊6

 are connected and presented in TTW 5, 

  A.2) 

A video presentation of the construction work in GG is provided, in relation to both 

𝑡𝑇𝑇𝑊3
, 𝑡𝑇𝑇𝑊4

, 𝑡𝑇𝑇𝑊5
 and 𝑡𝑇𝑇𝑊6

. This is the case for almost all construction tasks on 

TTW. 

The specific tasks just mentioned can noticeably be put in relation to the earlier 

presented types of tasks 𝑇𝐸𝑇  from the written examinations since the exam tasks can 

be solved through techniques involving gestures represented through 𝑡𝑇𝑇𝑊3
- 𝑡𝑇𝑇𝑊6

. 

An example of a set of gestures leading up to solving 𝑡𝑇𝑇𝑊4
 and hence solving some of 

the exam tasks involving unknown sides and angles will be given in section 4.3.2. 

Furthermore, the TTW offers GG worksheets (see section 4.3.1), primarily click 

proofs, which are described in the a priori CAS analysis (section 4.3.2). On the 

webpage click proofs of the Pythagorean theorem as well as for the area formulas can 

be found. TTW also offers manuals which describes in detail how a specific object 

must be constructed. An example of such a manual can be found in the A.2 (TTW 6) 

which is a description of how to construct a unit circle as well as a directional point 

                                                        

26 The instrumented technique for solving 𝑡𝑇𝑇𝑊4
 is examined in section 4.3.2 concerning the a priori 

analysis of the CAS tool. 
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and a directional angle. The instructed techniques are equal to the ones presented in 

section 4.3.2, namely 𝜏𝑈𝐶,𝐴𝑃,𝑇𝑅
𝑖 , 𝜏𝐷𝑃𝐷𝐴,𝐴𝑃,𝑇𝑅

𝑖 .  

As a final note, the GG tasks related to Trigonometry, offered by TTW, provide the 

option of putting algebra in relation to constructed figures (Geometry II). 

To sum up, this webpage provides an insight to the program of GG through tasks, GG 

worksheets and videos. By combining the TTW and the webmatematik.dk the teacher 

gives the students the possibility of establishing both a practical block, where the 

techniques used are mainly instrumented since they are related to GG, and a 

knowledge block, especially through click proofs on TTW and the knowledge gained 

from the more detailed explanations of the themes of Trigonometry on 

webmatematik.dk. 

4.2 Power Functions (A)     

This section is concerned with the establishment of the RPM connected to the theme 

of Power Functions.  

4.2.1 A Profile of the Theme 

The definition of a power function 

A power function can be defined as a function of the following form:  

 𝑓(𝑥) = 𝑏𝑥𝑎,  where 𝑏, 𝑎 ∈ ℝ\{0}   

(Yoshiwara & Yoshiwara, 2007, p. 257), where x denotes the base and a denotes the 

exponent of the power (𝑥𝑎), and b denotes the constant of proportionality. 

This form will be supposed throughout this section where nothing else is stated. 

Noticeably, the exponent (here denoted a) is sometimes allowed to be 0 as well (as in 

the teaching material for instance (see section 4.2.3)) which just means that constant 

functions, of the form 𝑓(𝑥) = 𝑏 for 𝑏 ∈ ℝ\{0}, are included in the definition of a 

power function (Webpage: Power Functions, 2016). Further, it is common to restrict 

the constant of proportionality (b) to be greater than zero (also done in the teaching 

material presented in section 4.2.3) which seems to be a convention rather than a 

necessity for the function to be well defined. As for the domain of the power function, 

the teaching material (section 4.2.3) seems to restrict x to be greater than zero. 
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However, the way the power function is presented by Yoshiwara & Yoshiwara (2007, 

pp. 233-320 (Chapter 3)), there are more options for the domain than the restriction 

mentioned here which are to be elaborated in the following. 

The domain of a power function 

For exploring the domain of a power function, the justification of the fact that the 

exponent of a power can attain any real value - corresponding to the expanded notion 

of a power, referred to in the curriculum (see section 4.2.2) - is to be elaborated. 

Noticeably, it is often in relation to the domain of the exponential function with a 

positive real base (see definition in the subsection; The power function in relation to 

other elementary functions), that this expansion of the notion of a power is justified 

(Bremigan, Bremigan, & Lorch, 2011, pp. 434–435; Eureka MathTM, 2015, p. 75).  

This justification can be divided into the following three steps (when denoting the 

base of the power x and the exponent of the power a):  

1) 𝑎 ∈ ℤ 27 

2) 𝑎 ∈ ℚ28 

3) 𝑎 ∈ ℝ29 

In the following, these steps will be elaborated further. 

1) Integer Exponents of Powers (𝑥𝑎  with 𝑎 ∈ ℤ): 

The possibility of positive integer exponents of powers (𝑥𝑎 , 𝑎 ∈ ℤ+) can intuitively be 

argued for, since a in this case just express how many times the base x occurs as a 

factor in an expression; 

  𝑥𝑎  =  𝑥 · 𝑥 ⋯ · 𝑥 (𝑎 times)  

                                                        

27 ℤ denotes the set of integers where an integer is either a positive or a negative whole number 

(including zero); i.e. it can be expressed without any fractional component (Webpage: Integer, 2016). 

28 ℚ denotes the field of rational numbers being numbers ...that can be expressed as a fraction ‘p/q’ 

where ‘p’ and ‘q’ are integers and ‘q≠0’ (Webpage: Rational Number E. W. Weisstein, 2016). 

29 ℝ denotes the field of real numbers consisting of rational and irrational numbers(Webpage: Real 

Number E. W. Weisstein, 2016). An irrational number ...is a real number that cannot be represented as’ 

𝑝

𝑞
’  for any integers ‘p’ and ‘q’ with ‘q≠ 0’ (Eureka MathTM, 2015, p. 75). 
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(Yoshiwara & Yoshiwara, 2007, p. 255). 

This applies for all 𝑥 ∈ ℝ, since any real number can be multiplied by itself a times for 

any 𝑎 ∈ ℤ+ and still be a real number (since a (field) property of ℝ is that it is closed 

under multiplication (Webpage: Field, 2016)). 

Regarding negative integer exponents (𝑎 ∈ ℤ−), the following applies 

  𝑥−𝑎  =
1

𝑥𝑎 ,  𝑎 ∈ ℤ+ and 𝑥 ≠ 0   (1) 

Noticeably, there may here lie a conceptual challenge as to understand that a power 

raised to a negative power is not itself negative; 

𝑥−𝑎 ≠ −𝑥𝑎.  

Furthermore, the negative exponent only applies to the base, x, and not to a factor of 

the power, if any, i.e.; 

𝑘𝑥−𝑎 ≠
1

𝑘𝑥𝑎   but   𝑘𝑥−𝑎 = 𝑘
1

𝑥𝑎  

(Yoshiwara & Yoshiwara, 2007, p. 256). 

The expression (1) can however readily be argued for by noting a pattern when 

moving from left to right in the following list; 

𝑥1 = 𝑥, 𝑥2 = 𝑥 · 𝑥, 𝑥3 = 𝑥2 · 𝑥, 𝑥4 = 𝑥3 · 𝑥, ⋯  

namely, that the exponent increases by 1 every time one factor x is added. 

Additionally, when moving from right to left, the exponent noticeably decreases by 1 

every time one factor x is removed, i.e. every time a division by x is made. Continuing 

dividing by x each time the exponent decreases by 1, the list can be expanded to the 

following: 

⋯ , 𝑥−3 =
1

𝑥3
, 𝑥−2 =

1

𝑥2
, 𝑥−1 =

1

𝑥1
, 𝑥0 = 1, 𝑥1 = 𝑥, 𝑥2 = 𝑥 · 𝑥, 𝑥3 = 𝑥2 · 𝑥, ⋯ 

Here, x clearly cannot be zero. 
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Now, it can from the list just above be deduced that powers with negative integer 

exponents are unit fractions30 with powers of x in the denominator having exponents 

equal to the numerical value of the negative integer exponents, i.e.: 

 𝑥−𝑎 =
1

𝑥𝑎 , for 𝑥 ≠ 0, 𝑎 ∈ 𝑍+. 

Furthermore, for the specific case where the exponent equals zero, the list above 

reveals that any non-zero number raised to the 0th power equals 1; 

 𝑥0 = 1 , for 𝑥 ≠ 0. 

(Yoshiwara & Yoshiwara, 2007, pp. 255–256).  

Hereby, integer exponents of a power have been justified. 

Regarding the domain of power functions f with integer exponents a, it can be 

summed up to be ℝ when 𝑎 > 0 and ℝ\{0} for 𝑎 ≤ 0, i.e. ℝ\{0} for a being an 

arbitrary integer. 

2) Rational Exponents of Powers (𝑥𝑎  with 𝑎 ∈ ℚ) 

Rational exponents of powers are less intuitive than integer exponents. With the 

conception of a power having integer exponents, it can be a challenge to understand 

what is meant by an exponent of the form 
1

𝑛
 and more generally 

𝑚

𝑛
 for 𝑚, 𝑛 integers 

with 𝑛 ≠ 0. Here, the concept of a root becomes relevant.  

The nth root of a real number 𝑥 ≥ 0 is defined to be the number which, multiplied by 

itself n times (n being any integer ≥ 2), is equal to 𝑥 (denoted √𝑥
𝑛

 31 and called a 

radical with radicand x and index n). Especially, the following applies for the nth root 

of a positive real number x: 

   √𝑥
𝑛

= 𝑥
1

𝑛   for 𝑛 ≥ 2 ∈ ℤ and 𝑥 ≥ 0    (2) 

(Yoshiwara & Yoshiwara, 2007, pp. 268–269). 

                                                        

30 Unit fractions are fractions with 1 in the numerator, i.e. on the form 
1

𝑛
, n a non-zero integer 

(Webpage: Unit Fraction E. W. Weisstein, 2016). 

31 The symbol √𝑥
𝑛

 refer to the positive root, whereas the negative root is written as − √𝑥
𝑛

 (Yoshiwara & 

Yoshiwara, 2007, p. 268, p. 275). 
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For the realisation of (2), the third law of exponents (𝐿3)  in the subsection on Laws of 

exponents further below) is usable, since it leads to the following equality: 

  (𝑥
1

𝑛)
𝑛

= 𝑥
1

𝑛
·𝑛  =  𝑥. 

A common misunderstanding to be noted, when considering a power with exponent  

1

𝑛
 (𝑛 ≥  2 ∈ ℤ), is that 

1

𝑛
 is not the factor of the base; 

  𝑥
1

𝑛 ≠
1

𝑛
𝑥  

(Yoshiwara & Yoshiwara, 2007, p. 269). 

Now, for cases where the exponent is on the form 
𝑚

𝑛
 where  

𝑚, 𝑛 ∈ ℤ,  𝑛 ≠ 0 and 𝑚 ≠ 1, such powers can be written in the two following forms 

involving an nth root:  

𝑥
𝑚

𝑛 = {
(𝑥

1

𝑛)
𝑚

= ( √𝑥
𝑛

)
𝑚

(𝑥𝑚)
1

𝑛 = √𝑥𝑚𝑛

, for 𝑥 > 0, 𝑛 ≠ 0 

(Yoshiwara & Yoshiwara, 2007, pp. 282–283). 

Noteworthy, the third law of exponents (𝐿3)  in the subsection on Laws of exponents 

further below) (as well as the field property of multiplicative commutativity of 

elements in ℚ, whereby 
𝑚

𝑛
=

1

𝑛
· 𝑚 = 𝑚 ·

1

𝑛
 (Webpage: Field Axioms E. W. Weisstein, 

2016)) has been applied in the above presented forms of 𝑥
𝑚

𝑛 . 

Hence, 𝑥
𝑚

𝑛  can either be described as “the nth root of x raised to the mth power” or as 

“the nth root of the mth power of x”.  

Regarding negative rational exponents (i.e. of the form 
𝑚

𝑛
 with n or m being a negative 

integer), the existence of such exponents can be realised through a similar approach 

as the one performed in the reasoning related to the existence of negative integral 

exponents. This is because of the possible denotation 𝑥
𝑚

𝑛 = ( √𝑥
𝑛

)
𝑚

 where m is an 

integer, whereby the same reasoning as that performed for integer exponents can be 

applied - as long as it is possible to extract the nth root of x (to be elaborated further 

below). For n or m negative it therefore also applies that: 
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  𝑥
𝑚

𝑛 = ( √𝑥
𝑛

)
𝑚

=
1

( √𝑥
𝑛

)
−𝑚 =

1

𝑥
− 

𝑚
𝑛

    (3) 

Noticeably, the domain of powers with rational exponents (
𝑚

𝑛
) depends on whether 

the denominator (n) of the exponent is even or odd and whether the base of the 

power is positive or negative. This is due to the fact that the existence of real-valued 

nth roots depends on whether the index, n, is even or odd and whether the radicand is 

positive or negative. Namely, an even root of a negative number is not a real but a 

complex number32. An odd root can, however, be evaluated for both a positive and a 

negative real number as radicand. (Yoshiwara & Yoshiwara, 2007, p. 275). Power 

functions having a power term of the form 𝑥
𝑚

𝑛 , 𝑛 ≥ 2, where 
𝑚

𝑛
 is positive, accordingly 

have different domains depending on whether n is even or odd; respectively ℝ+ ∪ {0} 

and ℝ. Furthermore, zero is not a part of the domain in either case whenever the 

rational exponent, 
𝑚

𝑛
, is negative, since that would mean a denominator equal to zero 

in the last expression of (3). Hence ℝ+\{0} is the domain covering all 𝑥𝑎 , 𝑎 ∈ ℚ.   

As an endnote for rational exponents of powers, they might as well be represented as 

decimal numbers rather than fractions (Yoshiwara & Yoshiwara, 2007, p. 269, p. 285). 

There may lie a conceptual challenge in interpreting a decimal number to be a 

fraction with integral nominator and denominator, i.e. a rational number. 

3. Real exponents of powers (𝑥𝑎  with 𝑎 ∈ ℝ)  

Now, for the comprehension of a power with an exponent being neither integral nor 

rational but irrational, it is more challenging to give meaning to such exponents. The 

justification thereof can be made through an experimenting as well as through a more 

formal approach.  

The experimenting approach requires a calculator and the procedure is to use specific 

examples of how an irrational number (for instance √2) can be approached through a 

sequence of rational numbers (expressed by decimal numbers). This, in order to 

                                                        

32 A complex number can (for 𝑎, 𝑏 ∈ ℝ) be written in the form 𝑎 + 𝑏𝑖, where 𝑖 = √−1 (Yoshiwara & 

Yoshiwara, 2007, pp. 588–590). 
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deduce that any real (and especially irrational) number can be approached through a 

sequence of rational numbers. Then, by considering a power with a specific positive 

base and a specific irrational exponent (for instance 2√2) this kind of power can be 

defined to be a limit - namely the limit of the sequence of powers having the same 

base and exponents equal to the elements of the sequence of rational numbers 

(decimal numbers) with the irrational exponent as a limit. As an example, the case of 

justifying 2√2 can take place as follows. First, it is realised (by use of calculator) that 

√2 can be approached through a sequence of rational numbers; 

{𝑎𝑛} ≔  {1, 1.4, 1.41, 1.414, 1.4142, 1.41421, ⋯ }  

and that these numbers can be written as decimal fractions33, i.e.  

{𝑎𝑛} = {
1

1
,

14

10
,

141

100
,

1414

1000
,

14142

10000
,

141421

100000
, ⋯ } 

Then, 2 is raised to each of these rational numbers, where it is possible to rewrite the 

powers to radicals, for instance 21.4 = 2
14

10 = √21410
, and it is realised that 2√2 can be 

defined as being the limit of the values 2𝑎𝑛 , i.e. lim
𝑛→∞

2𝑎𝑛 = 2√2 (Eureka MathTM, 2015, 

p. 78). As an alternative, the existence of the irrational power under consideration 

can be realised through squeezing it between rational powers with the same base, 

using inequality signs, and then adding more and more decimals (known from using 

the calculator). For instance, by starting out by writing: 21 < 2√2 < 22, followed by: 

21.4 < 2√2 < 21.5 and so on, in order to acknowledge that the irrational power (here 

2√2) is the only number which for certain is ...contained in every interval... (Eureka 

MathTM, 2015, p. 80).  

The more formal approach is to prove that, for 𝑥 > 0 and 𝑎 ∈ ℝ and {𝑎𝑛} being a 

sequence of rational numbers converging to 𝑎 ∈ ℝ, the sequence {𝑥𝑎𝑛} is convergent 

with limit 𝑥𝑎  (existence). Further, if {𝑠𝑛} is also a sequence of rational numbers 

converging to a, then it can be proven that lim
𝑛→∞

𝑥𝑠𝑛 = lim
𝑛→∞

𝑥𝑎𝑛  (uniqueness). Both the 

                                                        

33 A decimal fraction is a fraction of the form 
𝑚

10𝑛 with 𝑚 ∈ ℤ and 𝑛 ∈ ℤ+ (Webpage: Definition of 

Decimal Fraction, 2016). 
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existence and the uniqueness proof are noticeably not straightforward to perform 

and are based on completeness of the real numbers, being possible to express as 

limits of convergent (Cauchy) sequences34 of rational numbers regardless of which 

real number should be expressed (Webpage: Cauchy sequence, 2016).  

More details on the formal approach can be found in (Bremigan et al., 2011, pp. 434–

435). 

As for the domain of the base x of powers 𝑥𝑎 , with a irrational, it is the same as that of 

bases of rational powers. This is due to the fact that 𝑥𝑎  is defined to be a limit of a 

sequence of rational powers ({𝑥𝑎𝑛}) whereby the base can only attain the values 

possible for the base of a rational power. Hence, the domain of the power function 𝑥𝑎 , 

for 𝑎 an arbitrary irrational number, is ℝ+\{0}. 

An endnote for this review of the possible exponents of a power (1), 2) and 3) above), 

is that a restriction of the base x, which covers all the cases, is 𝑥 > 0 (or 𝑥 ∈ ℝ+\{0}). 

This explains why it is common to make such a restriction of the domain of a power 

function when defining it (for instance (implicitly) in the teaching material related to 

this study (section 4.2.3)) since it applies to every type of real exponent. 

Next, the power function will be put in relation to three other elementary types of 

functions (represented in the curriculum of high school mathematics - see section 

4.2.2) in order to see what this type of function has to offer compared to the others. 

The power function in relation to other elementary functions 

Along with the three other elementary functions of exponential, linear and 

logarithmic functions, the power function represents a basic type of covariation of the 

variables. Here, covariation is understood to involve a coordination of movement 

from 𝑥𝑚 to 𝑥𝑚+1 and movement from 𝑦𝑚 to 𝑦𝑚+1 (for a function 𝑦 = 𝑓(𝑥)) inspired 

by Confrey & Smith (1994, p. 33). The covariation of the variables of a power function 

can be described as follows: Whenever the independent variable is multiplied by a 

specific value (𝑘 > 0 ∈ ℝ) then the dependent variable is multiplied by a specific 

                                                        

34 A Cauchy sequence is a sequence of elements in which the terms ...become ‘arbitrarily close to each 

other’ as the sequence progresses (Webpage: Cauchy sequence, 2016). 
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value as well (namely 𝑘𝑎). This covariation property will henceforth be denoted (·/·), 

where the first sign represents the operation between the independent variable and 

the specific constant, k, and the second sign; the corresponding operation between 

the dependent variable and the specific constant, 𝑘𝑎. Noticeably, this property of the 

power function is also referred to as the “percent/percent property” of power 

growth, since the factors 𝑘 and 𝑘𝑎 each can be expressed as 𝑝 = 1 + 𝑟 for some 

𝑟 > −1 being the rate of growth/decay (Clausen, Schomacker, & Tolnø, 2013b, pp. 

76–79, p. 100). The percent/percent property (henceforth denoted (%/%)) will 

continuously occur as an aspect of the (·/·) covariation throughout the thesis. 

The covariation (·/·), characterising the power function, differs from those 

characterising the three other types of functions just mentioned - see Table 1. 

 Linear Exponential Logarithm Power 

𝑥 + + · · 

𝑓(𝑥) + · + · 
 

Table 1 The covariation of the variables of the four types of functions; Linear, Exponential, Logarithmic and Power 

functions. 

The exponential function can be defined as: 

  𝑓(𝑥) = 𝑏𝑎𝑥, where 𝑎 > 0 and 𝑎 ≠ 1 , 𝑏 > 0 and 𝑥 ∈ ℝ, 

where a is called the base of the function. 

Noticeably, the restriction of 𝑎 ≠ 1 is not always made (for instance not in the 

definition of the textbook (Clausen et al., 2013b, p. 84) presented in section 4.2.3). 

This simply relates to the choice of considering the constant function 𝑓(𝑥) = 𝑏, 𝑏 > 0) 

an exponential function or not. (Yoshiwara & Yoshiwara, 2007, pp. 340–341). The 

covariation of the variables of this function is denoted (+/·), meaning that whenever 

a specific value (k) is added to the independent variable then the dependent variable 

is multiplied by a specific value (namely 𝑎𝑘 when the function is defined as above) - 

see Table 1. 
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For the logarithmic function (base a), which is defined as the inverse function35 of the 

exponential function of the same base and as being of the form: 

  𝑓(𝑥) = 𝑙𝑜𝑔𝑎(𝑥),  where 𝑎 > 0  and 𝑎 ≠ 1 and 𝑥 > 0 36 

(where 𝑦 = 𝑙𝑜𝑔𝑎(𝑥) ⇔  𝑥 = 𝑎𝑦), the covariation of the variables is (·/+). This, since 

whenever the independent variable is multiplied by a specific value (k) then a specific 

value (𝑙𝑜𝑔𝑎(𝑘)) is added to the independent variable - see Table 1 (Yoshiwara & 

Yoshiwara, 2007, p. 422, p. 425).  

Finally, for linear functions, defined to be of the form: 

  𝑓(𝑥) = 𝑎𝑥 +  𝑏, where 𝑎, 𝑏 ∈ ℝ and 𝑥 ∈ ℝ, 

where a is called the slope (or gradient), the covariation of the variables is (+/+), 

since whenever a specific value (k) is added to x, then a specific value (𝑎𝑘) is added to 

f(x) - see Table 1 (Yoshiwara & Yoshiwara, 2007, pp. 77–78). 

There may lie a conceptual challenge as to understand the covariation (·/·) 

characterising power functions, since it may not seem as intuitive as the case where 

adding something to the independent variable leads to a change in the dependent 

variable - which is the case for both linear and exponential functions; being the two 

types to which the Danish students have already been introduced in primary school 

(mainly linear functions) (Webpage: Tal og algebra - 7. - 9. klasse - Matematik, 2016). 

The power function in relation to the exponential function 

One of the first things to capture one’s attention, when considering the algebraic 

expression of a power function, is that it looks very similar to that of an exponential 

function. The difference lies in whether the base is a variable and the exponent is a 

                                                        

35 An inverse function of a function f, with domain A and range B, is a function g with domain B and 

range A satisfying 𝑓(𝑔(𝑏)) = 𝑏 for all 𝑏 ∈ 𝐵 as well as 𝑔(𝑓(𝑎)) = 𝑎 for all 𝑎 ∈ 𝐴 (Webpage: Inverse E. 

W. Weisstein, 2016). 

36 Noticeably, the base (a) is often chosen to be 10 (the common logarithm; denoted log) or Euler’s 

number 𝑒 (the natural logarithm; denoted ln)(Webpage: Logarithm, 2016). Furthermore, the reason 

for the restriction 𝑎 ≠ 1 can be related to the exponential function of base a not being a constant 

function (see definition of exponential function). 
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constant (power function) or if it is the other way around (exponential function). The 

two function types may locally look like each other in their graphic representations as 

well, but the characters of their growths are very different. Cases where there are 

especially significant similarities to be found between the two functions, are when the 

exponent for the power function and the base of the exponential function is the same 

positive integer. This is because of the similar domain in such cases (namely ℝ) (see 

the subsection on The domain of a power function above) as well as the fact that both 

of the graphic representations have the property of getting steeper for 𝑥 > 0 as the 

exponent of the power function, respectively the base of the exponential function, 

increases (Webpage: Power Functions and Exponential Functions, 2016). Further, the 

locations of the graphs where the graphic courses look alike are within the same 

quadrant of the coordinate system (namely the first), which is not the case for 

negative exponents of the power function compared to exponential functions with 

bases greater than 0 and smaller than 1 (where both functions are decreasing) - see 

for instance the graphs of 𝑥−3 and 0.05𝑥  in Figure 18. 

 

 

As an example of a couple of respectively an exponential function and a power 

function with the same positive integer as base respectively exponent are 𝟐𝒙 and 𝒙𝟐 

whose graphical representations are presented in Figure 19.  

Figure 18 Plot of 𝒇(𝒙) = 𝒙−𝟑 and 

𝒈(𝒙) = 𝟎. 𝟎𝟓𝒙 made in GG. Here it is 

seen that the courses of the two 

graphs look alike for the part of the 

exponential graph located in the 

second quadrant whereas the similar 

part of the power graph is located in 

the first quadrant. 
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Figure 19 Plot of 𝒇(𝒙) = 𝒙𝟐 and  

𝒈(𝒙) = 𝟐𝒙 made in GG. 

The functions are clearly similar with respect to their domain (ℝ) but also in the way 

that, for 𝑥 > 0, they both approach infinity for increasing values of x. There are 

however important differences of the two functions. The intersections of the graphs 

and the second axis differ in the way that it is (0,0) for any power function whereas it 

is (0, 𝑏) for an exponential function of the form introduced in the definition earlier (in 

the case of 𝑥2 it is (0,1)). Furthermore, exponential functions always have the x-axis 

as horizontal asymptote, whereas power functions with positive exponents do not 

have any asymptotes. Additionally, in this example the following applies; The 

exponential function approaches zero while the power function approaches the [...] 

positive infinity [...] when x approaches negative infinity (Webpage: Power Functions 

and Exponential Functions, 2016). Finally, 2𝑥  dominates 𝑥2 for sufficiently large x 

which can be seen where the graph of the exponential function gets significantly 

steeper per x-unit than the power function (Figure 19). This holds for any positive 

integer and actually also any positive real number working as base respectively 

exponent for the exponential and the power function (Webpage: Power Functions 

and Exponential Functions, 2016).  

As an end note for this comparison, there is a clear difference between the graphic 

representations for a power and an exponential function when the domain of the 

power function is restricted to be 𝑥 > 0, since the graph of the exponential function 

runs in both the first and the second quadrant where the graph of the power function 

only runs in the first quadrant. Further, another aspect of the challenge in 

distinguishing the two types of functions is whether one understands what it means 

to raise a number to a power and not confuses the order of the base and the exponent. 
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The power function in relation to the linear and the logarithmic function 

Regarding the two other types of functions presented in Table 1, the power function 

has a close relation to linear functions when the exponent is equal to 1 since in such 

cases, it is in fact a linear function of the form 𝑓(𝑥) =  𝑏𝑥, 𝑏 ∈ ℝ\{0}. It may be 

confusing to realise that it is okay for a power function to be linear of this form - 

especially when it is represented graphically. 

The logarithmic function (being the inverse to the exponential function) has a 

relevant role when manipulating with the algebraic expression of power functions, 

since it can function for pulling down exponents. The second of the following three 

properties of logarithms (base 𝑎 > 0) for 𝑥, 𝑦 > 0 is relevant for such actions: 

a) 𝑙𝑜𝑔𝑎(𝑥 · 𝑦) = 𝑙𝑜𝑔𝑎(𝑥) + 𝑙𝑜𝑔𝑎(𝑦) 

b) 𝑙𝑜𝑔𝑎 (𝑥𝑘) = 𝑘 · 𝑙𝑜𝑔𝑎(𝑥)   

c) 𝑙𝑜𝑔𝑎 (
𝑥

𝑦
)  =  𝑙𝑜𝑔𝑎(𝑥) − 𝑙𝑜𝑔𝑎(𝑦) 

(Yoshiwara & Yoshiwara, 2007, p. 366). 

It may however be a challenge not just to consider the logarithmic function (and the 

properties thereof) as a tool for solving equations involving powers, rather than being 

a function. 

An endnote, for this review of the power function in relation to other elementary 

functions, is that it also has a significant relation to polynomials since it is in fact a 

polynomial (being of the form 𝑓(𝑥) = 𝑏𝑥𝑎)) when a is a positive integer (Webpage: 

Polynomials, 2016). Noticeably, polynomials have not yet been formally introduced to 

the students of the Power Function course, since the teacher teaching the Power 

Functions course (TP) follows the order of mathematical themes as they are presented 

in the textbook where Polynomials are introduced in the subsequent chapter of that 

introducing Power Functions (see section 4.2.3). 
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Laws of exponents 

The properties a) and c) of logarithms (introduced just above) noticeably look similar 

to the following two laws of exponents, for 𝑚, 𝑛 ∈ ℝ: 

𝐿1) 𝑎𝑚 · 𝑎𝑛  =  𝑎𝑚+𝑛   

𝐿2)  
𝑎𝑚

𝑎𝑛  =  𝑎𝑚−𝑛   

(Yoshiwara & Yoshiwara, 2007, p. 311). 

The algebraic structure of these laws can be difficult to remember and one may 

misunderstand 𝐿1)  and write 𝑎𝑚 · 𝑎𝑛 = 𝑎𝑚·𝑛 or 𝑎𝑚+𝑛 = 𝑎𝑚 + 𝑎𝑛, when simplifying 

or expanding powers with the same base, which is not valid, or think that it holds for 

powers with different bases, but 𝑎𝑚 · 𝑏𝑛 ≠ (𝑎 · 𝑏)𝑚+𝑛 (Yoshiwara & Yoshiwara, 2007, 

p. 743). Similarly, such misjudgements can be made for the operations / and − 

involved in 𝐿2). Furthermore, there exist the following three laws of exponents  

(for 𝑏 ≠ 0): 

𝐿3)  (𝑎𝑚)𝑛 = 𝑎𝑚𝑛,  

𝐿4)  (𝑎 · 𝑏)𝑛  =  𝑎𝑛 · 𝑏𝑛  and   

𝐿5)  (
𝑎

𝑏
)

𝑛

=
𝑎𝑛

𝑏𝑛  

(Yoshiwara & Yoshiwara, 2007, p. 311). 

It may be a challenge to distinguish between 𝐿3)  and 𝐿1)  when working with powers 

with the same base, i.e. to distinguish between the following expressions; 𝑎𝑚 · 𝑎𝑛 and 

(𝑎𝑚)𝑛 and remembering when to add respectively multiply the exponents when 

simplifying (Yoshiwara & Yoshiwara, 2007, p. 745). Similarly, such challenges, in 

distinguishing the laws from each other, may occur between 𝐿2)  and 𝐿5). Regarding 

𝐿4), there may lie a challenge in distinguishing between expressions of the form 𝑎 · 𝑏𝑛 

and (𝑎 · 𝑏)𝑛 where the law only applies for the latter as well as in not applying the law 

on sums; (𝑎 + 𝑏)𝑛 ≠ 𝑎𝑛 + 𝑏𝑛 (Yoshiwara & Yoshiwara, 2007, p. 746). 

The laws can however quite readily be realised by thinking of the exponent as a 

positive integer (see subsection on The domain of a power function further above) 

and writing what the left side of the equalities means, for instance for 𝐿5): 

(
𝑎

𝑏
)

𝑛

=
𝑎

𝑏
·

𝑎

𝑏
· ⋯ ·

𝑎

𝑏
 (𝑛 𝑡𝑖𝑚𝑒𝑠) =

𝑎·𝑎·⋯·𝑎 (𝑛 𝑡𝑖𝑚𝑒𝑠)

𝑏·𝑏·⋯·𝑏 (𝑛 𝑡𝑖𝑚𝑒𝑠)
=

𝑎𝑛

𝑏𝑛
 . 
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Applications of the power function 

This section ends with a consideration of the application oriented rationale of the 

theme of Power Functions. First of all, the power function is applicable for describing 

areas and volumes of geometrical objects such as cubes and spheres. For instance, the 

surface area (y) of a cube with side length x can be expressed as 𝑦 = 6𝑥2 (Webpage: 

The Power Function, 2016). Another relevant example is the study of relations 

between body size to different biological parameters, called allometry. Such relations 

are namely often described through equations of the form of power functions 

(Webpage: Allometry, 2016). For instance, the relation between the metabolic rate37 

and the mass of an animal introduced by Max Kleiber (in 1932) can be expressed as a 

power function (Yoshiwara & Yoshiwara, 2007, pp. 233–234) . Noticeably, when 

introduced to a power model, there lies a significant task of interpreting the algebraic 

expression to be that of a power function and not just having a focus on it being a 

formula for calculating some real variable, such as the surface area of a cube (given a 

side length) or the metabolic rate of an animal (given its weight). 

Another aspect of applications of power functions to real variables are the cases 

where one is given a set of data (on two real variables) where the relation between 

the variables of the data set is to be fitted into a power function equation - through 

regression38. To be noted power regression is often performed as linear regression of 

the transformed functional equation appearing when evaluating the logarithm of each 

side; log(𝑓(𝑥)) = log(𝑏) + 𝑎 · log(𝑥).  

Without going into further details of the type of regression, it is most common for the 

linear regression to be made through the method of Least Squares which seeks to 

minimize ...the sum of the squares of the offsets ("the residuals") of the points from the 

curve (Webpage: Least Squares Fitting, 2016) - where the here-mentioned curve is 

the bid on the best-fitting curve. (Webpage: Linear Regression E. W. Weisstein, 2016; 

                                                        

37 Metabolic rate denotes the ...body’s energy expenditure per unit of time (Webpage: Metabolic rate, 

2016). 

38 Regression is to be understood as a ...method for fitting a curve (not necessarily a straight line) 

through a set of points using some goodness-of-fit criterion (Webpage: Regression E. W. Weisstein, 

2016). 
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Webpage: The Power Function, 2016). Noticeably, the quality of the least squares 

linear regression can be assessed through evaluating the correlation coefficient 

(denoted 𝑟2) - where a correlation coefficient equal to 1 indicates a perfect fit 

(Webpage: Correlation Coefficient, 2016). The aspect of assessing and choosing a type 

of regression will not be further elaborated39, since it is not relevant for the Power 

Function course of this observation study where the students are only required to be 

able to solve tasks asking for fitting the given data to a power model - hence, not for 

assessing the type of regression (see section 4.2.2). 

4.2.2 The Curriculum in Relation to the Theme 

This section is concerned with presenting the mathematical knowledge to be taught 

and learned in high school in relation to the theme of Power Functions at the level 

current for the class being taught in this theme of the observation study. More 

specifically, the attention is oriented towards the curriculum for B-level mathematics 

for high school (C-B) (Undervisningsministeriet, 2013b), which serves as curriculum 

for the students in the class being taught in the theme. Parts of C-B, as well as 

supporting parts of the teacher’s guide for C-B (TG-B) (Matematik B - stx vejledning, 

2010), related to the theme will be singled out and associated with the types of tasks 

occurring in the written examination.  

Now, the parts of the core substance (section 2.2 of C-B) in which the theme of Power 

Functions is clearly involved can be listed as follows: 

(1) The expanded notion of a power40, 

(2) Equation solving through both analytic and graphic methods41 and by using IT-

tools, 

                                                        

39 For further discussion on this matter, see Jeanette Kjølbæk’s master thesis (Webpage: One-

dimensional regression in high school Jeanette Kjølbæk, 2016).  

40 The expanded notion of a power refers to the case where the notion of a power is expanded from only 

being considered as positive integers (Webpage: Det udvidede potensbegreb, 2016). 

41 Analytic methods refer to classical manipulation with the algebraic representation of an equation 

whereas graphic methods refer to drawing/plotting the graph of the equation in a coordinate system 

and reading off the solution (Webpage: Ligningsbegrebet, 2016). 
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(3) Formula expressions for describing direct and inverse proportionality and for 

expressing power relations between variables,  

(4) The notion of 𝑓(𝑥),  

(5) Characteristic properties of the power function (along with linear functions, 

polynomials, exponential- and logarithmic functions) involving the meaning of the 

constants in the functional equation, in relation to the look of the graph, as well as the 

relation between the percentage rate of growth for the dependent and the 

independent variable and the characteristic properties of the graphical course of the 

function (TG-B, p. 16), 

(6) Application of regression, and fundamental properties of mathematical models 

and modelling42 in general. 

The above presented core substance is represented in the exercises for the written 

examination related to the theme of Power Functions which is to be elaborated in the 

following. Based on the written examinations from 2007-201543, where 𝑇𝐸𝑃6
 is the 

only one of the types of tasks which can be found in the part of the examination 

without aids, the following list of represented types of tasks (denoted 𝑇𝐸𝑃) has been 

made and the figures Figure 20-Figure 23 present specific examples thereof 

(translated from Danish44): 

𝑻𝑬𝑷𝟏
: Given an equation of a power function, 𝑓(𝑥), and 𝑥0. Determine 𝑓(𝑥0). 

𝑻𝑬𝑷𝟐
: Given an equation of a power function, 𝑓(𝑥), and 𝑓(𝑥0). Determine 𝑥0. 

                                                        

42 Mathematical modelling is understood as cases where mathematics is brought into play and used for 

treating cases outside mathematics itself, for instance setting up a model of power growth in order to 

describe and predict a specific development (TG-B p. 27). Noticeably modelling and regression are 

strongly related as mathematical concepts - when performing regression, a model is made for the data. 

43 Noticeably the written examinations from earlier years are not publicly accessible why there is made 

no explicit references thereto, besides from the specific examples of exercises and tasks from some of 

the written examinations presented in the figures of this section. 

44 Noticeably, the notation of decimal numbers has also been translated from the use of “,” to “.”. 
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𝑻𝑬𝑷𝟑
:  Given a power function 𝑓(𝑥)(or 𝑦). Determine the percentage change of 

  𝑓(𝑥)(or 𝑦), given a percentage change (𝑟 · 100) of 𝑥. 

 

Figure 20 Exam exercise from 2015 (May 28th) involving tasks of type 𝑻𝑬𝑷𝟏
 and 𝑻𝑬𝑷𝟐

 (in part a)) and 𝑻𝑬𝑷𝟑
(part 

b)). 

𝑻𝑬𝑷𝟒
:  The function 𝑓(𝑥) = 𝑏 · 𝑥𝑎  (or 𝑦 = 𝑏 · 𝑥𝑎) satisfies 𝑓(𝑥1) = 𝑦1  

  (or 𝑏 · 𝑥1
𝑎 = 𝑦1) and 𝑓(𝑥2) = 𝑦2 (or 𝑏 · 𝑥2

𝑎 = 𝑦2). Determine an equation 

  (or the constants a and b) for f (or the relation between x and y). 

 

Figure 21 Exam task from 2012 (May 25th) of type 𝑻𝑬𝑷𝟒
. 

𝑻𝑬𝑷𝟓
:  Given a set of data for two variables. It is assumed that the relation 

  between the variables can be expressed as a power function equation, 

  𝑓(𝑥) = 𝑏 · 𝑥𝑎. Use the data to determine a functional equation for f (or 

  the constants a and b). 
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Figure 22 Exam exercise from 2012 (August 15th) involving tasks of type 𝑻𝑬𝑷𝟓
 (part a)), 𝑻𝑬𝑷𝟐

(part b)) and 

𝑻𝑬𝑷𝟑
(part c)). 

 𝑻𝑬𝑷𝟔
:  Two variables, x and y, are inverse proportional. Given a table presenting 

  one pair of values of these variables in relation to each other as well as 

  another value of 𝑥; 𝑥0, where the related value of 𝑦; 𝑦0, is not presented. 

  Fill out the rest of the table. 

 

Figure 23 Exam task (in the part without aids) from 2014 (May 27th) of the type 𝑻𝑬𝑷𝟔
. 

In prolongation of the latter presented type of task (𝑇𝐸𝑃6
), concerning inverse 

proportionality, Figure 24 presents an exercise involving both direct and inverse 

proportionality and may provide a perspective for which types of problems involving 



58 

 

proportionality the students should be able to solve. 

 

Figure 24 Exam exercise from 2007 (August 6th), in which both direct and inverse proportionality are 

represented (point (3) of the core substance), where equation solving is needed in order to solve the task of 

expressing z by x (i.e. point (2) of the core substance is represented as well). 

Noticeably, the task of type 𝑇𝐸𝑃6
 (Figure 23) and the exercise in Figure 24 have not 

occurred since 2008 and 2007 respectively, whereas the rest of the presented types 

of tasks in the list above are more common.  

An important thing to be noted in the formulations of 𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

 is the fact that none 

of these involve any explicit questions for explanations involving an establishment of 

a knowledge block, since the main terms used are determine, fill out and express. 

Now, analytic techniques for the types of tasks 𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

will be sketched and put in 

relation to the listed parts of the core substance apart from the points (1) and (4), if 

any relation thereto. The elimination of these two points for this review is due to the 

fact that they are represented implicitly in many tasks related to the theme of power 

functions. Point (1) is namely represented whenever a power function has an 

exponent different from a positive integer. Further, the point (4) is represented 

whenever a functional equation is involved in the task. Before sketching analytic 

techniques for the types of tasks 𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

, it should be noted that a more explicit 

review of techniques will be made in section 4.3.3 - namely instrumented techniques 

related to GG. 

Tasks of type 𝑇𝐸𝑃1
and  𝑇𝐸𝑃2

 can be solved by inserting respectively 𝑥0 or 𝑓(𝑥0) in the 

functional equation for 𝑓(𝑥) and subsequently calculating either the right side of the 

equation or solving the equation with respect to 𝑥0. Both 𝑇𝐸𝑃1
and  𝑇𝐸𝑃2

 clearly 

represent point (2) of the core substance.  

As for tasks of type 𝑇𝐸𝑃3
, these can be solved through realising that x is multiplied by 
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𝑘 = 1 + 𝑟. Thereafter, one should calculate k raised to the ath power (𝑘𝑎), subtract 1 

from the result and multiply it by 100. (See the (%/%) property in section 4.2.1; in 

the subsection The power function in relation to other elementary functions). Both the 

points (2), (4) and (5) of the core substance are represented in connection with 𝑇𝐸𝑃3
.  

Tasks of type 𝑇𝐸𝑃4
can be solved by inserting the coordinates of the two given points in 

the formula for a (presented in section 4.2.3 below as expression (4)) and calculate it. 

Thereafter one should insert the coordinates of one of the given points and the 

calculated value of a in the formula for b (presented in section 4.2.3 below as 

expression (5)). If asked for the functional equation one should finally write the 

equation for 𝑓(𝑥) (or (𝑦)) with the values of a and b inserted. The points (2), (3), and 

to some extent (5) of the core substance are represented in relation hereto. The latter 

point, since the technique for these types of tasks may involve using some of the 

properties of the logarithmic function (see section 4.2.1 above) for establishing the 

formula for a.  

Regarding tasks of type 𝑇𝐸𝑃5
, especially point (6) but also point (3) of the core 

substance are represented. To solve a task of type 𝑇𝐸𝑃5
, one can plot the points of the 

set of data in a coordinate system and fit the data to the equation of a power through 

regression. Noticeably, a CAS tool/IT-tool is very convenient for performing 

regression (see instrumented techniques in GG in section 4.3.3).  

Now, for the type of tasks 𝑇𝐸𝑃6
, it especially represents point (3) but also point (2) of 

the core substance. Such a task can be solved by inserting the given pairs of values of 

x and y in the equation for inverse proportionality between x and y; 𝑥 · 𝑦 = 𝑘, to 

calculate the constant of proportionality k (inverse proportionality is presented in 

section 4.2.3 below). Then 𝑥0 and k are to be inserted in the equation for inverse 

proportionality and one should then solve the equation with respect to the related 

value of y (𝑦0). For the exam exercise in Figure 24 one should, besides from the 

equation for inverse proportionality, noticeably also be able to apply the equation for 

direct proportionality between two variables x and y; 𝑦 = 𝑘 · 𝑥 (also presented in 

section 4.2.3 below).  
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4.2.3 The Teaching Material 

The teaching material, used by TP, is the textbook Gyldendals Gymnasiematematik 

Grundbog B1 (Clausen et al., 2013b) and its associated exercise book (Clausen, 

Schomacker, & Tolnø, 2013a). The existing exercises, concerning power functions, in 

the exercise book will however not be considered further. This, since the main types 

of tasks for the students to be able to solve are the types drawn from the written 

examinations, introduced in the section just above (4.2.2). It should however be noted 

that in the first section of the exercise book, called Tools (translated from Danish), the 

laws of exponents are presented. This, only for positive integer exponents to begin 

with. Subsequently, exponents equal to zero, negative integers and rational numbers 

are defined under the category of the expanded notion of a power. The case of 

irrational exponents is finally mentioned as an option, noting that the explanation of 

how such powers are defined will not be made. (Clausen et al., 2013a, p. 15). 

The textbook introduces the power function implicitly to begin with, in the subsection 

2.2 introducing examples of relations between variables, through examples such as 

the circumference and the area of a square with side length 𝑥. The examples of this 

subsection involves, noticeably, many linear relationships without an added constant 

in the expression (i.e. also power functions, but often just considered linear or as 

proportionality relations). (Clausen et al., 2013b, pp. 50–55). The theme of Power 

Functions is formally introduced after the introduction of Linear Functions and 

Linear Growth, Calculations with Percentages, Logarithms and Exponential Functions 

and Exponential Growth and within the chapter before the chapter (Chapter 2) 

concerning Polynomials (Chapter 3) (Clausen et al., 2013b). More specifically, the 

section on Power Functions and Power Growth (2.8) starts out by defining the power 

function to be a function of the form 𝑓(𝑥) = 𝑥𝑎, introduced immediately after the 

definition of a power relation to be of the type 𝑦 = 𝑏 · 𝑥𝑎 . It is then noted that 𝑏 > 0 

and that a does not have to be a positive number - actually 𝑎 ∈ ℝ is supposed, though 

not explicitly, but the lack of restrictions on the domain of a and the options of 𝑎 < 0, 

𝑎 = 0, 0 < 𝑎 < 1 and 1 < 𝑎, throughout the section, indicates it. (Clausen et al., 

2013b, p. 94). Noticeably, nothing is explicitly stated about the domain of f in this 

definition, but there seems to prevail an assumption that x is strictly greater than 
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zero, from how the graph types and calculations, involving x-values in denominators 

and x-values being independent variables of the logarithmic function (having ℝ+ as 

domain - see section 4.2.1, subsection: The power function in relation to other 

elementary functions), are presented throughout the section (Clausen et al., 2013b, pp. 

94–101). The definition is followed by a set of examples introducing power relations 

of variables (Clausen et al., 2013b, pp. 94–95). 

Then, power regression is introduced through two examples, the first of which 

concerns a data set of two variables, presented in a table. The task is of the type 𝑇𝐸𝑃5
. 

The second example concerns power regression based on only two pairs of related 

values of variables. The two examples present the answer, of which equation that can 

be said to describe the power relation - both its algebraic and graphic representation 

- but techniques in relation thereto are not introduced. (Clausen et al., 2013b, pp. 95–

96). To be noted, there is however a separate section elaborating on how to do 

regression (section 2.10, pp. 104-110), which opens by referring to the use of a tool 

(e.g. CAS) to do regression. Through examples, it is here introduced how one should 

approach tasks of regression without any explicit introduction to the instrumented 

techniques required, only a reference to using a (unspecified) CAS tool for such tasks. 

Back to the section on Power Functions (2.8), 

some properties of these functions are 

presented, in terms of the different look and 

conditions of monotony of the graph of  

𝑓(𝑥) = 𝑥𝑎 , depending on the value of a, 

presented through a figure (Figure 25). 

Further, which asymptotes there may be 

connected to the graph is presented and finally 

determination of the values of a and b in the 

equation 𝑦 = 𝑏 · 𝑥𝑎  knowing two points on the 

graph. Figure 25 The figure introducing the different 

looks of the graph of a power function 𝒇(𝒙) = 𝒙𝒂 

from the textbook (Clausen et al., 2013b, p. 96). 
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The formulas of a and b when knowing two points on the graph of the power function 

f is introduced through a theorem - henceforth denoted 𝑇ℎ𝑚𝑎𝑏. 𝑇ℎ𝑚𝑎𝑏 states:  

Given two points 𝑃(𝑥1, 𝑦1) and 𝑄(𝑥2, 𝑦2) on the graph of 𝑦 = 𝑓(𝑥) = 𝑏 · 𝑥𝑎 , the 

numbers a and b can be calculated as follows:  

First calculation:  𝑎 =
log(

𝑦2
𝑦1

)

log(
𝑥2
𝑥1

)
 or 𝑎 =

ln(
𝑦2
𝑦1

)

ln(
𝑥2
𝑥1

)
,    (4)  

Second calculation:  𝑏 =
𝑦1

𝑥1
𝑎    (5) 

(Clausen et al., 2013b, p. 97). 

The proof of 𝑇ℎ𝑚𝑎𝑏 is presented immediately after but without any explanations for 

the involved equation solving, i.e. the knowledge block of the praxeology of the proof 

is not elaborated. Furthermore, no explicit restrictions are made as to not having zero 

in the denominators of the fractions involved in the theorem, nor is it noted that the 

logarithm only can be evaluated for positive input, which must mean that there is an 

implicit comprehension that the domain of the power function is ℝ+. (Clausen et al., 

2013b, pp. 97–98). Thereafter, three examples of tasks related to 𝑇ℎ𝑚𝑎𝑏 are 

presented; one of the type 𝑇𝐸𝑃4
 followed by one where a and a point on the graph is 

known and b has to be determined and finally one of a more simple case where the 

functional equation can be determined without a tool for calculation (Clausen et al., 

2013b, pp. 98–99) (Clausen et al., 2013b, pp. 98–99).  

A power growth is subsequently introduced to denote a relation between two 

variables which can be described by a power function, followed by a theorem 

introducing what is characteristic for a power growth of the form 𝑦 = 𝑓(𝑥) = 𝑏 · 𝑥𝑎 , 

namely the covariation (·/·) (see section 4.2.1). This is followed by a proof which 

mainly consists of techniques. There are noticeably no explanations for these 

techniques (Clausen et al., 2013a, p. 100). Then the covariation (·/·) is reformulated 

into a language involving a (specific) percent change of the independent variable 

implying a specific percent change of the dependent variable (the (%/%) property). 

Subsequently, a couple of examples of tasks involving this property are introduced. 

Both examples involve tasks of the type 𝑇𝐸𝑃3
. The second example further introduces 

a task of determining the percentage change of x, given a percentage change of 𝑓(𝑥) 
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(the reverse version of 𝑇𝐸𝑃3
). As a separate section from the one concerning power 

functions and -growth, just presented, is the one introducing Proportionality and 

Inverse Proportionality (2.9). Here, proportionality and inverse proportionality are 

presented as two important relations of variables as follows; 

(Direct) proportionality: 𝑦 = 𝑏 · 𝑥 or  
𝑦

𝑥
= 𝑏, and 

Inverse proportionality: 𝑦 = 𝑏 ·
1

𝑥
 or 𝑦 = 𝑏 · 𝑥−1 or  𝑦 =

𝑏

𝑥
  

(Clausen et al., 2013b, p. 101). 

Thence, examples of graphs of the two types of relations are introduced with a 

domain being all of ℝ. There is noticeably no reference to the theme of Power 

Functions in this section. Hereby, there is no explicit motivation for introducing the 

two types of relation in prolongation of the theme of Power Functions. This section 

ends by presenting some examples of both (direct) proportionality and inverse 

proportionality, related to reality. Only through these examples, the term of the factor 

of proportionality (also denoted the scale factor) is implemented. (Clausen et al., 

2013b, pp. 101–103). 

4.3 A Priori Analysis of the CAS Tool 

In order to establish the RPM related to the two themes further, this section presents 

the main specific features of the CAS tool (section 4.3.1), GG, as well as the CAS tool in 

relation to the two themes (sections 4.3.2 and 4.3.3). More specifically, this section is 

concerned with RQ0 where the gestures and instrumented techniques possible to 

make in connection with the two mathematical themes in GG are considered, after 

some main specific features of the program have been presented. Where no other 

reference is made, this analysis is based on a review made during the course of this 

study with input from YouTube45 videos, TTW and manuals for GG (Webpage: 

GeoGebra (da), 2016; Webpage: GeoGebra (en), 2016). The analysis is made with 

reservations to the fact that there may be several different approaches to be made for 

using commands in GG in order to solve a specific task (i.e. there can be more than 

                                                        

45 Link: www.youtube.com (last visited 12.07.2016). 
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one instrumented technique/collection of gestures for solving a specific task) and 

also to the full potential of the single command in GG which may not be discovered. 

The focus is put on the gestures concerning clicks with the computer mouse or touch 

pad and not on the several keyboard shortcuts which are possible to make in GG46. 

This priority has been made since the clicking procedure are the same regardless of 

the computer being PC or Mac47. Another reason for focusing on the gestures, used 

with a computer mouse or touchpad, is that using shortcuts requires a rather 

advanced user of GG and both the teacher’s and the students of the two classes 

observed have very little experience with - and knowledge about GG (see section 5.0).  

As a final note, the analysis is based on the language English (US) since it is more 

suitable for the description of the functions and commands in English. It is however 

easy to translate the commands into Danish (more or less directly) - if necessary, 

since some (English) commands work in the same way in both the Danish and English 

setting. 

4.3.1 Main Specific Features 

In this section, general gestures and notions of importance in relation to GG, found 

relevant for both themes, will be presented before linking instrumented techniques to 

the two themes in the two a priori analyses of the themes. The instrumented 

techniques will be presented through specific examples of tasks related to GG. 

GG is overall …dynamic mathematics software that joins geometry, algebra and 

calculus [...] developed for learning and teaching mathematics in schools (Webpage: 

GeoGebra (da), 2016). It exists in both a computer program version (“GeoGebra 5.0 

Desktop”) and in an app version (“GeoGebra 5.0 Web and Tablet App”). The two 

versions have ...minor differences in terms of use and interface design (Webpage: 

                                                        

46 Keyboard shortcuts possible to make in GG can be found on the webpage (Webpage: Keyboard 

Shortcuts, 2016). 

47 To be noted here, the research in this analysis is performed on PCs whereas the observed students 

are Mac users (see section 5.0). 
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GeoGebra (en), 2016). This analysis is noted to be based on the desktop version, used 

for Windows.48 

The user interface of GG can be described roughly through the terms of Views and 

Perspectives where the Perspectives are constituted by a collection of Views. There 

are different possible Views to pursue in GG where the Algebra View, the Graphics 

View, the CAS View and the Spreadsheet View are considered especially suitable for the 

two mathematical themes of this study49. These Views are linked dynamically, 

meaning …that if you modify an object in any of the Views, its representations in the 

other Views automatically adapt to these changes if possible (Webpage: Views, 2016). 

This relation between the Views will be clarified through the specific examples of 

working with GG in relation to the two themes, presented in the a priori analyses 

below. 

The Algebra View displays 

algebraic representations of 

mathematical objects which ...can 

be entered directly using the 

(virtual) keyboard (e.g. coordinates 

of points, equations) (Webpage: 

Views, 2016) in an Input Bar placed 

at the bottom of the GG interface 

(see Figure 26).  

The Input Bar more specifically 

...allows you to directly create and 

redefine mathematical objects in the 

Algebra View by entering or 

                                                        

48 The program GG can be downloaded for free for both Windows, Mac OS X and Linux, for instance 

from (Webpage: GeoGebra - Download, 2016). 

49 Additionally, there is a 3D Graphics View and a Probability Calculator View which are not considered 

suitable for the two themes at this level of high school (Webpage: GeoGebra (en), 2016). 

Figure 26 The interface of GG when opening the program (the 

Algebra Perspective). The green box marks the Menubar, the 

red box marks the Graphics View Toolbar and the purple box; 

the undo and redo buttons in GG. 
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modifying their algebraic representations (e.g. values, coordinates, equations) 

(Webpage: Input Bar, 2016).  

In the Graphics View it is possible to construct mathematical objects, either by using 

mouse or touch pad in relation to its Toolbar (to be explained later). These objects 

can be …changed dynamically afterwards (Webpage: Views, 2016).  

The Spreadsheet View offers an interface for working with data and exploring 

statistical concepts and in the CAS View it is possible to make ...numerical and 

symbolic computations (Webpage: Views, 2016). 

Before going further, it is noted that, throughout the analysis, when referring to 

“click”, ”select” or “choose” gestures, it means using the computer mouse or the 

touchpad. 

Turning towards Figure 26, it shows the interface as it looks when opening the 

program, where the Algebra View and the Graphics View are open - this is called the 

Algebra Perspective (Webpage: Perspectives, 2016). The Perspective can be changed - 

e.g. to Spreadsheet Perspective or CAS Perspective (see Figure 26 where the box with 

“Perspectives” is available in the Sidebar50 of the GG-document). The choice of 

Perspective depends ...on the mathematics you want to use GeoGebra for... (Webpage: 

GeoGebra (en), 2016). Each of the possible Perspectives display ...those Views and 

other interface components most relevant for the corresponding field of mathematics 

(Webpage: GeoGebra (en), 2016). Noticeably, no matter which Perspective one 

chooses as a starting point, it is always possible to add or remove Views to this 

Perspective, depending on what one finds relevant when working with a specific 

mathematical content. The addition of Views is possible through the Menubar 

(marked by a green box on Figure 26 and explained further below) by clicking “View” 

and the shutdown of a View can be done by clicking the cross sign in the upper right 

corner of the View (see Figure 26). The Menubar contains the menus: File, Edit, View, 

Options, Tools, Window and Help. Through these menus it is, besides the opportunity 

of adding Views, possible both to save, open and share documents, to customise the 

                                                        

50 An elaboration of the Sidebar is given on the webpage 

https://www.geogebra.org/manual/en/Sidebar (last visited 01.08.2016).  
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toolbar and search for help for how to approach the tool. It applies for all Views that it 

is possible to correct mistakes step-by-step by using the undo and redo buttons, 

respectively the arrow turning left and the arrow turning right which is marked by 

the purple box in Figure 26. 

An important option is the one of 

editing the preferences for each 

opened View in the GG-document. This 

option is available in a Settings Dialog 

(called Preferences - see Figure 27) 

through the Options menu (in the 

Menubar) by choosing “Advanced” 

(having a sprocket wheel icon) or by 

choosing the small sprocket wheel 

icon to be found underneath the redo 

button (see Figure 26) and then 

selecting “Advanced”.  

As seen on Figure 27, the Settings Dialog is ...divided into different sections, which are 

shown depending on active objects and Views: ’Properties’,  ’Graphics’,  ’CAS’,  

  ’Spreadsheet’,   ’Layout’,  ’Defaults’, and  ’Advanced’ (Webpage: Settings 

Dialog, 2016) and there is an Algebra section as well.  

Within the here mentioned sections, it is possible to change the settings in the GG-

document - both local and global settings. For instance, changing the colour of an 

object (in the Properties section) respectively changing the angle unit between 

radians and degrees in the Algebra Perspective (in the Advanced section). (Webpage: 

Settings Dialog, 2016). In relation to the two themes, there are some more options to 

be noted within the Settings Dialog. In the Graphics section, it is possible to remove or 

add both axes and grid to the Graphics View. In the CAS section, one may both set a 

timeout for the CAS calculations and choose how rational exponents should be 

presented (as roots or not).  

Now, before going further to the features of the Views in GG applicable for both 

themes, it should be noted that decimal numbers are typed using a dot (“.”) and not a 

Figure 27 The Settings Dialog Preferences, called for in a 

GG-document (where a point has been plotted in the 

Algebra Perspective behind the dialog). 
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comma (“,”) (like Danes would do it), regardless of the language chosen for the 

document (through the Options menu). The number of decimals is set to be two when 

opening a new GG document but this can be changed through the Options menu as 

well through clicking on “Rounding”.  

In the following, the general aspects (found relevant for both themes) of the Algebra 

Perspective (the Graphics View and the Algebra View) and thence the CAS View are 

analysed. Since the Spreadsheet View is only relevant for the theme of Power 

Functions, it will only be explored in relation thereto in section 4.3.3. 

The Algebra Perspective 

In Figure 26 it is seen that there is a Toolbar which corresponds to the chosen Views - 

in this case, the Algebra and the Graphics View (marked by a red box in the figure). 

The Toolbar ...contains a selection of Tools and range of Commands as well as 

Predefined Functions and Operators that allow you to create dynamic constructions 

with different representations of mathematical objects (Webpage: GeoGebra (en), 

2016). In order to describe the Graphics View Toolbar, it is worth noting that every 

...icon in the Toolbar represents a Toolbox that contains a selection of related 

construction Tools (Webpage: Graphics View, 2016). From left to right in the red box 

in Figure 26, the following Toolboxes are seen to constitute the Graphics View 

Toolbar: Movements Tools, Point Tools, Line Tools, Special Line Tools, Polygon Tools, 

Circle and Arc Tools, Conic Section Tools, Measurement Tools, Transformation Tools, 

Special Objects Tools, Action Object Tools and General Tools. Here, it is worth 

mentioning that the symbol of each of the Toolboxes (the default construction Tool) 

can be changed ...on the little arrow in the lower right corner of the default Tools 

(Webpage: Tools, 2016). In the two a priori analyses of the mathematical themes 

(sections 4.3.2 and 4.3.3) there will be an elaboration of the Tools found relevant in 

relation to each theme. 
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Besides from using the Toolbar 

for constructing objects in the 

Graphics View, the Style Bar 

(appearing when clicking on the 

downward facing arrow in the 

tab of the Graphics View (marked 

by a purple box on Figure 28)), 

also has some options to offer. It 

is worth mentioning that the 

options of the Style Bar depend 

on the choice of Tool in the 

Toolbar since the Style Bar 

corresponds to the chosen construction Tool.  

Via the Style Bar, it is for instance possible to show or hide both the coordinate axes 

and the grid which is done by respectively using the first and the second option (with 

respectively axes and grid as icons).  

Now, some prospects of the Algebra View 

are to be considered. In Figure 29, the 

Algebra View has been selected and it is seen 

that the exact same Toolbar is available in 

this View as for the Graphics View.  It is 

however not possible to construct anything 

to be manipulated with dynamically within 

the Algebra View, as it more serves as an 

informant for what is going on in the 

Graphics View, so the Toolbar is not used. 

The Input Bar (as shortly presented earlier) 

is instead used to construct or redefine the mathematical objects (e.g. point 

coordinates and functional equations) to be put in the Algebra View. Noticeably, you 

have to ...press Enter after typing algebraic input into the Input Bar (Webpage: Input 

Bar, 2016). Furthermore, the input entered in the Input Bar will automatically be 

given a name if there is not asserted any. Symbolic manipulations are not possible 

Figure 28 The Style Bar of the Graphics View corresponding to 

the Move Tool (marked by a purple box). 

Figure 29 The Input Bar where the alpha box is 

checked, presenting mathematical symbols as 

options to put in the input text. 
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(for this, the CAS View is applicable). Besides from x, y and z (leading to functions), 

you can choose any letter to name inputs not being functions. When placing the 

cursor in the Input Bar, an Alpha box appears far right, containing mathematical 

symbols, including Greek letters and operators such as the degree sign and 

less/greater than or equal to signs, as shown in Figure 29.   

Further, there is an up and 

down arrow button offering 

the Input History in the Input 

Bar when having made some 

inputs in the document, 

where you can ...navigate 

through prior input step by 

step (Webpage: Input Bar, 

2016) and choose the input 

from earlier which is desired 

to work with (see Figure 30). 

As also seen on Figure 30, 

there is a little question mark 

surrounded by an open circle far right in the bottom of the GG view, next to the Input 

Bar, offering Input Help for what is desired as an output. Furthermore, Figure 30 

reveals how the output of the typed input through the Input Bar is organised in 

categories (here; “Function” and “Point”) and the blue bullets in front of the objects 

indicate that they are represented in the Graphics View - when clicking on a bullet, it 

will turn white and the corresponding representation of the object in the Graphics 

View will disappear. 

The CAS View 

In Figure 31 it is seen that there is another Toolbar when working in the CAS View. 

This Toolbar ...provides a range of CAS Tools that allow you to evaluate input and 

perform calculations (Webpage: CAS View, 2016).  

 

Figure 30 Here, the up and down arrow button (marked by the red 

box) has been checked whereby the history pops up as bars in a box. 

Further, the cursor has been put on the Input Help icon. 
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From left to right in the 

red box on Figure 31 the 

following Tools are 

represented; Evaluation 

Tools (consisting of 

three tools marked by 

the green box), Calculation Tools (marked by the purple box), Analysis Tools (marked 

by the orange box) and lastly, the General Tools. Four tools will mainly be used in the 

analyses of the CAS View in relation to the two themes, the first of which is called the 

Evaluate Tool (marked by a blue box in Figure 31) through which it is possible 

evaluate an expression in the CAS View by using the Enter Key (Webpage: Evaluate 

Tool, 2016). The second tool to be used is the Numeric Tool (represented by a  

“≈” -symbol; the second from the left in the green box in Figure 31), relevant for 

getting numerical approximations of expressions in the CAS View, also by using the 

Enter Key (Webpage: Numeric Tool, 2016). The Solve and the Solve Numerically Tool 

are the third and the fourth of the tools to be used, represented by (respectively) a  

“𝑥 =”-symbol and a “𝑥 ≈”-symbol (the fourth and the fifth in the purple box in Figure 

31). Through these two tools, it is possible solve equations in the CAS View. The 

function of these tools will be further elaborated in the a priori analyses of the two 

themes in relation to GG.   

Furthermore, the CAS View offers cells where it is possible to enter the input to be 

evaluated. As Figure 32 shows, 

the cells consist of an Input Field 

(described further below) at the 

top of the cell and an output 

display at the bottom of the cell. 

This is clearly seen in cell 1, 

where “3x^2=12” is the input 

written in the Input Field and the 

output (achieved by clicking on the Solve Tool) is displayed just below next to 

“Solve:”, namely “{x=-2, x=2}”. Cell 2 is empty and ready for a new input to be typed, 

just by clicking on the blank bar which is also called the Input Field.    

Figure 31 The Algebra Perspective of GG with added CAS View and boxes 

constituting the Toolbar connected thereto. 

Figure 32 In cell 1 of the CAS View (added to the Algebra Perspective) 

both an input and an output is displayed (respectively the first and the 

second line of cell 1). 
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The Input Field almost functions as the Input Bar (connected to the Algebra View) but 

there are some differences between the two which will now be explained. In the Input 

Field, it is possible to work with variables which are not assigned any values which 

has been observed not to be possible in the Input Bar. If values are to be assigned, it is 

necessary to type “:=” in the Input Field since “=” is used for equations whereas there 

is no distinctions between “=” and “:=” in the Input Bar. When working with 

multiplication it should be marked explicitly in the Input Field. As an example, it is 

possible to type both “a(b+c)” and “a*(b+c)” in the Input Bar but only “a*(b+c)” is 

valid in the Input Field. Noticeably, a white bullet can be seen underneath number 1 

and in front of the output display in the first cell on Figure 32. By clicking on this 

bullet, the output will be represented in the other Views, if possible. When doing so, 

the colour of the bullet turns from white into blue.  

GG worksheets  

As a final note for this review of the main features of GG, it is possible to make 

dynamic worksheets in GG and share them with other GG users through 

GeoGebraTube (Webpage: GG-worksheets, 2016). GeoGebraTube is an online service 

where everybody has access to shared worksheets worked out for different 

mathematical contents51. As this type of work with GG is categorised as being suitable 

for advanced users and especially relevant for teacher material, such worksheets are 

not designed in the analyses of GG in relation to the themes (Webpage: GeoGebra 

(en), 2016). Selected examples of existing worksheets from GeoGebraTube (referred 

to as GG worksheets or worksheets), and what these have to offer in connection with 

tasks within the two mathematical themes, will however be presented. Danish 

worksheets will here be used as examples, since both the teachers and the students 

are Danish. Quotations from the GG worksheets will nonetheless be made in English 

(directly translated from the Danish sentences). 

 

                                                        

51 Noteworthy, it is possible to download these worksheets so that they can be accessed offline as well 

as online. 
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Next, the a priori analyses of GG in relation to each of the themes of Trigonometry and 

Power Functions will be made (in the sections 4.3.2 and 4.3.3, respectively). These 

analyses will be based on the Algebra Perspective since it, first of all, is the one 

proposed by GG when opening a new document and, secondly, it offers an interface 

appropriate for both of the mathematical themes. The analyses are built up around 

solving given tasks in GG. The (instrumented) techniques will be presented in such a 

way that arrows pointing right (→) are used in in order to separate the (sets of) 

gestures to be made in GG as well as steps of reading off values from the View(s) in 

GG. Furthermore, a common denotation for the techniques is that of applying an 

abbreviation of the View or Perspective in which the technique is performed. Here, 

the Algebra Perspective is abbreviated AP, the CAS View; CV and the Spreadsheet View; 

SV. Further, the developer, being the researcher, is abbreviated TR for the researcher 

of the Trigonometry course and PR for the researcher of the Power Functions course. 

4.3.2 The CAS Tool in Relation to Trigonometry (L) 

This section is concerned with an examination of the potentials of GG in relation to 

Trigonometry. More specifically the potentials refer to the gestures and 

(instrumented) techniques possible to make in GG concerning tasks within the theme. 

The structure of this analysis is inspired by the structure of the review of the main 

specific features in section 4.3.1 just above. That means, first an examination of the 

gestures and techniques (𝜏𝑖) possible to make within the Algebra Perspective (i.e. the 

Algebra View and the Graphics View), then within the CAS View and finally, three 

chosen worksheets, related to Trigonometry, are presented. 

The Algebra Perspective 

First, some possible instrumented techniques to construct triangles in GG, both right 

triangles (RT) and arbitrary triangles (AT), are presented. It should be noted that 

arbitrary triangles are involved in all the exam exercises and tasks presented in 

section 4.1.2 whereas right triangles are not directly related to the presented exam 

exercises and tasks (even though an arbitrary triangle always can be divided into 

right triangles). The construction of a right triangle in GG can be done by adding the 
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grid in the Graphics View such that it makes it easier to make collinear points. 

Constructing the right triangle is done by: 

𝝉𝑹𝑻𝟏,𝑨𝑷,𝑻𝑹
𝒊 : Click on the Polygon Tool  → Place and combine the three points on the 

  grid such that two of the sides of the polygon are constructed by 

  collinear points (The start point is also the point which should be clicked 

  on at the end in order to close the polygon)  

The outcome of this technique is shown on 

the Figure 33. Noticeably, the right angle has 

been measured through applying the Angle 

Tool  (to be elaborated further later in 

this passage). Another way of constructing a 

right triangle is done by: 

𝝉𝑹𝑻𝟐,𝑨𝑷,𝑻𝑹
𝒊 :  Click on the Segment Tool → 

  Place the points in the 

  Graphics View (automatically 

  named A and B) → Choose 

  Perpendicular Line Tool  → 

  Select the line segment and a point (the straight line is created through 

  the point and is perpendicular to the line segment) → Choose the 

  Intersect Tool  (the intersection point can be created in two ways:  

  • Selecting two objects creates all intersection points (if possible),  

  • Directly clicking on an intersection of the two objects creates only this 

  ‘single intersection point’  (Webpage: Intersect Tool, 2016)) → Click on 

  the line segment and the perpendicular line (intersection point is 

  created (automatically named D)) → Click on the Polygon Tool  and 

  combine the points A, C and D. 

Figure 33 The outcome of 𝝉𝑹𝑻𝟏,𝑨𝑷,𝑻𝑹
𝒊 . Further, the 

gesture of measuring an angle has been performed 

in order to check that one angle is right (𝟗𝟎°). 
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The outcome of 𝜏𝑅𝑇2,𝐴𝑃,𝑇𝑅
𝑖  is shown on Figure 34.

 

Figure 34 Shows the right triangle ACD where it is to be noted that point D is in a different shape than the other 

points. This is due to the fact D is fixed to the perpendicular line g and the line segment AB which means that the 

point can only be moved so that it follows the line segment AB.   

A third possible way to construct a right triangle is: 

𝝉𝑹𝑻𝟑,𝑨𝑷,𝑻𝑹
𝒊 :  Click on Segment Tool → Place the points (A and B) in the Graphics 

  View → Select Angle with Given Size Tool  → Click on A and B and type 

  90 ° into the appearing input box (clockwise) → Combine the points A, B 

  and A’ via the Polygon Tool .  

The input box mentioned in the fourth step of 𝜏𝑅𝑇3,𝐴𝑃,𝑇𝑅
𝑖  is illustrated in Figure 35 and 

the outcome of 𝜏𝑅𝑇3,𝐴𝑃,𝑇𝑅
𝑖   is shown in Figure 36. 

Figure 35 Here, the appearing input box is shown where 

an angle of 𝟗𝟎 ° is entered and is chosen to be constructed 

“clockwise”. 
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Figure 36 The outcome of 𝝉𝑹𝑻𝟑,𝑨𝑷,𝑻𝑹
𝒊  in the form of the right triangle ABA’. 

With respect to 𝜏𝑅𝑇3,𝐴𝑃,𝑇𝑅
𝑖  (and Figure 36) it should be noted that GG automatically 

place A’ as an auxiliary point for where the last vertex may be placed. Further, GG 

automatically gives the line segment AB the name f and when the polygon is drawn 

GG name the sides a,b and a’. It is however possible to rename the vertices, the angles, 

the line segments and the sides under “Option properties”. In the Algebra View, it is 

possible to see the values for f, a, b, and a’ and the angle measure for 𝛼 and the 

coordinates for the vertices. Further, the area (related to the type of task 𝑇𝐸𝑇4
) of the 

3-gon is shown in the Algebra View as “poly1”, which in this case is 12.6.  

Additionally, 𝜏𝑅𝑇3,𝐴𝑃,𝑇𝑅
𝑖  is an instrumented technique which can also be used for 

constructing arbitrary triangles. However, none of the angles are here 90°. The 

technique in relation to constructing an arbitrary triangle will however not be 

exemplified since the procedure is the same as that of 𝜏𝑅𝑇3,𝐴𝑃,𝑇𝑅
𝑖 .  

Instead, another technique will be presented for constructing arbitrary triangles. This 

is a possible technique for solving 𝑇𝐸𝑇1
 and the technique presented below will be 

based on 𝜏𝑇𝑇𝑊4
 where 𝐴 = 30°, 𝑏 =  7 og 𝑐 =  5 in triangle 𝐴𝐵𝐶. 

𝝉𝑨𝑻,𝑨𝑷,𝑻𝑹
𝒊 :  Select Segment with Given Length Tool → Click on the point that is 

  chosen to be the starting point of the segment and type the desired 

  length of the segment (i.e. 5) in the appearing window. The line segment 

  AB is hereby constructed. → Click on Angle with Given Size Tool  → 
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  Click on the leg point B and the point A and type 30° into the input box 

  (counter clockwise) (GG automatically place an auxiliary point (B’) on 

  the basis of the constructed angle → Click on Ray Tool  → Select two 

  points A and B’ (Ray is constructed from A and through B’) → Select the 

  Circle with Center and Radius Tool  → Select the center point (in this 

  case; A) and then type the radius of the circle equal to 7 (since 𝑏 = 7 in 

  triangle 𝐴𝐵𝐶 is given) in the text field of the appearing window (now the 

  circle and the ray intersects each other illustrated by Figure 37) → 

  Choose the Intersect Tool  → Click on the ray and the circle (the point C 

  is hereby constructed) → Click on the Polygon Tool  and combine A, B 

  and C [Hide the unnecessary objects (i.e. the circle and the ray) in the 

  Algebra View by clicking on the related blue bullets (turning into white)] 

  → Read the side length of a from the Algebra View in order to answer the 

  task. 

The gestures marked by [ ] are not necessary for answering the task but leads to a 

representation of the relevant objects (being the points and sides of the triangle ABC) 

in the Graphics View - which makes it simpler to consider the triangle ABC.  

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 37 The part of 𝝉𝑨𝑻,𝑨𝑷,𝑻𝑹
𝒊  where the circle and the ray intersect each other. 
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On Figure 38, the final construction 

of an arbitrary triangle using this 

technique is seen.  

𝑇𝐸𝑇2
- 𝑇𝐸𝑇5

 can be answered using the 

same gestures as in 𝜏𝐴𝑇,𝐴𝑃,𝑇𝑅
𝑖  just in a 

different order (and with other 

measures of sides and angles). 

However, to determine unknown 

angles (especially relevant for 𝑇𝐸𝑇2
), 

it is good to know the Angle Tool  

as well, since it will measure the 

desired angle. To construct such an 

unknown angle, there are (at least) 

three options after having clicked on 

the Angle Tool: 

𝝉𝑨𝒏𝒈𝒍𝒆𝟏,𝑨𝑷,𝑻𝑹
𝒊 :  Click on three points where the second point selected 

   becomes the vertex of the angle. 

𝝉𝑨𝒏𝒈𝒍𝒆𝟐,𝑨𝑷,𝑻𝑹
𝒊 :  Click on two line segments and create an angle between the 

   two. 

𝝉𝑨𝒏𝒈𝒍𝒆𝟑,𝑨𝑷,𝑻𝑹
𝒊 :  Click on the constructed polygon. 

For the latter technique, the angle 

measure depends on whether one 

connects the points of the polygon 

clockwise or counter clockwise as 

seen on Figure 39. 

 

Figure 38 The outcome of 𝝉𝑨𝑻,𝑨𝑷,𝑻𝑹
𝒊  in the form of triangle 

ABC. It is clearly seen in the Algebra View that 𝒂 = 𝟑. 𝟔𝟔, 

which gives the answer to the exam question 𝑻𝑬𝑻𝟏
. 

Figure 39 The angles are interior in triangle 

DEF since it is constructed counter 

clockwise whereas triangle ABC has exterior 

angles since the points of the triangle are 

connected clockwise. 
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In GG, it is also possible to construct altitudes, medians, perpendicular bisectors and 

angle bisectors, which are helpful tools in order to answer exercises like the one 

presented in Figure 15 (b)). The median can be constructed by the following 

technique: 

𝝉𝑴𝒆𝒅𝒊𝒂𝒏,𝑨𝑷,𝑻𝑹
𝒊 :  Click on the Polygon Tool  and combine the points of the 

   triangle → Click on Midpoint or Center Tool  → Click on a 

   side in the triangle whereby the midpoint (here named D) of 

   that side is constructed → Click on Segment Tool  → Click 

   on the vertex point (here named A) located opposite to D 

   and click on D (whereby the median is constructed and 

   named f). 

The outcome of this technique is illustrated in Figure 40. 

 

 

  

 

 

 

 

 

Noticeably, 𝜏𝑀𝑒𝑑𝑖𝑎𝑛,𝐴𝑃,𝑇𝑅
𝑖  is a very simple technique for solving the second part of the 

exercise in Figure 15 compared to the one where the median is constructed without 

the use of GG followed by using the Law of Cosine or the Law of Sine. The latter 

technique requires first of all knowing how to construct a median by hand (using 

paper and pencil) and involvement of the Laws in order to determine its length. 

To construct the altitude of an arbitrary triangle the following technique can be 

applied: 

Figure 40 The outcome of 

𝝉𝑴𝒆𝒅𝒊𝒂𝒏,𝑨𝑷,𝑻𝑹
𝒊 . Here, the length of the 

median, named f by GG, is seen in the 

Algebra View to be 𝒇 = 𝟔. 𝟔𝟔. 
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𝝉𝑨𝒍𝒕𝒊𝒕𝒖𝒅𝒆,𝑨𝑷,𝑻𝑹
𝒊 :   Click on the Polygon Tool  and combine the points of the 

   triangle → Click on the Perpendicular Line Tool  → Select 

   a point (vertex) and the line segment opposite to the point 

   (the line f is constructed) → Click on the Intersect Tool  to 

   construct the intersection point F between line f and line 

   segment AB → Click on the Segment Tool  and combine 

   point F and point C (the line segment g is constructed and is 

   the altitude of triangle ABC). 

See Figure 41 for the outcome of 𝜏𝐴𝑙𝑡𝑖𝑡𝑢𝑑𝑒,𝐴𝑃,𝑇𝑅
𝑖  and note that the length of the 

constructed altitude g is presented in the Algebra View. 

 

 

 

 

 

 

 

 

 

An interesting aspect of GG is that it is a dynamic tool, which becomes very useful 

when working with similar triangles. The thing about constructing similar triangles in 

GG is that it is possible to make the angles and the sides of the triangles 

interdependent. The interdependence leads to the option of dragging the points of 

one of the triangles such that the shape of the other triangle will be changed 

simultaneously. Hereby, the angles of the other triangle remain identical to the angles 

of the triangle in which the point(s) have been dragged. 

For the construction of the first triangle (ST1) of two similar triangles (ST), the 

following technique can be applied: 

Figure 41 The outcome of 𝝉𝑨𝒍𝒕𝒊𝒕𝒖𝒅𝒆,𝑨𝑷,𝑻𝑹
𝒊  in 

the form of the altitude g in triangle ABC. 
The length of g can be read from the 

Algebra View to be 𝒈 = 𝟑. 𝟒𝟐. 
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𝝉𝑺𝑻𝟏,𝑨𝑷,𝑻𝑹
𝒊 :  Click on the Polygon Tool  and combine the points of the triangle (A, B 

  and C) → Use the Angle Tool  to construct all of the three interior 

  angles of triangle ABC (renamed aA, aB and aC via Object Properties). 

To construct a similar triangle (ST2) to the one just constructed the following 

technique can be performed: 

𝝉𝑺𝑻𝟐,𝑨𝑷,𝑻𝑹
𝒊 :  Click on Segment Tool  → Place the points in the Graphics View → 

  Rename the points through Object Properties to A1 and B1 and the line 

  segment to c1 → Choose Angle with Given Size Tool  → Click on B1 and 

  A1 and type “aA” into the input box (counter clockwise) → Click on A1 

  and B1 and type “aB” into the input box (clockwise) → Select Ray Tool  

  → Select two points, A1 and the auxiliary point → Click on B1 and the 

  auxiliary point (now, two intersecting Rays have been constructed) → 

  Click on the Intersect Tool   → Select the two Rays and the intersecting 

  point is constructed. This is renamed C1 via Object Properties → Click on 

  the Polygon Tool  and combine the points (A1, B1, and C1) of the 

  triangle [→ Remove all the unnecessary auxiliary lines and points.] 

The Figure 42 shows the outcome of both 𝜏𝑆𝑇1,𝐴𝑃,𝑇𝑅
𝑖  and 𝜏𝑆𝑇2,𝐴𝑃,𝑇𝑅

𝑖 . 
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Figure 42 Here, two similar triangles, triangle ABC and 𝑨𝟏𝟏𝑩𝟏𝟏𝑪𝟏𝟏. The reason for the lowered 1 is that GG 

distinguishes between points and angles of the triangle 𝑨𝟏𝟏𝑩𝟏𝟏𝑪𝟏𝟏 when the angles have been named A1, B1 and 

C1 as well as the points. 

After having performed the techniques 𝜏𝑆𝑇1,𝐴𝑃,𝑇𝑅
𝑖  and 𝜏𝑆𝑇2,𝐴𝑃,𝑇𝑅

𝑖 , it is possible to drag 

the points of the first constructed triangle, triangle ABC, via the Move Tool .  Here, 

the other triangle (𝐴11𝐵11𝐶11) will change simultaneously with triangle ABC, in the 

sense that the angles are ever congruent. For instance, when dragging the point B of 

the first triangle, the other triangle will adapt to the new settings, see Figure 43. 
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As an endnote (regarding Figure 43), by dragging in triangle 𝐴11𝐵11𝐶11 it is not 

possible to change the size of the angles since they are depending on the angle 

measure of triangle ABC (constructed first). It is however possible to make the length 

of the sides of the triangle 𝐴11𝐵11𝐶11 larger or smaller, hence a scaled version of 

itself and additionally, it is possible to rotate it. This by use of the Move Tool . 

To answer tasks of type 𝑇𝐸𝑇5
 it is possible to drag in the two triangles such that their 

angles and sides matches the numbers stated in the specific task if possible - this is 

however not straightforward. GG will then give the lengths of the unknown sides 

which can be read from the Algebra View. If it is not possible to do it this way, the 

scale factor can be determined by typing “k=a/a1” or “k=b/b1” or “k=c/c1” in the 

Input field (depending on which similar sides are known) and then calculate the 

unknown side in the CAS View (this View will be elaborated further down).  

Now, the construction of the unit circle is considered. It is almost unavoidable not to 

talk about the unit circle when dealing with Trigonometry. Therefore, it is also 

necessary to know how to construct this in GG. The unit circle has its centre in origo 

𝑂 = (0,0) and radius 1 (already mentioned in the unit circle context section 4.1.1). 

The technique used to construct the unit circle (UC) can be as follows: 

Figure 43 The gesture of dragging the 

point B in triangle ABC of Figure 42 

has been performed here. It is seen 

that the angles of the two triangles are 

congruent and the corresponding 

sides are similar. Triangle ABC is a 

scaled version of triangle 𝑨𝟏𝟏𝑩𝟏𝟏𝑪𝟏𝟏. 
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𝝉𝑼𝑪,𝑨𝑷,𝑻𝑹
𝒊 :  Type “O=(0,0)” in the Input Bar and press Enter → Click on Circle with 

  Center and Radius Tool  → Select O as the centre point and enter the 

  radius (which in the unit circle is 1) in the appearing dialog window. 

A directional point P and a directional angle aP52, can be added to the construction of 

the unit circle by the use of this technique (denoted DPDA for Directional Point and 

Directional Angle): 

𝝉𝑫𝑷𝑫𝑨,𝑨𝑷,𝑻𝑹
𝒊 :   Click on the Point on Object Tool  (which creates a point 

   fixed to the unit circle) → Select the unit circle as the object 

   to which the point is fixed to → Name the point on the unit 

   circle (the directional point) P via Object Properties → 

   Select the Ray Tool  and create a Ray through O and P →  

   Select Angle Tool  to construct the directional angle → 

   Click on the positive side of the x-axis and the ray → name 

   the angle aP via Object properties. 

The outcome of the two techniques presented just above is seen in Figure 44. 

 

 

 

 

 

Figure 44 Here, the outcomes 

of 𝝉𝑼𝑪,𝑨𝑷,𝑻𝑹
𝒊  and 𝝉𝑫𝑷𝑫𝑨,𝑨𝑷,𝑻𝑹

𝒊  are 

shown in the form of a unit 

circle respectively the 

directional point (P) and the 

directional angle (aP). 

 

                                                        

52 The directional angle emerges from Origo and has its right angle-leg on the positive part of the x-axis 

and the left angle-leg is where the leg intersects the circle through a point (the directional point). 
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The point, P, in Figure 44 can be moved along the circle via the Move Tool . 

When performing the gesture of dragging the point P, the angle aP automatically 

follows and changes its measure. 

To clarify the notion of cosine and sine in relation to GG, it is possible define 

“Px=cos(aP)” and “Py=sin(aP)” in the Input Bar and cosine and sine becomes 

respectively the x-coordinate and the y-coordinate to the point P. Then it is possible 

to see a relation between the directional angle and cosine and sine. Further it is on 

this basis possible to solve tasks like 𝑡𝑇𝑇𝑊1
 and 𝑡𝑇𝑇𝑊2

. On Figure 45, the values for 

both cosine and sine when the directional angle is 58° can be seen, namely 0.53 and 

0.85, respectively. 

 

Figure 45 Here, the values of cosine and sine with respect to the angle of 𝟓𝟖° is shown in the Algebra View as 

respectively “Px” and “Py”. Hereby it can be realised that the coordinates of P are actually (𝑷𝒙, 𝑷𝒚). 

As an endnote to the review of the Algebra Perspective, it is worth mentioning that 

there exist boxes with explanations when moving the computer mouse over a 

Toolbox. These boxes work as a help tool when making constructions in GG. In the 

Figure 46 a box is illustrated by holding the mouse over the Angle Tool. 
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Figure 46 Here, a box helping to construct an angle via the Angle Tool is shown. In the box there is written Angle - 

Select three points or two lines. 

The CAS View 

GG also offers a CAS View where for instance tasks like 𝑡𝑇𝑇𝑊1
 and 𝑡𝑇𝑇𝑊2

 can be solved 

by use of a classical CAS tool.  

When using the CAS View in connection with Trigonometry one has to make sure 

whether the result shall be given in terms of radians or degrees. If the result is wished 

to be in degrees, an addition of the degree symbol (°) is needed. This symbol can be 

made by entering the keyboard shortcut ‘Alt’ + ‘O’ (for PC) or ‘Ctrl’ + ‘O’ (for Mac OS) 

or by using the Alpha symbol in the Input Field and selecting the degree symbol. It 

should be specified that …GeoGebra does all internal calculations in radians. The 

degree symbol (°) is nothing but the constant π/180 used to convert degree into radians 

(Webpage: Numbers and Angles, 2016).  

Hence, the technique of solving cos(45°) (inspired by 𝑡𝑇𝑇𝑊1
) in the CAS View is: 

𝝉𝟏,𝑪𝑽,𝑻𝑹
𝒊 :  Enter “cos(45°)”  in the Input Field → Click on the Evaluate Tool  → 

  Click on Numeric Tool  to get a numerical approximation. 

The outcome of the above presented technique is shown in Figure 47. 

 
 
Figure 47 The outcome of 

𝝉𝟏,𝑪𝑽,𝑻𝑹
𝒊 . Cell 1 shows the result 

when clicking on the Evaluate 

Tool and cell 2 shows the result 

after clicking on the Numeric 

Tool. 

https://www.geogebra.org/manual/en/Evaluate_Tool
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It is also possible to solve equations in the CAS View. E.g. if sin(𝑥°) =
1

2
 is considered, 

the following technique can be used for finding the unknown angle: 

𝝉𝟐,𝑪𝑽,𝑻𝑹
𝒊 :   Type “sin(𝑥°)=1/2” in the Input Field (in cell 1) → Click on Solve Tool  

  → Copy the output from cell 1 to be input of cell 2 -> Click on Numerical 

  Tool . 

The outcome of this technique is shown in Figure 48. 

 

Figure 48 The outcome of 𝝉𝟐,𝑪𝑽,𝑻𝑹
𝒊  is shown here. Here, the Solve Tool has been used in cell 1 and the Numerical 

Tool has been used in cell 2. The output of cell 1 is “x = 𝟑𝟔𝟎 𝒌𝟏 + 𝟑𝟎, x = = 𝟑𝟔𝟎 𝒌𝟏 + 𝟏𝟓𝟎” due to the periodicity of 

sine. The output of cell 2 is “x = 𝟑𝟎, x = 𝟏𝟓𝟎”.  

In connection with 𝜏2,𝐶𝑉,𝑇𝑅
𝑖 , it should be mentioned that if the Solve Numerically Tool 

 is selected instead of the Solve Tool , the output will be “x = 30”. 

When applying the Law of Sine or the Law of Cosine, certain reservations must be 

taken concerning calculations in the CAS View. For example, an angle must be 

guessed when working with the Laws. This is slightly easier to explain through an 

example. The example is illustrated in Figure 49 and is based on the task of the type 

𝑇𝐸𝑇2
 from the exam exercise in Figure 14 where the Law of Cosine is needed in order 

to solve the task.  

https://www.geogebra.org/manual/en/Evaluate_Tool
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Figure 49 Equation solving when applying the Law of Cosine to solve a specific task of type 𝑻𝑬𝑻𝟐
 (from Figure 14) 

in the CAS View. More specifically, the outcome of the use of the techniques 𝝉𝟑,𝑪𝑽,𝑻𝑹
𝒊  and 𝝉𝟒,𝑪𝑽,𝑻𝑹

𝒊 . 

The NSolve command, also known as Solve Numerically Tool Attempts (numerically) 

to find a solution of the equation for the given unknown variable (Webpage: NSolve 

Command, 2016) and the command is noted only to work for continuous functions53. 

On Figure 49 the following techniques is used in cell 1 and respectively cell 2:  

𝝉𝟑,𝑪𝑽,𝑻𝑹
𝒊 :  Enter the equation “cos(𝐴°)=((20^2+26.24^2-20^2)/(2*20*26.24)),A” 

  → Click on the Solve Numerically Tool  . 

𝝉𝟒,𝑪𝑽,𝑻𝑹
𝒊 :  Enter the equation  

“cos(𝐴°)=((20^2+26.24^2- 20^2)/(2*20*26.24)),A=40” → Click on the 

Solve Numerically Tool  . 

The techniques 𝜏3,𝐶𝑉,𝑇𝑅
𝑖  and 𝜏4,𝐶𝑉,𝑇𝑅

𝑖  differ from each other by the guessed angle  

(𝐴 = 40). When adding this angle, the output only relates to the triangle context 

(where angles cannot be negative and the sum of the angles is equal to 180°) which is 

noted to be the case in the exam tasks 𝑇𝐸𝑇1
- 𝑇𝐸𝑇5

.  Noticeably, it is only possible to 

guess an angle ∈ (0°, 180°). Further, when solving equations where the Laws are 

applied and where the unknown variable is a side length of a triangle, it is not 

required that the length of the side has to be guessed.  

                                                        

53 A function f is continuous in a point 𝑎 ∈ 𝐷𝑓  (the domain of f) if ∀ε > 0 ∃ 𝛿 > 0: for 𝑥 ∈ 𝐷𝑓  and 

|𝑥 − 𝑎| < 𝛿 then |𝑓(𝑥) − 𝑓(𝑎)| < 휀 (Lindstrøm, 2006, p. 212). The functions sin(𝑥) and cos(𝑥) are well 

known to be continuous for all 𝑥 ∈ ℝ.  
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Tasks of type 𝑇𝐸𝑇5
 (as the one presented in Figure 17) can also be determined within 

the CAS View. A technique, which can be used hereto, is: 

𝝉𝟓,𝑪𝑽,𝑻𝑹
𝒊 :  Type “10/4” in the Input Field of cell 1 → Click on the Numerical Tool  

        → Type “2*2.5” (where 2.5 is the output from cell 1) in cell 2 → Click on 

  the Numerical Tool . 

The outcome of this technique can be seen in Figure 50. 

 

Figure 50 The outcome of the technique 𝝉𝟓,𝑪𝑽,𝑻𝑹
𝒊 . In cell 1, the scale factor 𝒌 =

𝑨𝑬

𝑨𝑪
 is calculated and in cell 2,  

𝑫𝑬 = 𝑩𝑪 · 𝒌 is calculated. 

GG worksheets in relation to Trigonometry 

Finally, three relevant GG worksheets in connection to Trigonometry will be 

presented in this section. The three worksheets involve different aspects of GG, some 

are dynamical some requires clicking in order to get the correct answers. The first 

worksheet to be presented is the “Triangle calculator” seen in Figure 51. This 

worksheet can be found on: http://tube.geogebra.org/m/2248515 (last visited 

20.06.2016). 

https://www.geogebra.org/manual/en/Evaluate_Tool
https://www.geogebra.org/manual/en/Evaluate_Tool
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Figure 51 Here, two sides, a and b, and the intermediate angle C are known in triangle ABC, which are to be 

entered as input in the visible boxes. The worksheet offers a yellow instruction box as well as the possibility to 

rename the angles and sides and it provides a drawing of the triangle as well. Moreover, the worksheet gives the 

information of all the algebraic manipulations. Here the Law of Cosine is used. 

This worksheet is a fully automated problem solver in the sense that it just gives the 

answers and the calculations behind them when entering the information of given 

values of side lengths and angles. The worksheet only represents the practical block 

of solving tasks related to angles and side lengths of triangles (for instance of the type 

𝑇𝐸𝑇1
, 𝑇𝐸𝑇2

 or 𝑇𝐸𝑇3
) in the sense that it both serves as, provides and performs the 

technique. Hereby, the worksheet does not necessarily require a knowledge block 

established by the user. 

Another worksheet is concerned with the proof of the Pythagorean Theorem. This 

worksheet is illustrated in the figure below (Figure 52) and can be found on the link: 

https://www.geogebra.org/m/219527 (last visited 20.06.2016). 
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Figure 52 This worksheet is a review of the Pythagorean Theorem through a Click Proof (i.e. hints for the steps of 

the proof can be called for through clicks). Here, all boxes from 1-7 are marked such that algebraic gestures 

appears as an output of the click gesture. Along with marking the boxes, the figure to the left appears which gives 

the students a visualisation of the proof. 

This worksheet provides a review of the proof. For each check mark the worksheet 

gives more and more information needed to finish the proof. The information given is 

in terms of algebraic gestures and illustrations. Even though the worksheet is 

concerned with a proof, it is primarily concerned with the practical block of 

performing the proof since it consists of click steps presenting algebraic gestures 

without explanations. However, there are technological elements in point 5. 

The next and last worksheet to be considered presents sine and cosine by using the 

unit circle (see Figure 53). The worksheet can be found by the link: 

https://tube.geogebra.org/m/49281 (last visited 21.06.2016). 
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Figure 53 This worksheet is dynamical in the sense that P can be dragged. It also contains boxes that can be 

checked, in order to see illustrations of the unit circle, the (directional) angle (V), the directional point (P), Cosine 

or Sine. To the right, some explanatory comments related to the checked boxes are presented.  

The worksheet can be used as a supplement to 𝑡𝑇𝑇𝑊1
 and 𝑡𝑇𝑇𝑊2

 in section 4.1.3 in 

relation to the construction work as well as to solving the tasks. By using this 

worksheet, the students do not have to construct the unit circle from scratch. The unit 

circle and related features are constructed by clicking on the five boxes (Unit circle, 

Angle, Directional point, Cosine and Sine) that appears in the upper left corner (see 

Figure 53). When the boxes are checked, illustrations and explanations related to the 

boxes appear. For instance, if the box of Sine has been marked, a green arrow appears 

in the illustration as well as the explanatory comment which in this case is: Sine is 

defined as the y-coordinate to the directional point (the fourth comment presented to 

the right in Figure 53). The point P can be dragged such that it is possible to see how 

the directional angle and sine and cosine with respect to this angle are related. 

Besides from the praxis of dragging the point P, the worksheet contains explanatory 

comments associated to the unit circle and its features. Hereby, the user can establish 

a knowledge block in relation to tasks like 𝑡𝑇𝑇𝑊1
 and 𝑡𝑇𝑇𝑊2

. 

As an endnote for this review of GG worksheets, the design of all of the three 

presented worksheets links algebra to figures (i.e. Geometry II - see section 4.1.1). 
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4.3.3 The CAS Tool in Relation to Power Functions (A)   

This a priori analysis is based on the Views in GG immediately found relevant for 

working with problems related to the theme of Power Functions and especially tasks 

of the types 𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

. The Perspective and Views to be considered here are: The 

Algebra Perspective, The CAS View and The Spreadsheet View. Each View offers 

specific opportunities for solving tasks which will be presented here where the 

techniques are numbered in direct relation to the types of tasks (𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

). Finally, 

four worksheets related to the theme will be explored. 

The Algebra Perspective 

Through the Algebra Perspective it is possible to solve several of the task types  

𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

 which will be elaborated here.  

First of all, tasks of type 𝑇𝐸𝑃1
 can be solved through the following technique, 

concerning the determination of the coordinates of the intersection point between 

the line 𝑥 = 𝑥0 and the graph of the given power function 𝑓: 

 𝝉𝟏,𝑨𝑷,𝑷𝑹
𝒊 :  Type the functional equation for f in the Input Bar as “f(x)=b*x^a” 

  where a and b are given values →  Press Enter → Type “x=𝑥0” 

  where 𝑥0 is a given value → Press Enter [→ Choose the Move Graphics 

  View Tool  → Drag the x- and/or y-axis until both the line 𝑥 = 𝑥0 and 

  the graph of f are visible in the Graphics View] → Choose the Intersect 

  Tool  → Click on both the graph of the function f and the line 𝑥 = 𝑥0 in 

  the Graphics View (i.e. the intersection) → Read off the second 

  coordinate of the intersection point from the Algebra View 

  representation of the point. 

The gesture of clicking on both the graph of 𝑓 and the line 𝑥 = 𝑥0 is noticeably only 

possible if the intersection between the line 𝑥 = 𝑥0 and the graph of 𝑓 is visible in the 

Graphics View, or else the gestures marked by [ ] becomes relevant to perform in 

order to achieve visibility of the intersection. See Figure 54 for an example of the 

outcome of 𝜏1,𝐴𝑃,𝑃𝑅
𝑖  - performed on the specific task of type 𝑇𝐸𝑃1

 presented in Figure 

20. 

https://www.geogebra.org/manual/en/Move_Graphics_View_Tool
https://www.geogebra.org/manual/en/Intersect_Tool
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Figure 54 The outcome of 𝝉𝟏,𝑨𝑷,𝑷𝑹
𝒊  performed on the specific task of type 𝑻𝑬𝑷𝟏

 from Figure 20. The line 𝒙 = 𝟒𝟎𝟎 

has been named g by GG and the intersection point has been named A. The coordinates of A in the Algebra View 

(marked by a green box) reveal that 𝒇(𝟒𝟎𝟎) = 𝟏𝟐𝟏. 𝟓𝟑𝟑. 

An almost similar technique (as 𝜏1,𝐴𝑃,𝑃𝑅
𝑖 ) can be applied for tasks of type 𝑇𝐸𝑃2

 - the 

only difference is that one should plot the line 𝑦 = 𝑓(𝑥0) and read off the first 

coordinate of the intersection point, since 𝑓(𝑥0) is given and 𝑥0 is to be determined: 

𝝉𝟐,𝑨𝑷,𝑷𝑹
𝒊 :  Type the functional equation for f in the Input Bar as “f(x)=b*x^a” 

  where a and b are given values → Press Enter → Type “y=𝑓(𝑥0)” 

  where 𝑓(𝑥0) is a given value → Press Enter [→ Choose the Move Graphics 

  View Tool  → Drag the x- and/or y-axis until both the line 𝑦 = 𝑓(𝑥0) 

  and the graph of the f are visible in the Graphics View] → Choose the 

  Intersect Tool  → Click on both the graph of the function f and the line 

  𝑦 = 𝑓(𝑥0) in the Graphics View (i.e. on the intersection) → Read off the 

  first coordinate of the intersection point from the Algebra View 

  representation of the point. 

https://www.geogebra.org/manual/en/Move_Graphics_View_Tool
https://www.geogebra.org/manual/en/Intersect_Tool
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In the cases of solving tasks of the types 𝑇𝐸𝑃1
 

and 𝑇𝐸𝑃2
, the option of adding a grid to the 

Graphics View through the Style Bar may 

provide help for supporting the 

determination of the intersection point 

between the line and the graph - in the sense 

that it can clarify which second coordinate the 

intersection point has, before asking for it 

through the Intersect Tool  (see Figure 55). 

Regarding tasks of the type 𝑇𝐸𝑃3
, such tasks 

are possible to solve within the Algebra Perspective as well. It is namely possible 

through an intersection point procedure where one starts out by choosing a value of x 

to which it is found easy to add or subtract the given amount of percentage describing 

the change of x. For instance, in relation to the specific task of type 𝑇𝐸𝑃3
 presented in 

Figure 20, one can choose to plot the lines 𝑥 = 10 and 𝑥 = 13 in the Graphics View 

along with the graph of the given power function, f (where the relation between the x-

values of 10 and 13 is an increase of 30 %; the given increase of x). Thereafter, one 

can mark off the two intersection points between each of the lines and the graph of 

𝑓 through the same procedure as used for marking off the intersection points in 

𝜏1,𝐴𝑃,𝑃𝑅
𝑖  and 𝜏2,𝐴𝑃,𝑃𝑅

𝑖 . The second coordinates of the two intersection points (i.e. 

𝑓(10) and 𝑓(13)) can now be read off from the algebraic representations of the 

points in the Algebra View (see Figure 56).  

Figure 55 A grid has here been added to the 

Graphics View for the example presented in 

Figure 54. 

https://www.geogebra.org/manual/en/Intersect_Tool
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Figure 56 Here, the outcome of the gestures in relation to the example of a task of type 𝑻𝑬𝑷𝟑
 from Figure 20 is 

presented. The lines 𝒙 = 𝟏𝟎 and 𝒙 = 𝟏𝟑 are (respectively) named g and h by GG and the intersection points 

between each of the lines and the graph of f are named A and B (respectively). Finally, the second coordinates of A 

and B can be read from the Algebra View (namely as 0.817 and 1.166 respectively - see the green box). 

After having performed the gestures presented through the example above, the 

percentage increase between the function values can be calculated by use of a 

calculator - for instance the CAS View of GG (to be introduced further down). Hence, 

the following technique for solving tasks of type 𝑇𝐸𝑃3
 can be applied in the Algebra 

Perspective: 

𝝉𝟑,𝑨𝑷,𝑷𝑹
𝒊 : Type the functional equation of 𝑓 in the Input Bar as “f(x)=b*x^a” 

  where a and b are given values → Press Enter → Type “x=𝑥1” where 𝑥1 is 

  a specific value to which it is easy to add or subtract the given amount of 

  percent by which x should change → Press Enter → Type “x=𝑥2” where 𝑥2 

  is the specific value gotten when adding or subtracting the given amount 

  of percent by which x should change → Press Enter [→ Choose Move 

  Graphics View Tool  → Drag the x- and/or y-axis until both the line 

  𝑥 = 𝑥1, the line 𝑥 = 𝑥2 and the graph of f are visible in the Graphics 

  View] → Choose Intersect Tool  → Click on both the 

  graph of the function f and the line 𝑥 = 𝑥1 in the Graphics View (i.e. on 

  the intersection)→ Choose Intersect Tool  → Click on both the graph of 

https://www.geogebra.org/manual/en/Move_Graphics_View_Tool
https://www.geogebra.org/manual/en/Intersect_Tool
https://www.geogebra.org/manual/en/Intersect_Tool
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  the function f and the line 𝑥 = 𝑥2 in the Graphics View (i.e. on the 

  intersection) → Read off the second coordinates of the two intersection 

  points from the Algebra View representation of the points (𝑓(𝑥1) and 

  𝑓(𝑥2)) → Calculate ((𝑓(𝑥2) / 𝑓(𝑥1)) -1)*100. 

The part of 𝜏3,𝐴𝑃,𝑃𝑅
𝑖  marked by [ ] is only necessary when the two lines and the graph 

of 𝑓 are not all visible in the Graphics View. To be noted, such a procedure can also be 

used for solving the opposite task of 𝑇𝐸𝑃3
, namely that of determining the percentage 

change of the value x, given a percentage change of 𝑓(𝑥). One only plots the lines  

𝑦 = 𝑦1 and 𝑦 = 𝑦2 where the values 𝑦1 and 𝑦2 are chosen such that 𝑦2 is the value of 

𝑦1 changed by the given amount of percentage. 

For tasks of the type 𝑇𝐸𝑃4
, it is possible to solve such tasks via the Algebra View of GG, 

following the analytic technique sketched in section 4.2.2: 

𝝉𝟒,𝑨𝑷,𝑷𝑹
𝒊 : Type “a=log(𝑦2/𝑦1)/log(𝑥2/𝑥1)” in the Input Bar where 𝑦2, 𝑦1, 𝑥2 and 𝑥1 

  are given values → Press Enter → Type “b=𝑦1/(𝑥1^a)” in the Input Bar 

  where 𝑦1 and 𝑥1 are given values, and a is remembered by GG to be the 

  number just calculated through the Input Bar → Press Enter → Read off 

  the values of a and b from the Algebra View and write down  

  the functional equation for the power function; 𝑓(𝑥)(or 𝑦) = 𝑏 · 𝑥𝑎 if 

  requested. 

Here, one may further want to plot the given points “(𝑥1, 𝑦1)” and “(𝑥2, 𝑦2)" along 

with the graph of the power function f (or y) in order to verify the calculated values of 

a and b. This can be done through the Input Bar by typing each point as marked by 

the quotation marks just above and further by typing “f(x)=b*x^a” (or ”y=b*x^a”) 

(where each gesture is followed by Enter) where GG noticeably has remembered the 

calculated values of a and b. Figure 57 presents an example of the outcome of 𝜏4,𝐴𝑃,𝑃𝑅
𝑖  

supported by the gestures just presented, when solving the specific task of type 𝑇𝐸𝑃4
 

presented in Figure 21. 
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Figure 57 The outcome of 

𝝉𝟒,𝑨𝑷,𝑷𝑹
𝒊  performed on the 

specific task of type 𝑻𝑬𝑷𝟒
 

from Figure 21 are the values 

of a and b in the Algebra 

View, namely 𝒂 = 𝟏. 𝟐𝟐𝟐 and 

𝒃 = 𝟏. 𝟐𝟖𝟔. Further the 

graph of “f(x)=b*x^a” along 

with the two given points 

(named A and B) have been 

plotted in order to check that 

the points lie on the graph. 

Even though the Spreadsheet View (see subsection on this View further below) of GG 

may seem more immediate to use when solving tasks of the type 𝑇𝐸𝑃5
, it is possible to 

solve such tasks in the Algebra Perspective as well. The following technique is namely 

possible to apply: 

𝝉𝟓,𝑨𝑷,𝑷𝑹
𝒊 :  Type each of the given points from the set of data; “(𝑥𝑖 ,𝑦𝑖)”, each 

  followed by Enter, in the Input Bar (each point is then given a name in 

  the form of a capital letter by GG) → Type a list of the points in the Input 

  Bar: “{A,B,C,...}” when the points are named A, B, C,... → Press Enter → 

  Type “FitPow[ list1 ]” in the Input Bar, if the list of points is named list154 

  → Press Enter → Read off the functional equation of the power function 

  which has appeared both in the Graphics and the Algebra View. 

Figure 58 shows an example of the outcome of the technique 𝜏5,𝐴𝑃,𝑃𝑅
𝑖 , performed on 

the example of a task of type 𝑇𝐸𝑃5
 from Figure 22. 

 

                                                        

54  This is what GG will call it if it is the first list made in the document - one can read off the name of 

the list in the Algebra View. 
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Figure 58 The outcome of 𝝉𝟓,𝑨𝑷,𝑷𝑹
𝒊  

performed on the example of Figure 22 

are the six points A-F (named by GG), 

both represented in the Algebra and in 

the Graphics View, the list of the points 

(list 1) in the Algebra View and finally, 

the equation of the power function 

𝒇(𝒙) = 𝟎. 𝟏𝟔𝟐𝒙𝟐.𝟗𝟗𝟏 fitted for the data 

to be read from the Algebra View. 

Now, before considering the options in the CAS View of GG, an important option in the 

Algebra Perspective in relation to the theme should be presented. Namely, the option 

of constructing a less specific power function (with domain 𝑥 > 0), through the 

following technique: 

𝝉𝑺𝒍𝒊𝒅𝒆𝒓𝒔 𝒂𝒃,𝑨𝑷,𝑷𝑹
𝒊 :  Type “f(x)=b*x^a,x>0” in  the Input Bar → Press Enter → 

   Click “Create Sliders” in the “Create Slider(s)” view popping 

   up on the screen.  

Through 𝜏𝑆𝑙𝑖𝑑𝑒𝑟𝑠 𝑎𝑏,𝐴𝑃,𝑃𝑅
𝑖 , sliders for a 

and b appear in the Graphics View 

with both values equal to 1 at first, 

along with the graph for the 

function “f(x)=1 x , (x>0)” - see 

Figure 59. Moreover, the functional 

equation appears as “Function” and 

the values for both a and b as 

“Number” in the Algebra View.  

To begin with, both the slider for b 

and that for a span over the interval 

of [−5,5] with jumps of 0.05. The 

specifications for both interval and 

Figure 59 The outcome of 𝝉𝑺𝒍𝒊𝒅𝒆𝒓𝒔 𝒂𝒃,𝑨𝑷,𝑷𝑹
𝒊  in the form of the 

two sliders for values of a and b and the equation and graph of 

the power function 𝒇(𝒙) = 𝒃 · 𝒙𝒂, 𝒙 > 𝟎 in respectively the 

Algebra and the Graphics View. 
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increment of the sliders can be changed (especially relevant for the b values when 

𝑏 > 0 is assumed for the function f to be a power function - see section 4.2.1). This 

can be done by double clicking on the slider whereby a view with “Preferences” pops 

up and here the “Min.” and “Max” values can be entered for the slider (under the 

“Slider” tab). As for the function of the sliders, the mouse can be used to click on one 

of them in the Graphics View and drag the point (being either a or b in this case) to 

the right or to the left (in order to change its value). Note that, when changing at least 

one of the a or b values on the sliders, it leads to a change in both the functional 

equation of f in the Algebra View and in the look of the graph in the Graphics View. 

Thereby, it is possible to get to see several different types of graphs of a power 

function 𝑓(𝑥) = 𝑏 · 𝑥𝑎  (, 𝑥 > 0) dynamically. 

The CAS View  

Through the CAS View, it is possible to execute both symbolic and numeric 

calculations in relation to the Power Functions theme where input and output are 

made within the same View as opposed to the Input Bar in relation to the Algebra 

View. For instance, tasks of the type 𝑇𝐸𝑃1
 can be solved through the following 

technique in this View: 

𝝉𝟏.𝟏,𝑪𝑽,𝑷𝑹
𝒊 :  Type the right side of the functional equation of f with the value 𝑥0 

  inserted, as “b*𝑥0^a” where a and b are given values, in an Input Field → 

  Choose the Evaluate Tool  → Choose the Numeric Tool  to get the 

  numerical approximation → Read off the result from the last output. 

Figure 60 presents an example of the outcome of 𝜏1.1,𝐶𝑉,𝑃𝑅
𝑖 , performed on the specific 

task of type 𝑇𝐸𝑃1
in Figure 20. 

 

 

Figure 60 The outcome of 𝝉𝟏.𝟏,𝑪𝑽,𝑷𝑹
𝒊  performed 

on the task of type 𝑻𝑬𝑷𝟏
in Figure 20. In cell 1, 

the result when using the Evaluate Tool is 

presented and in cell 2, the Numeric Tool has 

been used. 

https://www.geogebra.org/manual/en/Evaluate_Tool
https://www.geogebra.org/manual/en/Numeric_Tool
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There is however also the possibility of defining the power function f in the CAS View 

(or in the Algebra View - see the previous section) and then calculate 𝑓(𝑥0) in the CAS 

View in order to solve 𝑇𝐸𝑃1
: 

𝝉𝟏.𝟐,𝑪𝑽,𝑷𝑹
𝒊 :  Type “f(x):=b*x^a”, where a and b are given values, in an Input Field → 

  Press Enter → Type “f(𝑥0)”, where 𝑥0 is a given value, in the next Input 

  Field → Choose the Evaluate Tool  → Choose the Numeric Tool  

  to get the numerical approximation → Read off the result from the last 

  output. 

See Figure 61 for the outcome of 𝜏1.2,𝐶𝑉,𝑃𝑅
𝑖  performed on the task of type 𝑇𝐸𝑃1

in Figure 

20. 

 

Figure 61 The outcome of 𝝉𝟏.𝟐,𝑪𝑽,𝑷𝑹
𝒊  performed on the task of type 𝑻𝑬𝑷𝟏

in Figure 20. Noticeably, the power 

function f(x) can be represented in both the CAS, the Algebra and the Graphics View when having defined it by “:=” 

in the CAS View (through the (blue) bullet). 

As for tasks of type 𝑇𝐸𝑃2
, these are possible to solve as well, through the following 

technique in the CAS View: 

𝝉𝟐.𝟏,𝑪𝑽,𝑷𝑹
𝒊 :   Type ”f(𝑥0) = b*x^a”, where 𝑓(𝑥0), b and a are given values →  

  Choose the Solve Numerically Tool  to get a numerical 

  approximation → Read off the result from the last output. 

It should here be noted that the Solve Numerically Tool (performing the NSolve 

command) can only be used on continuous functions as well as piecewise-defined 

https://www.geogebra.org/manual/en/Evaluate_Tool
https://www.geogebra.org/manual/en/Numeric_Tool
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functions (Webpage: NSolve Command, 2016; Webpage: Solve Command, 2016). 

Figure 62 presents the outcome of 𝜏2.1,𝐶𝑉,𝑃𝑅
𝑖  performed on the task of type 𝑇𝐸𝑃2

 from 

Figure 20. 

 

 

 

Figure 62 The outcome of 𝝉𝟐.𝟏,𝑪𝑽,𝑷𝑹
𝒊  

performed on the task of type 𝑻𝑬𝑷𝟐
 

from Figure 20 is presented in cell 

1 of the CAS View. 

Noticeably, GG is not necessarily able to solve with respect to x when one chooses the 

Solve Tool  instead of the Solve Numerically Tool, which is seen in Figure 63 where 

this has been practiced on the specific example of a task of type 𝑇𝐸𝑃2
 task from Figure 

20. This can be explained by the fact that the function in the equation is only 

piecewise-defined (with domain 𝑥 > 0) whereby the Solve command cannot be 

applied and NSolve is needed as command in order to get a result (Webpage: Solve 

Command, 2016). 

 

Figure 63 The output of using the Solve Tool for solving the task of type 𝑻𝑬𝑷𝟐
 task from Figure 20 in the CAS View 

is seen to be the message: ”Calculation took too long and was aborted”. 

Like for 𝑇𝐸𝑃1
 tasks, there is also the possibility of defining the power function f in the 

CAS View (or in the Algebra View - see the previous section) and then solve  

𝑓(𝑥) = 𝑓(𝑥0) (numerically) in the CAS View for 𝑇𝐸𝑃2
 tasks: 

 

 

 

https://www.geogebra.org/manual/en/Solve_Tool
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𝝉𝟐.𝟐,𝑪𝑽,𝑷𝑹
𝒊 :  Type “f(x):=b*x^a”, where a and b are given values, in an Input Field → 

  Press Enter → Type “f(x)=f(𝑥0)”, where 𝑓(𝑥0) is a given value, in the 

  next Input Field → Choose the Solve Numerically Tool  → Read off the 

  result from the last output. 

Here, the same applies for the use of the Solve Tool  as for the technique 𝜏2.1,𝐶𝑉,𝑃𝑅
𝑖 . 

Now, for tasks of the type 𝑇𝐸𝑃3
, the following technique is applicable in the CAS View, 

with references to the sketched analytic technique in section 4.2.2: 

𝝉𝟑,𝑪𝑽,𝑷𝑹
𝒊 :  Type “(1+(𝑟 · 100)/100)^a”, where (𝑟 · 100) and a are given values, in an 

  Input Field → Choose the Numeric Tool   → Click on the output (copies 

  it to the next Input Field) → Type “-1” next to the input (/the copied 

  output) → Choose the Numeric Tool  → Click on the decimal output 

  (copies it to the next Input Field) → Type “*100” next to the input (/the 

  copied output) → Choose the Numeric Tool  → Read off the result 

  from the last output. 

Since it is a specific number describing the percentage change of 𝑓(𝑥), given a 

percentage change of 𝑥 (namely (𝑟 · 100)) which is to be determined in 𝑇𝐸𝑃3
 tasks, the 

Numeric Tool is used in 𝜏3,𝐶𝑉,𝑃𝑅
𝑖  instead of the Evaluate Tool  since the Evaluate 

Tool leads to the exact evaluation as an output instead of a decimal number.  

See Figure 64 for an example of the outcome of 𝜏3,𝐶𝑉,𝑃𝑅
𝑖  performed on the specific 

example of a task of type 𝑇𝐸𝑃3
 in Figure 20. 

 

 

 

 

 

Figure 64 The outcome of 

𝝉𝟑,𝑪𝑽,𝑷𝑹
𝒊  performed on the task 

of type 𝑻𝑬𝑷𝟑
 in Figure 20. The 

Numeric Tool is used in all of 

the three cells. 

https://www.geogebra.org/manual/en/Solve_Tool
https://www.geogebra.org/manual/en/Numeric_Tool
https://www.geogebra.org/manual/en/Numeric_Tool
https://www.geogebra.org/manual/en/Numeric_Tool
https://www.geogebra.org/manual/en/Evaluate_Tool
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Regarding tasks of type 𝑇𝐸𝑃4
, they can be solved through the following technique in 

the CAS View of GG: 

𝝉𝟒,𝑪𝑽,𝑷𝑹
𝒊 :  Type “a:=log(𝑦2/𝑦1)/log(𝑥2/𝑥1)”, where 𝑦2, 𝑦1, 𝑥2 and 𝑥1 are given 

  values, in the Input Field → Choose the Numeric Tool  → Type 

  “b:=𝑦1/(𝑥1^a)”, where 𝑦1 and 𝑥1 are given values, and a is remembered 

  by GG to be the number just calculated through the Input Field above, in 

  the next Input Field → Choose the Numeric Tool  → Read off the value 

  of a and b from the outputs and write down the functional equation for 

  the power function; 𝑓(𝑥)/𝑦 = 𝑏 · 𝑥𝑎  if requested. 

Noticeably the typing “b:=” is not necessary for the technique 𝜏4,𝐶𝑉,𝑃𝑅
𝑖  to work as a 

technique but it provides an overview when reading off the values of a (also defined 

by “a:=”) and b in the outputs of the CAS View. Further, it makes it possible henceforth 

to write b instead of the specific number evaluated in GG, where it will be 

remembered to be of the evaluated value. Figure 65 presents an example of the 

outcome of 𝜏4,𝐶𝑉,𝑃𝑅
𝑖  performed on the task of type 𝑇𝐸𝑃4

 presented in Figure 21. 

 

 

 

 

 

 

 

 

Now, regarding tasks of the type 𝑇𝐸𝑃6
, such tasks can be solved through the following 

technique (with references to the analytic techniques sketched in section 4.2.2): 

𝝉𝟔,𝑪𝑽,𝑷𝑹
𝒊 :  Type “k:=x*y”, where x and y are the given set of values, in an Input Field 

  → [Choose the Evaluate Tool ] / [Choose the Numeric Tool ] → 

Figure 65 The outcome of 𝝉𝟒,𝑪𝑽,𝑷𝑹
𝒊  performed on the task of type 𝑻𝑬𝑷𝟒

 in Figure 21 where the 

Numeric Tool has been used in both cell 1 and cell 2. If requested, the functional equation can 

be written as 𝒇(𝒙)/𝒚 = 𝟏. 𝟐𝟗 · 𝒙𝟏.𝟐𝟐. 

https://www.geogebra.org/manual/en/Numeric_Tool
https://www.geogebra.org/manual/en/Numeric_Tool
https://www.geogebra.org/manual/en/Evaluate_Tool
https://www.geogebra.org/manual/en/Numeric_Tool
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  Type “k/𝑥0” in the next Input Field where 𝑥0 is the given value for x and k 

  is remembered by GG to be the number just calculated through the Input 

  Field above → [Choose the Evaluate Tool ] / [Choose the Numeric Tool 

  ] → Read off the result from the last output. 

Only one of the parts in [ ] is here to be chosen, depending on what type of output is 

wanted (either an exact evaluation or a numerical approximation). In Figure 66 the 

outcome of 𝜏6,𝐶𝑉,𝑃𝑅
𝑖  is presented in relation to the task of type 𝑇𝐸𝑃6

 in Figure 23. 

 

Figure 66 The outcome 

of 𝝉𝟔,𝑪𝑽,𝑷𝑹
𝒊  performed on 

the task of type 𝑻𝑬𝑷𝟔
 from 

Figure 23. The constant of 

proportionality (k) is 

defined and calculated in 

cell 1 and GG remembers 

the value of k in cell 2 

when calculating 𝒚𝟎.  

As an endnote for this review of the CAS View, it does not appear ideal to solve tasks 

of the type 𝑇𝐸𝑃5
 within this View. The Spreadsheet View is however especially ideal 

for this type of task which will be elaborated in the following. 

The Spreadsheet View 

The Spreadsheet View is very suitable for solving tasks of power regression or 

modelling (i.e. of the type 𝑇𝐸𝑃5
). Without going further into details with the content of 

the Spreadsheet Toolbar55, two possible techniques will here be presented for solving 

tasks of type 𝑇𝐸𝑃5
 - one in which the Spreadsheet View interacts with the Algebra and 

the Graphics View (𝜏5.1,𝑆𝑉,𝑃𝑅
𝑖 ) and one solely made within the Spreadsheet View 

(𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖 ): 

 

                                                        

55 An elaboration of the tools of the Spreadsheet Toolbar can be found on the link: 

https://www.geogebra.org/manual/en/Spreadsheet_Tools (last visited 15.07.2016). 

https://www.geogebra.org/manual/en/Evaluate_Tool
https://www.geogebra.org/manual/en/Numeric_Tool
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𝝉𝟓.𝟏,𝑺𝑽,𝑷𝑹
𝒊 :  Type the given values for the independent variable in a column (A) of 

  the spreadsheet → Type the given values for the dependent variable 

  in a column (B) just to the right of column A of the spreadsheet such 

  that the related values of the two variables are presented directly next to 

  each other → Mark the two columns where they are filled out (using 

  either mouse or keyboard) → Right click on the marked area → 

  Choose “Create” and click on ”List of points” → Type “FitPow[ list1 ]” in 

  the Input Bar of the Algebra Perspective, if the list of points is named 

  list156 → Press Enter → Read off the functional equation of the power 

  function which has appeared both in the Graphics and the Algebra View. 

Figure 67 presents the outcome of the technique 𝜏5.1,𝑆𝑉,𝑃𝑅
𝑖  performed on the example 

of a task of type 𝑇𝐸𝑃5
 from Figure 22. 

                                                        

56 “list1” is what GG will call the list if it is the first undefined list made in the document. One can read 

off the name of the list in the Algebra View. 
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Figure 67 The outcome of 𝝉𝟓.𝟏,𝑺𝑽,𝑷𝑹
𝒊  performed on the task of type 𝑻𝑬𝑷𝟓

 in Figure 22. The functional equation can 

be read from the Algebra View to be 𝒇(𝒙) = 𝟎. 𝟏𝟔𝒙𝟐.𝟗𝟗. Furthermore, both f and the list of points are noted to be 

represented in both the Algebra and the Graphics View. 

𝝉𝟓.𝟐,𝑺𝑽,𝑷𝑹
𝒊 :  Type the given values for the independent variable in a column (A) of 

  the spreadsheet → Type the given values for the dependent variable 

  in a column (B) just to the right of column A of the spreadsheet such 

  that the related values of the two variables are presented directly next to 

  each other → Mark the two columns where they are filled out (using 

  either mouse or keyboard) → Choose the “Two Variable Regression 

   Analysis Tool”  in the Data Analysis Tools menu of the 

  Spreadsheet View Toolbar → Click “Analyze” in the appearing “Data 

  Analysis” view → Click on the bar under “Regression Model” and choose 

  “Power” in the pop down menu just appeared → Read off the functional 

  equation of the power function which has appeared under the plot of the 

  points and the fitted graph in the “Data Analysis” view. 

https://www.geogebra.org/manual/en/Two_Variable_Regression_Analysis_Tool
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An example of the outcome of 𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖  is presented in Figure 68 where the technique 

is performed on the task of type 𝑇𝐸𝑃5
 in Figure 22. 

Some further notes to be made, on options in relation to the “Data Analysis” view, are 

the following (related to Figure 68):  

- Evaluating the y-value, given an x-value (i.e. solving tasks of type 𝑇𝐸𝑃1
) by typing a 

given x-value in the bar in front of “Symbolic Evaluation: x=” followed by clicking 

Enter - this technique will henceforth be denoted 𝝉𝟏,𝑺𝑽,𝑷𝑹
𝒊 57, and 

- Copying the output of the “Data Analysis” view to the Graphics View by clicking on 

the icon marked by a green box in Figure 68 whereby the outcome of 𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖  can be 

related to the Algebra and the Graphics View - similar to the outcome of 𝜏5.1,𝑆𝑉,𝑃𝑅
𝑖 .  

Furthermore, it is possible to get to see the correlation coefficient (𝑟2) for assessing 

the performed regression through clicking on the icon marked by the orange box in 

Figure 68. 

GG worksheets in relation to Power Functions 

Some examples of dynamic worksheets made in GG which could be relevant for the 

theme of Power Functions and its introduction for the high school students, will here 

                                                        

57 This technique is noticeably only experienced to be possible to perform after having performed 

𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖 . 

Figure 68 The outcome of 𝝉𝟓.𝟐,𝑺𝑽,𝑷𝑹
𝒊  

performed on the task of type 𝑻𝑬𝑷𝟓
 from 

Figure 22. The functional equation can be read 

to be 𝒚 = 𝟎. 𝟏𝟔𝒙𝟐.𝟗𝟗 underneath the plot in 

red text. The green box marks where to click 

in order to “Copy to Graphics View” whereby 

the functional equation and the data points 

are both represented in the Graphics and in 

the Algebra View when closing the “Data 

Analysis” view. Clicking on the icon marked by 

the orange box leads to a presentation of some 

statistics related to the performed regression - 

especially the 𝒓𝟐 value can be accessed here. 
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be presented briefly. These worksheets have all, where nothing else is stated, been 

found through searching for “potensfunktion” on http://tube.geogebra.org/ (last 

visited 15.07.2016). 

The first example (found on https://www.geogebra.org/m/2719557 (last visited 

15.07.2016)) concerns the impact of the value of the exponent a of a power function 

𝑓(𝑥) = 𝑏 · 𝑥𝑎  on the look of the 

graph of a power function - see 

Figure 69. Here, the (multiple 

choice) task is to choose the right 

answer for the domain of a in the 

drop down menu appearing when 

clicking on the bar in which a 

statement for a’s domain is 

presented. Thereafter it is possible 

to check the chosen answer by 

clicking on the bar “Check mit 

svar”. Finally, it is possible to ask 

for a new graph by clicking on the 

bar “Ny graf”. Noticeably, this 

worksheet does not ask for nor 

does it give any explanations for 

the relation between the domain of a and the look of the graph of 𝑓. It is however 

noted that, in order to click on the right answer for the domain of a, the user has to 

have some knowledge of the relation between this domain and the look of the graph. 

The next example (found on 

https://www.geogebra.org/material/simple/id/2837783 (last visited 15.07.2016)) 

is that of a worksheet presenting a click proof of 𝑇ℎ𝑚𝑎𝑏 (see section 4.2.3) presented 

in Figure 70 where click refers to the possibility of clicking your way through helping 

hints and right answers for the steps of the proof. There are eight steps concerning 

the techniques required for performing the proof. These steps are presented in a 

summary underneath the theorem in the left column of two, whereas help to each 

Figure 69 The worksheet named Power function - a’s impact 

on the look of the graph (translated from Danish). The drop 

down menu presenting possible domains of 𝑎 is presented 

and the right answer has been chosen - in this case 𝑎 < 0 - 

whereby clicking the bar called “Check mit svar” makes it turn 

green (otherwise it will turn red). 
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step of the proof can be obtained through marking off boxes for either hints or right 

answers in the right column. As an example of: A step → A hint for this step →  A right 

answer for the step, the first set of these is formulated as follows (translated from 

Danish):  

1. The correlated values of x and y from the points P and Q are inserted into the 

equation 𝑦 = 𝑏 · 𝑥𝑎  → In this way, you get two equations → 𝑦2 = 𝑏 · 𝑥2
𝑎  and 𝑦1 = 𝑏 · 𝑥1

𝑎 . 

This worksheet sets the stage for the user to get to learn the analytic techniques for 

carrying out the proof of 𝑇ℎ𝑚𝑎𝑏. Explanations are however not presented nor 

requested from the worksheet. Noticeably, there lies a giant pitfall in the case where 

the user of the worksheet does not think for him-/herself when reading each of the 

given steps in the summary of the proof and just go clicking for both hint and upshot 

with a certain amount of impatience because of the availability of these answers. This 

pitfall relates to the lack of an establishment of a knowledge block when solving the 

task. 

 

Figure 70 GG worksheet concerning the proof of 𝑻𝒉𝒎𝒂𝒃. The red sentences of the right column are hints for the 

steps of the proof (elicited by marking off the “Vink” boxes) whereas the green sentences are right answers for the 

steps of the proof (elicited by marking off the “Facit” boxes).   
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Another example of a worksheet is the one presented in Figure 71 with the headline 

What is power growth (translated from Danish). This worksheet can be found through 

searching for “potensvækst” on (Webpage: GG-worksheets, 2016)58. It especially 

concerns the (%/%) property (see section 4.2.3) in the way that it presents four 

exercises related to dragging sliders representing both the value of a, the value of b 

and the percentage change of x of the power function of the form 𝑦 = 𝑏𝑥𝑎 . 

 

Figure 71 Example of worksheet on power growth where both the a and the b value of the power function  

𝒚 = 𝒃𝒙𝒂 can be changed via sliders. Especially the percentage change (of x, though not stated) can be changed via 

a slider. In a coordinate system, the power function is represented as a graph and it is indicated two places on the 

graph that when the x-value increases by a percent equal to that of the slider (just presented) then y decreases (in 

this case) by a certain percent. 

The four exercises of this worksheet can be translated as follows (from Danish): 

1. Why does one in a popular phrase call power growth “percent-percent” growth? 

2. Set the sliders such that x increases by 30% and y increases by approx. 20 % 

                                                        

58 Direct link: https://tube.geogebra.org/m/143911 (last visited 15.07.2016). 
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3. Set the sliders such that x increases by 30% and y decreases by approx. 20 % 

4. What determines whether the y-value decreases or increases? 

The exercises 1. and 4. calls for some explanation, based on the information given in 

the worksheet and dragging the sliders whereas the exercises 2. and 3. are more 

technique-oriented since they involve dragging the sliders in order to achieve a 

specific (%/%) relation between the variables. 

The worksheet presented in Figure 72 presents the final example of a worksheet in 

this review. It is named Direct and inverse proportional relations (translated from 

Danish) and has been found through searching for “Ligefrem” on (Webpage: GG-

worksheets, 2016)59. The worksheet concerns (direct or inverse) proportionality and 

presents the task of filling out the table of data on the related variables x and y (with 

significant similarities to the task type 𝑇𝐸𝑃6
 and the type similar to this, only 

concerning direct instead of inverse proportionality). The user can from the text 

underneath the table read whether the variables are inverse (“omvendt”) or direct 

(“ligefrem”) proportional, which is noted to be a relation of the form y·x=k or y=k·x in 

the text. The user is then required to know how to determine the constant of 

proportionality, k, and use it for determining the lacking values of the table. This 

intention of the worksheet is indicated by the ordering of the boxes possible to mark 

off in order to get answers for, first of all, the constant of proportionality and 

thereafter the filled out table. Further the last box from above offers the possibility of 

seeing the graphical representation of the proportional relation between the two 

variables, indicating a suggestion for the user to contemplate the look of the graph. 

This worksheet does hereby not present any techniques for calculating either k or the 

x- and y-values lacking in the table. It does however guide the steps to be taken for 

solving the given task, through the ordering of the boxes possible to mark off for right 

answers - especially the first two since the outcome of marking off the third box 

(being the graph) is not crucial for solving the task. 

                                                        

59 Direct link: https://tube.geogebra.org/m/1338399 (last visited 15.07.2016). 
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Figure 72 An example of a worksheet on direct and inverse proportionality offering the possibilities of seeing the 

right answer for the constant of proportionality, the right answer for the filled out table and finally, the graph of 

the relation between the variables through marking off small boxes. These boxes have all been marked off here. 

When having completed one task, one can click on “Ny funktion” (the green bar) and a new unfilled table of related 

x and y values appears. 
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5.0 Introduction to the Observation Study 

Two different Danish high school teachers in mathematics, who taught in the two 

themes at the same high school, were involved in the observation study. The 

observations were performed in the period from Marts 30th to April 29th 2016. More 

specifically, the one of the teachers (TT) taught Trigonometry on A-level at first grade 

of high school and the other teacher (TP) taught Power Functions on B-level also at 

first grade. 10 modules were observed in the Trigonometry course and eight modules 

in the Power Functions course where each module was of 90 minutes’ duration. Both 

of the teachers used the computer program GG as a CAS tool. GG is noted to be new as 

a CAS tool to both the teachers and the students since GG has just been implemented 

on the specific high school this school year. In addition, it should be noted that it was 

not specified which type of calculator the students must use when doing algebraically 

represented mathematical problems (the classical understanding of CAS). Noticeably, 

it is optional in what way the teacher chooses to implement the CAS tool as long as it 

is consistent with the requirements of the curriculum (see the sections 4.1.2 and 

4.2.2). The observations have been performed on students using Mac computers 

(called the “participating students” (PSs); see section 6.0 for an elaboration hereof). 

In prolongation of this it should be noted that TT is a Mac user whereas TP uses a PC. 

Throughout the thesis, anonymity of both the teachers and the students is 

guaranteed, with respect to not letting them feel judged in any way (see Acronyms p. 

xi).   

In accordance with the RQs presented in section 3.0, a method for collecting the 

empirical data has been developed and will be clarified in the following section. 
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6.0 Methodology 

In this section, the methodology, for the observations on the high school lessons of 

the two courses of Trigonometry and Power Functions as well as for the collected 

empirical data in order to answer RQ1-RQ3, is outlined.  

The empirical data can be listed as follows: 

(1) Tasks proposed by the teacher in relation to GG 

(2) Screen recordings 

(3) Field notes 

(4) Photographs  

(5) Take-home group assignments 

For the analyses of the two observed courses (see section 7.1 and 7.2), this data will 

be used to an extent allowing an overview, for what happened in the courses of the 

themes in relation to the RQs, to be established.  

The data contributing to answering RQ1 constitutes relevant parts from both data (1), 

data (2), data (3) and data (5). Regarding RQ2, relevant parts, also from data (2) and 

data (3), as well as from data (4) and data (5) are contributing. 

The tasks (T) proposed by the teacher in relation to GG (data (1)) has been collected 

through mail correspondences with each teacher. This data offers an insight into the 

praxeologies, expected for the students to establish, by the teacher. Selected parts of 

this data will be analysed using the terminology of MOs (see section 2.2.2) in the 

sections 7.1 and 7.2. 

Data (2) includes corresponding audio recordings from the computers of some of the 

students - the PSs - when they do work involving GG. Noticeably, the selection of PSs 

has differed from module to module in order to ensure observations of different 

approaches to GG, depending on the academic and technical level of the PSs. 

The recordings (screen/audio) has provided access to observe the instrumented 

techniques (𝜏𝑖) (both instructed and spontaneously developed) used by the PSs on 

the screen. Further the recordings have provided access to the oral formulations and 

explanations (i.e. the knowledge block of the MO if any) for the specific mathematical 
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tasks the PSs seek to solve. This, with reservations to the lack of access to the typing 

on the keyboard and thereby any potential shortcuts (also noted in section 4.3). 

Noticeably, notes made by the PSs (i.e. potential written considerations) on the 

computer (for instance in Word) in addition to their work in GG is also captured on 

the screen recordings. The recordings require an installed program on the computer. 

In general, Mac computers have such a program installed for certain, namely 

QuickTime Player60, whereas PCs do not. It may therefore take a separate action for 

the students with PCs to find and download such a program and it was discovered 

that it was not necessarily possible to make a full screen recording with unlimited 

recording time (and not only a couple of minutes) in the programs targeted at PCs. 

Therefore, the group of PSs was narrowed down to be Mac users. 

This data has been collected via USB plugs since it was found favourable compared to 

uploads or mail-correspondences via the Internet, because of the time-consuming 

aspect connected to the speed of uploads. Furthermore, the aspect of ensuring 

anonymity of both the teachers and the students is not guaranteed when using the 

Internet, thus the choice of USB plugs. This choice was made with reservations to the 

fact that it also consumes some time (up to two minutes for a 10-minute screen 

recording file) to save the files on a USB61, but not as much as when uploading to the 

Internet. With this in mind, the PSs were asked to save their recordings every 10th 

minute and start a new recording immediately after, when working in GG. In order to 

keep track on the succession of the video files, the PSs were further asked to number 

the files “1”, “2”, “3”,... and so on, depending on the amount of files. The compromise of 

around 10 minutes’ duration for one screen recording has been adopted such that the 

mathematical work of the PSs was not interrupted to such an extent where the PSs 

could not focus on solving the mathematical tasks since they would have to wait for 

the files to be saved. In addition, unnecessarily disturbance of the students, by more 

frequently instructing them to save the files, was sought avoided. 

                                                        

60 For further information and download, follow this link: http://www.apple.com/quicktime/what-is/ 

(last visited 29.07.2016). 

61 Before initiating the observations, the write speed of each of the involved USB plugs was tested, in 

order to be certain that it would not take longer than two minutes to save 10-minute video files. 
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When the audio recordings are transcribed as well as when referring to specific 

situations, the following abbreviations will be used, for the sake of anonymity of both 

teacher and students: 

TT: Trigonometry teacher  

TP: Power Functions teacher 

PS1, PS2,…: Participating students, i.e. Mac users with a USB plug 

AS1, AS2,…: Other students participating in dialogue 

The transcribed parts of the audio recordings will be translated more or less directly 

from Danish into English with reservations to the fact that some phrases may be 

difficult to translate directly into English in order to maintain the meaning. Therefore, 

the spoken words of the students and the teacher may be interpreted (van Nes, Abma, 

Jonsson, & Deeg, 2010). The screen recordings have been named “Module number, 

USB number, File number”. A list of the recordings is presented in A.3. 

Further, for taking field notes (data 3), a scheme was developed with the RQs in mind 

(see A.4). Both researchers took field notes throughout both courses to support the 

validity of the notes taken. They will be used both for given a holistic picture of the 

actions, of both the students and the teacher, in the lessons as well as for providing 

supporting comments for the screen recording data. When observing the PSs - being 

at most three students per researcher - the researchers were placed just behind them. 

This allowed each researcher to maintain an overview when writing the notes and 

keeping an eye on what is not immediately traceable from the screen recordings. The 

researchers attempted however to keep some distance, in order not to disturb the 

work of the students. Noticeably, the positioning of the researchers in the classroom 

was further affected by the teacher’s organisation of the students’ work. When the 

students worked in groups, each researcher observed one group, preferably with 

two-three Mac users in the group. This, in order to follow the process more intensely 

rather than seeking to cover several groups each, at the same time, which can result 

in a collection of screen recordings with little or no supportive field notes. When the 

students worked individually, the researchers positioned themselves such that they 

followed a maximum of three Mac users each, sitting near to each other. 
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As a supplement for the collection of screen recordings, photographs of any 

handwritten notes made by the PSs in connection with their work in GG is also 

functioning as empirical data (data (4)). This with the assumption that it could 

happen that the PSs would write down their considerations and answers using pencil 

and paper next to their work in GG. Hereby, data (4) may give access to 

supplementary technology (𝜃) and theory (Θ) practised by the PSs. When found 

relevant such specific photographs will be referred to in the analyses of the empirical 

data (sections 7.1 and 7.2). 

Furthermore, collected answers of take-home group assignments (data (5)) may 

work as a perspective, when relevant for work with GG, on the learning outcome for 

the students in form of praxeologies (both instructed by the teacher and developed by 

the students) in relation to GG. 

The data contributing to answering RQ3 is mainly data (3), but also relevant parts of 

data (4). The part of the field notes (data (3)), oriented solely on the praxis of the 

teacher and how s/he orchestrates the work with GG, was made from a free corner of 

the classroom, in order for the researcher to not stand out. In the situations where the 

teacher interacted with the students in their work with GG, notes were taken from the 

positions near to the PSs. Additionally, photographs of the teacher’s work with GG 

(taken later in the progress of the study62) can give a supportive impression of the 

teacher’s exploitation modes of GG work in the lessons. 

An endnote for the methodology presented here is that the empirical data will be 

used to an extent found appropriate for the analyses of the specific courses in relation 

to RQ1-RQ3 which will be elaborated in the following (sections 7.1 and 7.2). 

  

                                                        

62 Only done in connection with the Trigonometry course, since the observations of the Power 

Function course were finished when a relevance of such photographs was experienced. 
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7.0 Analyses of the Empirical Data 

Here, the analyses of the empirical data collected through the two courses will be 

presented. More specifically, these analyses are based on the data (1)-(5) presented 

in the above section (6.0) on the methodology in order to answer RQ1-RQ3. A 

common aspect of the two analyses is that the content of the courses in relation to GG 

work will be listed in tables (Table 2 and Table 3) and herein put in relation to the 

exam tasks and exercises presented in the sections 4.1.2 and 4.2.2. The latter can 

further be put in relation to the overall motivation of the study (see section 1.0), lying 

in the written examination being an overshadowing goal, for which ATD has been 

chosen as a theoretical framework.  

To be noted, whenever the term explanation is used in relation to the students’ praxis, 

it refers to a technological-theoretical discourse, i.e. an establishment of a knowledge 

block.  

7.1 The Trigonometry Course (L) 

7.1.1 Outline of the Course 

The observed course of Trigonometry is based on 10 modules, where the 

observations were made during the initial modules of the course which means that it 

was not observed to the end. Primarily part 1 (concerning right and similar triangles) 

but also a very tiny part of part 2 (concerning the area formula) out of three parts of 

an assignment of the theme, working as an outline of the modules, provides the 

framework of the observed course (see A.5; “1.del” and “2.del”). In Table 2 below, an 

overview of the observation study in Trigonometry is presented. 
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Module 

no. 

Content in relation to GG 

 

Relation to exam 

exercises 

1 Construction of triangles - altitudes, medians, angle bisecting 

and perpendicular bisector 

Exercise 

presented in 

Figure 15 

2 Construction of triangles - altitudes, medians, angle bisecting 

and perpendicular bisector 

Exercise 

presented in 

Figure 15 

3 Construction of triangles - similar triangles 𝑇𝐸𝑇5
 

4 Construction of triangles - similar triangles 𝑇𝐸𝑇5
 

5 GG worksheets concerning the proof of the Pythagorean 

Theorem via sliders and a click proof (see A.6.1 and Figure 

52, respectively) 

No direct relation 

to exam exercises. 

Applicable in 

relation to tasks 

involving right 

triangles. 

6 Construction of the unit circle including the definition of 

cosine and sine (herein lies working with the directional 

point and directional angle) 

No direct relation 

to exam exercises 

7 Work with take-home group assignments (Part 1 (“1.del”), 

exercises (a)-(l) in A.5) 

Exercise 

presented in 

Figure 15 and 𝑇𝐸𝑇5
 

8 Work with cosine and sine in relation to the unit circle (see 

Figure 53) and the proof of cosine and sine in right triangles 

via GG worksheet (click proof) (see A.6.2) 

No direct relation 

to exam exercises 

9 Work with definitions of sine and cosine through GG 

worksheet (see Figure 53) as well as in relation to right 

triangles 

No direct relation 

to exam exercises 

10 Work with sine and cosine in relation to right triangles. 

Work with the proof of the area formula in arbitrary triangles 

via GG worksheet (click proof) (see A.6.3) 

Area formula 

relates to 𝑇𝐸𝑇4
 

 

Table 2 From left to right column; The number of the observed modules, a brief overview of what was taught and 

learned in the respective module with respect to GG, and the last column represents the taught and learned 

knowledge in relation to the exam exercises presented in section 4.1.2. 

Note that the area formula was only briefly introduced in module 10 and was to be 

further examined in the modules to come. 

From Table 2 it is shown that TT introduced the definition of cosine and sine in the 

unit circle context first (module 6, 8, and 9) and then later introduced them in the 

triangle context (module 9 and 10).  
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7.1.2 A General Overview of the Teacher’s Orchestrations in Relation to GG  

The following section explains the overall teacher orchestrations in relation to GG 

throughout the modules. TT always started the 

modules by presenting the structure of the specific 

module, possibly homework, academic goals, and 

the exercises of the day on a projector to all the 

students in the class. TT highlighted the exercises of 

the day on a projector, which were always related 

to GG either through direct construction work or 

GG worksheets, and left the screen like this for the 

rest of the module unless something was going to 

be presented on the projector such as the CAS View 

of GG. By highlighting these points, the students 

were always aware of what to do and which 

exercises to solve. This is shown in Figure 73. 

It is worth mentioning that TT also made use of the blackboard but not in relation to 

GG. The situations where TT found it necessary to use the blackboard are for instance 

when reviewing technological-theoretical elements or homework of the day or when 

setting an exercise in the beginning of the module (not necessary related to 

Trigonometry) which the students should be able to solve without using any aids. 

In general, there was a major focus on the use of GG throughout the modules. This is 

not surprising since most of the tasks instructed by TT are to be found on TTW where 

all the tasks are oriented towards GG, as earlier mentioned (in section 4.1.3). Some 

examples of tasks have already been presented, as 𝑡𝑇𝑇𝑊1
- 𝑡𝑇𝑇𝑊6

, but in the following, 

some relevant exercises and tasks for this analysis will be presented as well. These 

will be presented in connection with the instrumented techniques (𝜏𝑖) used by the 

students as well as potential explanations in relation to the instructed exercises and 

tasks. As also previously mentioned (in section 4.1.3), TT used GG worksheets when 

introducing proofs like the Pythagorean Theorem and the formulas of cosine and sine 

in right triangles (see Figure 52 and A.6.2) in an attempt to have the students to 

establish a knowledge block.   

Figure 73 TTs use of projector in the 

introduction to a module. As shown, TT 

highlighted what was to be examined. 
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TT wants for the students to be familiar with GG since it is a tool, they will be using 

throughout their entire study time. This is one of the reasons why TT established an 

exploratory environment where the students were allowed to explore on their own 

and gain knowledge of the different gestures and instrumented techniques that GG 

has to offer. Another reason is that TT learns GG simultaneously with the students 

and thereby discovers the potentials of and possible obstacles with GG. 

It is clear from section 4.1.3 that no book was used in the teaching of the course. On 

that basis, TT expected the students to take individual notes in which they for 

instance could explain what they had observed in GG. 63 In that manner, TT 

encouraged the students to establish a knowledge block. Whether the students were 

capable of establishing such a block will be explored throughout this section. 

TT let the students work on their own computers when working in GG, also when it 

came to group work. Hence, all of the students got to practise gestures and techniques 

in GG. In the modules 5, 7, 8, and 10, TT let the students work in groups. In these 

modules, they were working with GG worksheets (especially click proofs) and the 

take-home group assignment where it is preferable to have someone to talk to in 

order to justify and explain the results (often via algebraic expressions) and the way 

to reach them. 

In two of the modules, TT instructed the students to position themselves in such a 

way that their backs were turned to the middle of the classroom such that TT could 

better keep an eye on what was going on their computer screens. Another reason was 

because it was easier for TT to get around in the classroom in order to help the 

students. TT circulated among the students when they worked on their own, whether 

it was individually or in groups, in order to help and to keep track of the students’ 

work. 

Consistently for all modules, TT (in interaction with the students) made a recap in the 

last five minutes of the module of what the students were supposed to have learned 

in that particular module. This very often ended with TT having to explicitly ask them 

                                                        

63 These statements on TT’s methods related to GG work and the teaching material were expressed by 

TT him-/herself in connection with an introduction meeting with TT. 
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to share what they have gained from their work with GG, since many of the students 

only referred to what was learned outside of the work with GG (through blackboard 

and projector presentations by TT). Hereby a distinction of the mathematics learned 

in GG and the mathematics learned outside of GG was (seemingly unintentionally) 

made.  

Next, a presentation, of the mathematical praxeologies established by the students in 

relation to GG on the basis of the instructed exercises and tasks by TT, will be given. 

7.1.3 The MOs Instructed by the Teacher and Established by the Students 

This section will examine the gestures and instrumented techniques used by the 

students in order to answer the specific exercises and tasks related to GG, determine 

the students’ ability to establish a knowledge block, and examine the common 

observed characteristics related to GG which includes an example of the challenge in 

making the variables dependent of one another.  

All the exercises instructed by TT either require constructions of arbitrary triangles 

(especially in the modules 1-4) or constructions of right triangles (primarily in the 

modules 9-10). A task related to the need of constructing an arbitrary triangle (AT) 

could be the second task (2.) of the instructed exercise (1.1) (see A.6.4), since it 

explicitly asks for a drawing of an arbitrary triangle. The technique used by all of the 

PSs to answer this task was as follows: 

𝝉𝑨𝑻,𝑨𝑷,𝑷𝑺
𝒊 :  Click on the Polygon Tool  → Click three different places in Graphics 

  View to make three corners → Connect the points so that the last click 

  ends at the same place where the first point was placed. 

The above technique has emerged on the basis of the video belonging to exercise 1.1 

concerning an examination of the altitude where it is required to draw an arbitrary 

triangle. Such a video can noticeably provide shared knowledge, concerning the 

instrumented techniques to be performed in GG, to the students. This is a didactical 

configuration made by TT and can be equated with a second level orchestration, since 

the video presents a combination of gestures forming a technique.  

The exercises concerning right triangles (RT) have no video nor a detailed manual 

associated with the exercise (see section 4.1.3), which may lead to more individual 
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and explorative techniques for the students to develop. Hence the techniques may 

become more spontaneous since there is no given instruction of how to solve the 

exercises. Some exercises concerning right triangles instructed by TT are listed here: 

𝒆𝒙𝒆𝒓𝒄𝒊𝒔𝒆𝑹𝑻𝟏,𝑨𝑷,𝑻𝑻:  Given a right triangle ABC, where angle C is right, and 𝑎 = 6, 

   𝑏 = 8, and 𝑐 = 10. Construct the triangle and measure the 

   angles (“Øvelse 3.50” a) in A.6.5). 

𝒆𝒙𝒆𝒓𝒄𝒊𝒔𝒆𝑹𝑻𝟐,𝑨𝑷,𝑻𝑻:  In triangle ABC, angle 𝐴 = 90°, angle 𝐵 = 63° and 𝑏 = 7. 

   Construct the triangle, and measure the sides and the last 

   angle unknown (“Øvelse 3.51” b) in A.6.6). 

The different observed spontaneously developed 𝜏𝑖  for constructing right triangles in 

GG in order to solve these exercises are listed below: 

𝝉𝑹𝑻𝟏,𝑨𝑷,𝑷𝑺
𝒊 :  Click on the Segment with Given Length Tool → Click on the 

  Perpendicular Line Tool  → Click on the point and the line on which the 

  perpendicular line should be perpendicular to → Click on the Segment 

  with Given Length Tool  → Click on the Move Tool  such that the line 

  segment just constructed can be moved such that it lies on top of the 

  perpendicular line → Click on the Segment with Given Length Tool → 

  Click on the Move Tool  such that all the line segments touches each 

  other → Click on the Polygon Tool  to combine the points [→ Remove 

  all lines and points that are not to be used.] 

To be noted, the part marked by [ ] is not a necessity for solving the exercise (this is 

also the case in the technique below; 𝜏𝑅𝑇2,𝐴𝑃,𝑃𝑆
𝑖 ). Further, note that the technique just 

described can be applied to exercises similar to 𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇1,𝐴𝑃,𝑇𝑇. 

𝝉𝑹𝑻𝟐,𝑨𝑷,𝑷𝑺
𝒊 :  Click on the Segment with Given Length Tool  → Click on the 

  Perpendicular Line Tool  → Click on the point and the line on which the 

  perpendicular line should be perpendicular to → Click on the Angle with 

  Given Size Tool  (clockwise) → Click on the angle leg point and the 

  angle vertex point → Click on the Ray Tool  → Click on the Intersect 

  Tool  → Click on the Ray and the Perpendicular Line (creates 

https://www.geogebra.org/manual/en/Perpendicular_Line_Tool
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  intersecting point) → Click on the Polygon Tool  to combine the points 

  [→ Remove all lines and points that are not to be used.] 

This technique can be related to exercises similar to 𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇2,𝐴𝑃,𝑇𝑇.  

The last technique developed by the students to be presented here does not relate to 

the exercises instructed (𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇1,𝐴𝑃,𝑇𝑇 and 𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇2,𝐴𝑃,𝑇𝑇) but is just an 

attempt to construct a right triangle with no given length or sides and is in a sense 

related to 𝜏𝑅𝑇1,𝐴𝑃,𝑇𝑅
𝑖 : 

𝝉𝑹𝑻𝟑,𝑨𝑷,𝑷𝑺
𝒊 :  Click on the Polygon Tool   → Click three different places in the 

  Graphics View and try to let two of the three points be collinear and 

  combine them such that the first point clicked is also the last one.  

To be noted, in relation to this technique, the outcome is not guaranteed to be a right 

triangle whereas the use of the grid in 𝜏𝑅𝑇1,𝐴𝑃,𝑇𝑅
𝑖  makes it certain. 

There were even some PSs 

that discovered a gesture in 

GG in relation to 

𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇1,𝐴𝑃,𝑇𝑇  which was 

to click on the Distance or 

Length Tool  which puts the 

length measure onto the 

triangles sides in the Graphics 

View as shown on Figure 74. 

This gesture is noteworthy 

not explicitly instructed by 

TT. From the above techniques and gestures, concerning right triangles, it becomes 

clear that there are different paths to the same goal. It is also possible to put together 

some of the different gestures used in the techniques in a different order and still 

reach the same outcome. In fact, none of these techniques just presented are precisely 

the same as 𝜏𝑅𝑇1,𝐴𝑃,𝑇𝑅
𝑖 , 𝜏𝑅𝑇2,𝐴𝑃,𝑇𝑅

𝑖  and 𝜏𝑅𝑇3,𝐴𝑃,𝑇𝑅
𝑖  which demonstrates that GG is a 

versatile tool where not only one technique is applicable for solving one specific 

exercise. The more explorative techniques established by the students are based on 

Figure 74 A right triangle where the Distance or Length Tool is used. 

Hereby, GG presents the side lengths in the Graphics View where 

|𝑨𝑪| = 𝟔, |𝑪𝑩| = 𝟖, and |𝑩𝑨| = 𝟏𝟎. 
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TT’s more open-formulated exercises where there is no exact technique instructed, 

for instance in the shape of a detailed manual or a video or by TT him-/herself. This 

way, the students do not for certain develop the same techniques which gives them 

the possibility to personalise their techniques in such a way that the individual 

student choose the ones most intuitive to perform. This can be equated with a third 

level orchestration since the students can reflect upon the techniques chosen to be 

used.  

There are more examples of different techniques solving the same task throughout 

the modules, for instance the construction of a perpendicular bisector (PB) (see 

exercise 1.4 task 3. in A.6.7). Here, two different types of techniques are discovered by 

some PSs: 

𝝉𝑷𝑩,𝑨𝑷,𝑷𝑺𝟏

𝒊 :  Click on the Polygon Tool  to combine the points → Click on the 

  Midpoint or Center Tool  → Select the line segment and the midpoint of 

  that line will be placed → Click on the Perpendicular Line Tool  → Click 

  on the line where the midpoint is placed and the midpoint (the 

  perpendicular line is constructed). 

𝝉𝑷𝑩,𝑨𝑷,𝑷𝑺𝟐

𝒊 :  Click on the Polygon Tool  to combine the points → Click on the 

  Perpendicular Bisector Tool → Select the line to which the 

  Perpendicular Bisector should belong. 

Actually, TT was not aware of the existence of the latter technique, which again 

indicates that there are many facets of GG which almost makes it impossible for TT to 

be familiar with all the gestures possible to perform in GG.  

One very important feature, which GG offers and which TT is well aware of, is the 

feature where the figures constructed can be accessed dynamically. To make a figure 

dynamic and not static, one must make the variables interdependent. To make the 

variables dependent of each other requires a consistency with the notions. There is a 

huge importance attached to an awareness of the use of uppercase and lowercase 

letters, which became evident for both TT and the students, especially in modules 3 

and 6 concerning construction of similar triangles (ST) and the unit circle (UC), 

respectively. Some of the tasks instructed by TT in module 3 were as follows: 
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𝒕𝑺𝑻𝟏,𝑨𝑷,𝑻𝑻:  Construct two similar triangles (see A.6.8 for the manual of this task; 

  exercise 3.1 “Opgave 1”). 

𝒕𝑺𝑻𝟐,𝑨𝑷,𝑻𝑻:  Given two similar triangles constructed in GG. Try to imagine, that you 

  have to calculate one of the side lengths. How can it be determined if the 

  other five side lengths are known? (From exercise 3.1, “Opgave 2”, in 

  A.6.8). 

This task is followed by hints such as writing “ka=a1/a” in the Input Bar in GG.  

Noticeably, 𝑡𝑆𝑇2,𝐴𝑃,𝑇𝑇 and the hints given in connection thereto has a significant 

relation to solving tasks of type 𝑇𝐸𝑇5
. This, since 𝑡𝑆𝑇2,𝐴𝑃,𝑇𝑇 is solved by realising the 

need of the scale factor to determine the unknown side length. 

A task instructed in module 6 reads: 

𝒕𝑼𝑪,𝑨𝑷,𝑻𝑻:  Given the constructed unit circle. Drag the directional point P. What is 

  the connection between Px, Py and the coordinates to the point P? (See 

  A.2; TTW 1 task 3.). 

The technique used by all of the PSs for 𝑡𝑆𝑇1,𝐴𝑃,𝑇𝑇 was the same and is actually a 

combination of the two techniques 𝜏𝑆𝑇1,𝐴𝑃,𝑇𝑅
𝑖  and 𝜏𝑆𝑇2,𝐴𝑃,𝑇𝑅

𝑖 . This is maybe due to the 

fact that detailed manuals are given in connection with the exercises in which the 

tasks occur. The aspect of the provided manuals constitutes a second level 

orchestration made by TT. For the construction of the unit circle and the construction 

of the directional point and angle, the techniques used were 𝜏𝑈𝐶,𝐴𝑃,𝑇𝑅
𝑖  and 𝜏𝐷𝑃𝐷𝐴,𝐴𝑃,𝑇𝑅

𝑖 , 

respectively - again due to the given manuals. However, many of the PSs did not 

follow or read the manuals carefully since they were not able to make the point P on 

the unit circle dynamic. This was due to the fact that many named the directional 

angle “V” but when entering the point “P=(Px, Py)=(cos(V), sin(V))” they used “v” as 

the angle instead of “V”. Hereby, GG automatically created a slider since “v” was not 

defined.  This may reveal that they were not yet aware of cosine and sine with respect 

to the angle being the coordinates to the point P on the unit circle. Nor could they 

construct two interdependent triangles because of the lack of awareness on how to 

type the defined angles. It is again very important here to be consistent with the 

notation.  
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Figure 75 below shows a screenshot of the work of a PS in GG who has been able to 

construct two interdependent and similar triangles ABA’ and vAvBvC in GG.  

 

Figure 75 Two similar triangles, triangle ABA’ and triangle vAvBvC have been constructed here, where the sides of 

triangle ABA’ are 𝒂𝟏, 𝒃𝟏, and 𝒄𝟏 and the sides of triangle vAvBvC are 𝒂, 𝒃, and 𝒄. The triangles are shown in the 

Algebra Perspective where a slider for the value a1 also has been constructed by GG.   

In an attempt to solve 𝑡𝑆𝑇2,𝐴𝑃,𝑇𝑇, the PS entered “ka=a1/a” in the Input Bar in GG and 

GG consequently created a slider for a1 since it was not defined. The PS did not 

understand the use of the slider and abandoned the attempt to solve the task. What 

the PS should have written was “a_1” and not “a1” because of the way the sides are 

defined in the triangles. The PS however never became aware of this, and merely 

followed the hint without realising that the hint was to use the ratio of two 

corresponding sides in order to determine the scale factor. This again shows the 

importance of the consistency of the notation. This raises the question of whether the 

need of a focus on such consistency in the praxis related to GG may remove focus 

from the mathematical conceptual understanding. This will be discussed in section 

8.1. Thus this PS did not make use of GG to calculate the scale factor since it was 

challenging for the PS to link algebra to the figure constructed in GG (with references 

to Geometry II).  In prolongation of this problematique, it noticeably seemed easier 

for this PS to perform solely algebraic techniques in relation to solving a task similar 

to 𝑡𝑆𝑇2,𝐴𝑃,𝑇𝑇 later in the same module (see A.6.9). 
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Due to the notation problematique, TT chose to make an oral recap of five minutes, 

where this important feature was to be shared with every student in the classroom.  

Many of the PSs, especially in the beginning of the course, actually had a hard time 

using GG, both dynamically but also for explaining their observations of what they 

had just seen or constructed, where the latter is one of the long term goals for the 

teaching planned by TT. Some of the PSs rather used the formulas for cosine and sine 

connected to right triangles regardless of being presented to a unit circle in GG (or in 

a GG worksheet) or having constructed a right triangle in GG. In the just mentioned 

cases, the students were respectively supposed to drag the directional point on the 

unit circle and read off the measured angles and/or side lengths of the right triangle 

constructed, instead of the using the formulas. Especially, this reveals a struggle with 

managing the relation between the analytic and the synthetic geometry. 

In the following passage, some examples of the students struggling when using the GG 

dynamically or making conclusions on the basis of something constructed in GG will 

be presented. The first example is when the students had to solve the instructed task 

of constructing medians in GG and explain the observed (TTW 5 task 3. in A.2). 

This task noticeably relates to the exercise presented in Figure 15. 

A PS called for TT’s help in order to answer this task. This need for help arose after 

the PS had constructed the triangle and the median by applying 𝜏𝑀𝑒𝑑𝑖𝑎𝑛,𝐴𝑃,𝑇𝑅
𝑖  as well 

as using www.google.com in order to try to understand the notion of a median. Below, 

a transcript excerpt from USB Blå, file 2, Module 2 (see A.3.1) is presented. TT wants, 

in this situation, to hear the PS’s explanation of a median: 

PS:  The median cuts in the middle. 

TT:  Yes, in the middle of what? 

PS:  Of the triangle. 

TT:  Of the triangle? Where is the middle of the triangle? I don’t think it is what you mean? 

PS:  In the middle of… in the middle of… the baseline. 

TT:  Yes, that you can call it… Or maybe we should define it as.. We have an angle and it cuts 

  the opposite side.. and it is the opposite side we look at… It is the middle of that side not 

  the middle of the triangle.. it is the middle of the side. 

PS:  Yes. 

TT:  Write it down. 
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The PS hereafter opens Word and write down: A line which cuts the line on the side 

opposite to the angle (USB Blå file 3 Module 2; see A.3.1). As mentioned, TT here tried 

to get the students to establish a knowledge block in the terms of the instructed task 

having technological characteristics when asking “explain the observed”. Here, it is 

however seen that the PS was not entirely capable of describing a median since the 

written description is not precise enough for it to concern a median.   

Another example that should be pointed out is from module 8 where the students 

worked with the GG worksheet presented in Figure 53. Here, the students had to find 

cosine and sine with respect to a given angle by dragging the point P. Instead, the PSs 

used the formulas for cosine and sine in connection with right triangles. Hence, sine 

and cosine were just used as a toolbox for solving trigonometric problems. In 

addition, the following transcript excerpt from USB 6 file 1 Module 10 (see A.3.1) 

point out the exact same (thus using formulas instead of GG dynamically), where a PS 

and another student (AS) talk to each other about solving 𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇1,𝐴𝑃,𝑇𝑇: 

PS:  What was it that we have to calculate? 

AS:  I used the Law of Sine but you probably shouldn’t since we are not allowed to do that. 

PS:  Okay. 

Obviously, the AS knows that it is wrong to use the formulas but does it anyway, 

which also shows a clear example of the students feeling insecure in using GG at that 

point. Many of the PSs found it hard to understand the unit circle context and 

preferred the triangle context which could be because it is well known as a context 

from the elementary school (Webpage: Fælles mål 2009 (historiske) Folkeskolen, 

2016, p. 60). However, even though the PS and the AS have the dialogue above in 

module 10, it is worth mentioning that as the modules progressed, most of the PSs 

became more comfortable in performing gestures and techniques in GG, also dynamic 

ones, especially after the take-home group assignment (in module 7) which is to be 

elaborated further down. 

The next example concerns student work with exercise 4.2.2 (TTW 1 in A.2) where 

the students had to find cosine to a specific angle as well as sine to a given angle by 

dragging the directional point P on a unit circle, just as in 𝑡𝑇𝑇𝑊1
 and 𝑡𝑇𝑇𝑊2

. Hence, the 

students were encouraged to work with cosine and sine in relation to the unit circle. 
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The following transcript excerpt is from USB 6, file 4, module 6 (see A.3.1) and 

indicates that the two students AS1 and AS2 have a hard time letting go of cosine and 

sine in relation to the triangle context: 

AS1:  Cos to an angle is the relationship between the adjacent side and the hypotenuse, right? 

AS2:  Yes. 

AS1:  This means, if the adjacent side has length 5 and the hypotenuse… 

AS2:  Well, it is not the intention.. It is not something definitely, you just have it on you 

  calculator… 

AS1:  But, isn’t it possible to calculate it in this way? 

AS2:  I don't know… If you take the ratio of two sides you just get a constant… you know the 

  scale factor. 

AS1:  Yes yes exactly. 

AS2:  So, cosine is just something you enter on your calculator. 

AS1:  Yes. 

The students try to put into words their understanding of the notions (i.e. they try to 

establish a knowledge block) but the statements above show a clear example of a 

black box effect since cosine is just a button on the calculator (according to AS2). What 

this also shows is that AS1 perceives cosine to an angle in relation to the triangle 

context and not the unit circle context. Overall, it seems however problematic for 

these two students to manage the definition of cosine and sine with respect to an 

angle, whether in the triangle context or in the unit circle context. 

TT made a recap in the last five minutes of this module where the students 

contributed with terms, such as directional point and directional angle, as well as the 

importance of the notation in GG by being consistent in using the same letter for the 

directional angle. In this recap it was not explicitly mentioned by TT that no formulas 

were allowed to be applied at this point but TT repeatedly stated that the students 

must use GG dynamically.  

One common observed gesture/technique used by all of the PSs is the Angle Tool  

in relation to triangles, for instance in relation to 𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇2,𝐴𝑃,𝑇𝑇 or 𝑡𝑆𝑇1,𝐴𝑃,𝑇𝑇. The 

challenge in using this tool is that one must know which angle leg to pick first, in 
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order to get an interior angle which is in 

the students' interest as they are working 

with triangles. Almost all the PSs had a 

hard time figuring this out. As shown on 

Figure 76 the angle 𝛼 is exterior and not 

interior where the latter was the PS’ 

intention. Angle 𝛼 was obtained through 

the following technique (similar to 

𝜏𝐴𝑛𝑔𝑙𝑒2,𝐴𝑃,𝑇𝑅
𝑖 ): 

𝝉𝜶,𝑨𝑷,𝑷𝑺
𝒊 :  Click on the Angle Tool  

  and select to segments → 

  Click on line segment AB and 

  then BC. 

Here, GG is programmed to interpret AB 

to be the initial leg which was not the intention. Many of the PSs however found out 

which leg to start with in order to get an interior angle merely through what seems to 

be clicks on the legs in a random order until the angle is interior. The question is here, 

whether they learn from this in general or if they only see the clicking on the right leg 

as a first as an important feature in GG for constructing interior angles.  

There was a brief recap of the angle notation where it was described by TT in 

interaction with the students that the interior angle C of a triangle ABC (drawn on the 

blackboard) is the same as angle ∠𝐵𝐶𝐴, where BC and AC are the initial and the 

terminal leg, respectively, and the exterior angle C is the same as angle ∠𝐴𝐶𝐵 where 

AC is the initial leg and BC is the terminal leg. Hereby, TT tried to make the students 

aware of the importance of the order of the angle legs. In prolongation of this, there 

was a brief sum up where it was stated that an angle in a triangle ∈ (0°, 180°).  

It has further been observed that most of the PSs used the legs of the triangle to 

construct angles, a few used the three vertices (𝜏𝐴𝑛𝑔𝑙𝑒1,𝐴𝑃,𝑇𝑅
𝑖 ) but no one discovered 

𝜏𝐴𝑛𝑔𝑙𝑒3,𝐴𝑃,𝑇𝑅
𝑖 . 

Figure 76 Here, an arbitrary triangle ABC has been 

constructed by a PS where the 𝜶 is an exterior angle 

and 𝑽𝜶 is an interior angle. 
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As mentioned earlier, TT made a great deal out of letting the students explain and 

justify their results and what they have observed in GG. Examples thereof have 

occurred throughout this section, for instance when a PS should write down how to 

describe a median in Word. Here, some more examples are to be presented. 

The first example is based upon one of the only exercises instructed by TT that 

actually required the formulas of sine and cosine in relation to right triangles: 

𝒆𝒙𝒆𝒓𝒄𝒊𝒔𝒆𝑹𝑻𝟑,𝑨𝑷/𝑪𝑽,𝑻𝑻:  Given a right triangle ABC where angle C is right and angle 

   𝐵 = 77° and the cathetus 𝑎 = 13. Determine the unknown 

   sides and angles through calculations and check the results 

   by construction and measurements (“Øvelse 3.47” in 

   A.6.10). 

For solving the above exercise, several PSs used Word or paper and pencil to write 

down the formulas and rewrite them in order to solve the exercise, using a classical 

CAS tool of own choice (including GG). Within this praxis, the PSs managed to explain 

their calculations to a great extent. As an example of such a praxis in relation to 

𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇3,𝐴𝑃/𝐶𝑉,𝑇𝑇, one PS used Word for the notes (see A.6.11) and started out by 

calculating the unknown angle A by using that the sum of the angles in a triangle is 

180° and isolating A in this equation. Next, the PS calculated the unknown side c via 

the formula cos(𝐴) [ =
𝑎𝑑𝑗𝑎𝑐𝑒𝑛𝑡 𝑐𝑎𝑡ℎ𝑒𝑡𝑢𝑠

ℎ𝑦𝑝𝑜𝑡𝑒𝑛𝑢𝑠𝑒
 ] =

13

𝑐
 (without writing the part marked by [ ] 

though) and isolating c herein. Finally, the PS calculated b by using the Pythagorean 

Theorem. Throughout this PS’ notes it is clear that the PS knows how to manipulate 

with the formulas. The PS more specifically makes an effort as to establish a 

knowledge block, in the sense that the PS explains the calculations through written 

sentences by referring to the angle sum of a triangle and the Pythagorean Theorem.  

Noticeably, this PS used the CAS View of GG when calculating both of the unknown 

sides. However, the PS calculated in radians without realising it, even though TT had, 

at this point of the course, instructed the importance of using the degree symbol (°) - 

this will be elaborated further down. 

The great importance that lies in the students being able to use correct terms when 

working with a task or an exercise is expressed through some of the observed 
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dialogues that TT had with the students while circulating around in the classroom to 

help the students, a part of the teacher orchestration. For instance, when having a 

conversation with two students, a PS and an AS, in relation to the task 𝑡𝑈𝐶,𝐴𝑃,𝑇𝑇. Here, 

TT made an effort as to get the students to deduce, from working with the unit circle, 

that cosine to the directional angle is the x-coordinate of the directional point and sine 

to the directional angle is the y-coordinate of the directional point. Here TT really tries 

to get the students to use the correct terms in a coherent manner - for instance by 

noting that it is not enough just to say “the directional point” but the students should 

say “the directional point on the unit circle” (from USB 6, file 4, module 6 (see A.3.1)). 

Another example is the dialogue between TT and a PS (from USB 8, file 1, module 1) 

where the PS tries to explain the definition of an altitude. The PS has asked TT for 

help after seeing the video that belongs to the task (exercise 1.1; see A.6.4). 

PS:  How do I construct an altitude? 

TT:  You can get help from the video or try to explore the Menu. What is an altitude? Have 

  you looked it up in the formula collection? Tell me, what is an altitude of a triangle? 

PS: It is from the apex... or the top of the triangle and onto the baseline. 

TT:  How onto the baseline? There are many ways it can fall down to the baseline? 

PS:  [Points with the computer mouse from A to the line between C and B] straight down.   

TT:  What do you mean when you are saying straight down? 

PS:  Just straight. What is it you want me to say? 

TT:  Well, it is not quite the correct terms you use. Straight is not precise enough. Straight it 

  is, but it just means that it is not skewed. 

PS:  What is it called when it goes like this [the PS draws a straight vertical line in the air] 

TT:  You mean perpendicular? 

PS:  Aaaarh... It must be perpendicular to the baseline. 

TT:  Yes, isn't it what is special about altitudes? 

PS:  Yes. 

Subsequently, TT tells the PS to go to the Menubar and select something that can 

make a perpendicular line. At no point does TT tell the PS how to construct the 

altitude in GG and wants the PS to think about the techniques possible to use from 

what the PS now knows about an altitude. However, TT gives this student knowledge 

to the boxes in GG that describes how the specific tool works (these boxes are also 

described in section 4.3.2). Noticeably, this gesture within using a helping box was 

not to be summed up by TT. The way of letting the students find the gestures in order 
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to solve a given task on their own was, as mentioned before, a deliberate choice by 

TT. From the above dialogue, it is (again) seen that TT wants the students to use the 

exact terms. This had a high priority throughout all the modules.  

To be noted, after having had the above dialogue with TT, this PS dragged in the 

constructed triangle with three altitudes in GG and wrote down (in Word) that the 

altitudes of the triangle always intersect (USB 8, file 1, module 1). This shows the PS’ 

ability to use GG dynamically and reflect upon it. 

Many of the exercises and tasks had an associated video attached just as the task that 

lead to the dialogue just above. In connection hereto, it was also observed that many 

of the PSs just followed such a video parallel to their own constructions and did not 

reflect upon what they had just constructed or just watched in the video, as the 

situation leading to the above dialogue was a clear example of. In general, the aspect 

of the observed student approach to the videos may be an example of a black box 

effect since the students may blindly perform the gestures in GG without reflecting 

upon them.  

Thus, TT tried to establish praxeologies of both a practical block and a knowledge 

block for the students through the instructed exercises, but they are not always in 

accordance with what praxeologies the PSs actually established.   

Now, some of the praxeologies established when the students spoke together in 

groups will be reviewed. Here, some of the students established a knowledge block by 

explaining to the other classmates of the group how to solve the given task. For 

instance: 

𝒕𝑪𝒐𝒔𝒊𝒏𝒆 𝒕𝒐 𝒂𝒏𝒈𝒍𝒆,𝑾𝒐𝒓𝒌𝒔𝒉𝒆𝒆𝒕,𝑻𝑻:  Argue for the formula cos(𝑣) = − cos(180 − 𝑣) 

    from the figure (exercise 6, task 10.; see  

    A.6.12). 

This task is associated with a GG worksheet which illustrates a unit circle and two 

points on the unit circle with respect to angle 𝑣 and 180 − 𝑣 (see Figure 1 in A.6.3). By 

dragging the points, the respective angle follows. The following conversation between 

a PS and an AS, in connection to the task, takes place (from USB 6, file 3, module 10 

(see A.3.1)): 
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AS:  I know why. We are on the negative side of the x-axis. 

PS:  What is negative? [points to the angle 180 − 𝑣] 

AS:  Cosine to v is equal to minus cosine to 180 minus v because when it [the point] is on 

  this side [points to the point in the second quadrant] then it [the x-coordinate] is minus 

  cosine. 

The AS here try to explain in words what is observed in the dynamic GG worksheet. 

The AS has clearly understood that cosine with respect to the angle is the first 

coordinate to the directional point and was in general very accurate, by using terms 

as directional point and directional angle in the work with the PS as a partner. In 

connection with this presented worksheet, it is seen that the students got the 

possibility of explaining what they observed in the unit circle context. It should be 

noted that this took place in the very last observed module where the students may 

have become more comfortable in considering cosine and sine in relation to the unit 

circle. 

As mentioned, TT also used click proofs in order to give the students the possibility of 

establishing a knowledge block, for instance the click proof of the formulas of sine 

and cosine in relation to the right triangle (A.6.2). Here the students could click their 

way through the steps of constructing a unit circle, two similar right triangles and 

their interrelationship. Along with the clicks, an illustration appears, which could 

make it easier for the students to grasp the proof. However, in the work with these GG 

worksheets, the students did not necessarily need to explain or reflect on why and 

how it was so, since they could just click their way through the proof and write off. 

This was also the observed in connection with the above mentioned click proof where 

an example is seen in the notes of a PS (see A.6.13) which were merely written off 

from the worksheet. Hereby, the worksheet may have become a black box rather than 

the intended kick starter for the establishment of a knowledge block.  It should be 

noted that this worksheet is extremely important in the way that it connects the unit 

circle context with the triangle context. This, in the sense that it provides insight to 

why the formulas for sine and cosine with respect to an angle in the triangle context 

are as they are. One can ask oneself if the students realised this?   

In connection with the implementation of click proofs in the course in general, it 
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should further be noted that TT only sometimes performed recaps on such 

worksheets.  

Until now, there has been a very large focus on 

the construction work and the dynamic aspect of 

GG but, as briefly mentioned earlier and also in 

section 4.3.2, there is a classical CAS tool in GG 

(the CAS View) which now will be reviewed for 

its implementation in the course. 

The CAS View in GG was introduced by TT in 

module 9 on the projector in order to create a 

common knowledge to the gestures and 

techniques to be used in this View of GG, thus 

both a first and a second level of orchestration. 

There was a need for TT’s common presentation 

since there are several reservations one must 

make when working with the CAS View in GG as 

a classical CAS tool. Many of them are already 

described in 4.3.2. A picture of TT’s presentation 

is shown on Figure 77. 

The presentation in Figure 77 shows elements of a first level orchestration included 

in the second level orchestration since TT has presented a really important gesture, 

namely the typing of the degree symbol (“Ctrl+O” on a Mac). Otherwise, GG will 

calculate in radians which is a term, the students will not be introduced to at this level 

of high school. TT noticeably did not mention this effect of not typing the degree 

symbol but merely put an emphasis on typing it. Another important gesture that was 

introduced in this orchestration is the typing of “sqrt” when calculating square roots 

and furthermore, the difference between using the techniques Solve and NSolve when 

making calculations. Even though this detailed introduction was made by TT, some of 

the PSs were not comfortable in using the CAS tool yet. Many forgot the degree 

symbol and calculated in radians, without noticing it, and they had trouble 

distinguishing between NSolve and Solve as well. If the output was complicated, like 

Figure 77 A picture of TT’s introduction to 

the CAS View in GG to the students on a 

projector. On the projector, cell 1 of the CAS 

View can be seen, where TT has written 

“sin(x°)=1/2” in the Input Field and then 

clicked on the Solve Tool and then the output 

is shown to be “{x=360k1+30, x=360k1+150}”. 

In cell2, TT has used the Numerically Solve 

Tool on the same input where the output is 

“{x=30}”. 
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the output in cell 1 on Figure 77, they simply just tried using a different gesture 

(browsing between the four tools presented in section 4.3.1; The CAS View). Many of 

the PSs did not use the classical CAS tool of GG and chose to operate with handheld or 

computer calculators instead, despite of the introduction made by TT. However, it is 

important to keep in mind that this is the first time that both TT and the students use 

GG in relation to Trigonometry, so it seems understandable that they do not feel as 

confident yet in choosing this as a CAS tool in general.  

Although many of the students found it difficult to use GG, it has a huge impact in the 

sense that the students can visualise the problem that they are faced with. In the light 

of this feature of GG, TT gave the students a take-home group assignment which 

included the use of GG dynamically (e.g. geometric constructions) and an oral 

presentation of the chosen tasks in a screen recording. The assignment was based 

upon the tasks (a)-(l) of the assignment of the theme part 1 (“1.del” in A.5). 

The students worked in groups of four to five students but each on their own 

computer in order to make an individual presentation of a specific task from (a) to (l). 

It should be noted that only task (a) and (b): 

(a) Define concepts to describe triangles, including altitude, angle bisector, 

  median, perpendicular bisectors, apexes and adjacent- and opposite side. 

(b)  Explain similar triangles.  

  Along the way, you must include the scale factor and theorems that apply 

  for similar triangles. 

are represented in the types of exam tasks and exercises presented in section 4.1.2 in 

the sense that (a) relates to the exercise presented in Figure 15 and (b) relates to 𝑇𝐸𝑇5
. 

All the other tasks from the take-home group assignment deal with right triangles and 

the definition of cosine and sine in this context, none of which are represented in any 

of the exam tasks. In this assignment, the students were asked to describe what they 

saw, to explain whether they worked with a definition, a theorem or a proof, to 

explain what was happening and to draw conclusions of the tasks. This strongly 

indicates that TT wanted the student to establish praxeologies of both the practical 

block and the knowledge block. 
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When going through the hand-ins, it becomes clear that some of the students did not 

use the dynamic aspect which GG offers. Instead, some of the students had 

constructed the triangle in Paint64 and made use of the computer mouse to point at 

the specific angle or side they talked about. Furthermore, most of the students lacked 

justifications and explanations when presenting the answer to the specific task. 

Hence, these students did not establish quite the same praxeologies as TT had 

expected them to. However, through this take-home group assignment and hand-ins, 

a common understanding of what was expected of the students, in connection to their 

work in GG, as well as a demonstration of which praxeologies the students could 

manage was established which the students and TT (respectively) could take with 

them consecutively. The students’ approach to the video recordings in the groups was 

observed to be very individual in the sense that they only practised their own task(s) 

without communicating much with their group members on the praxeologies. 

TT gave feedback to the screen recordings handed in by the students by making 

comments throughout the video like it is shown in Figure 78.  

 

Figure 78 A construction of a right triangle in GG is shown. A student tries here to answer task (d) of the take-

home group assignment: Define concepts to describe the right triangles, including hypotenuse, adjacent and opposite 

cathetus. As seen in the upper left corner, there is a grey, transparent, box with TT’s comments to the students 

work in GG; “Fine construction of a right triangle by the use of Geogebra”.   

                                                        

64 Paint is a standard Windows program offering the option of drawing objects. 
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The presentation of the student in Figure 78 noticeably shows the correct way of 

answering the task, since the student has actually used GG in order to construct a 

right triangle. Hence, there were students who managed to fulfil TT’s demands of 

using GG. The feedback was referred to by TT in module 9 (to be found in a shared 

folder on YouTube) where the students had the possibility of seeing the videos with 

feedback before continuing doing the exercises related to GG of the module. Here, 

only some of the PSs chose to have a look on the feedback video. 

As a sum up on this entire review, it was clear throughout the modules, through the 

formulations of the instructed tasks and the take-home group assignments that TT 

wanted the students to use the GG dynamically and in this connection write down 

what they observed through the visualisations. More specifically, the students had the 

possibility of seeing a lot of examples of the same type of object through GG’s dynamic 

features. However, the gestures for the construction of the objects and the approach 

to the dynamic features of the objects had not yet been fully established by the 

observed students through this course. Some of the students had difficulties in 

connecting algebra to the figures, to cope with the definitions of sine and cosine in the 

analytic geometry, to construct interior angles, and to make the variables 

interdependent such that the constructed figures actually became dynamic. However, 

it seems to be a great visualisation tool at this point of a Trigonometry course, 

especially through the worksheets where the objects have been constructed a priori, 

and the students only had to (mainly) drag in a point to deduce something from the 

observed object. As the modules progressed and especially after the take-home group 

assignments and the stated expectations in connection thereto, most of the PSs tried 

to use GG more dynamically.  
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7.2 The Power Functions Course (A)   

7.2.1 Outline of the Course 

The Power Function course consisted of eight modules, listed in the Table 3 below 

presenting the content for which GG and GG worksheets have been involved and 

which of the types of exam tasks (𝑇𝐸𝑃1
-𝑇𝐸𝑃6

) that can be put in relation to the modules. 

Module 

no. 

Content in relation to GG/GG worksheets 

 

Relation to exam 

tasks 

1 - The impact of the constants a and b on the look of the 

graph of a power function 𝑓(𝑥) = 𝑏 · 𝑥𝑎; Exercises 

related to GG (see A.7 Module 1) 

No direct relation to 

𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

 

2 - 𝑇ℎ𝑚𝑎𝑏; Worksheet 1 with click proof offering hints and 

right answers (see Figure 70) 

Some relation to 𝑇𝐸𝑃4
 

 

3 - Calculation of a and b knowing two points on the graph 

of 𝑦 =  𝑏 · 𝑥𝑎; Worksheet 2 with exercises with hints 

and right answers (see A.7 Module 3) 

- Regression/modelling exercises from the exercise 

book (Clausen et al., 2013a) (see A.7 Module 3) 

𝑇𝐸𝑃4
 

 

 

𝑇𝐸𝑃1
, 𝑇𝐸𝑃2

, 𝑇𝐸𝑃3
 and 

especially 𝑇𝐸𝑃5
 

4 - Review (in plenary) of the techniques used in GG for 

answering the regression/modelling exercises from 

Module 3; Sherpa-like situation 

- Power growth and the (%/%) property; Worksheet 3 

with graph of power function and sliders (see Figure 71) 

𝑇𝐸𝑃1
, 𝑇𝐸𝑃2

, 𝑇𝐸𝑃3
 and 

especially 𝑇𝐸𝑃5
 

 

Some relation to 𝑇𝐸𝑃3
 

5 The (·/·) covariation of variables in power growth 

𝑓(𝑥) = 𝑏 · 𝑥𝑎; GG-document made by TP working as a 

worksheet (see A.7 Module 5) 

Some relation to 𝑇𝐸𝑃3
 

 

6 Proportionality (direct and inverse); Worksheets 4-7; 

Student work with Worksheet 7 (see Figure 72) with 

exercises offering access to right answers and graphical 

representation (see A.7 Module 6 for Worksheets 4-6) 

𝑇𝐸𝑃6
 

 

7 - Proportionality (direct and inverse) continued; 

Worksheet 7 (see Figure 72) 

- Distinguishing linear, exponential and power 

functions; Worksheet 8 with multiple choice exercises 

related to graphic representations (see A.7 Module 7) 

𝑇𝐸𝑃6
 

 

 

No direct relation to 

𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

 

8 - Distinguishing linear, exponential and power functions 

continued → Worksheet 8 

- Take-home group assignment (see A.8 Module 8) 

No direct relation to 

𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

 

𝑇𝐸𝑃1
, 𝑇𝐸𝑃2

, 𝑇𝐸𝑃3
 and 𝑇𝐸𝑃5

 

Table 3 Overview of the content related to GG and GG worksheets in the eight modules of the course and its 

relation to the exam tasks 𝑻𝑬𝑷𝟏
- 𝑻𝑬𝑷𝟔

. 
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It is noted that GG or GG worksheets have been involved throughout all eight modules 

and used for many of the conclusions of the theme - from the impact of the values of a 

and b on the look of the graph to distinguishing the power function from linear and 

exponential functions (as Table 3 indicates). Furthermore, it should be noted that TP 

set up more sessions related to GG worksheets than sessions related to performing 

techniques in GG itself in this course. GG itself was primarily prioritised in module 1 

in connection with the impact of the values of a and b on the look of the graph and in 

the modules concerning power regression/modelling (Module 3 and 4). For 

answering RQ1-RQ3, it is the teacher and student work in relation to GG itself which is 

of special interest why these sessions will be reviewed as a first. The GG worksheets 

are, even though they do not necessarily call for performing techniques in GG, an 

interesting aspect as to how TP has organised the course in relation to GG why the 

implementation of these will also be reviewed. Further, the take-home group 

assignment and its relation to GG-use will be analysed. Finally, a sketch of the 

teacher’s orchestrations respectively the student work in relation to GG will be made. 

When referring to the modules in this analysis, Table 3 may work as to provide both 

further details on the GG work as well as an overview of the course.  

7.2.2 Teacher and Student Work in Relation to GG Itself 

In Module 1, TP gave the students a sheet of exercises with some relation to GG (see 

A.7) just after having introduced the definition of a power function on the blackboard 

with an emphasis on both 𝑥 > 0 and 𝑏 > 0, followed by a brief review of the concepts 

of domain, range, conditions of monotony and asymptotes. The main technique 

instructed by TP to be carried out in GG (via these exercises) is the following, which is 

seen to be an extension of 𝜏𝑆𝑙𝑖𝑑𝑒𝑟𝑠 𝑎𝑏,𝐴𝑃,𝑃𝑅
𝑖 : 

𝝉𝑺𝒍𝒊𝒅𝒆𝒓𝒔 𝒂𝒃,𝑨𝑷,𝑻𝑷
𝒊 : Type “f(x)=b*x^a,x>0” in the Input Bar [→ Press Enter] → 

   Click “Create Sliders” in the “Create Slider(s)” view popping 

   up on the screen → Drag in “f(x)” from the Algebra View to 

   the Graphics View → Right click on the slider for b and 

   choose “Object Properties” → Set the interval of b (in this 

   specific case to min: 0.01 and max: 10). 
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The gesture marked by [ ] is not instructed but necessary. The outcome of 

𝝉𝑺𝒍𝒊𝒅𝒆𝒓𝒔 𝒂𝒃,𝑨𝑷,𝑻𝑷
𝒊  is noticeably both the graphic (in the Graphics View) and the algebraic 

representation (in both the Algebra and Graphics View) of a power function with 

domain 𝑥 > 0 where 𝑎 can attain the values [−5, 5] (see subsection on The Algebra 

Perspective in section 4.3.3) and b; the values [0.01, 10]. The typing of “x>0” in this 

technique may lead to a further awareness of the domain of a power function being 

ℝ+. The fact that the functional equation can be seen in the Graphics View next to the 

graph via 𝝉𝑺𝒍𝒊𝒅𝒆𝒓𝒔 𝒂𝒃,𝑨𝑷,𝑻𝑷
𝒊  makes it unnecessary to move one’s gaze from the Graphics 

to the Algebra View in order to see that the functional equation changes 

simultaneously with the look of the graph when dragging the sliders for a and/or b. 

Thereafter, a description of what happens when the value of a is changed is required 

as well as a determination of the intervals for a where the look of the graph changes 

significantly. Here, it seems that the praxis of dragging a slider (for a) in GG is sought 

to lead to some explanation for the look of the graph in terms of which intervals of a 

leads to different graphical representations. Next, the technique of plotting a specific 

point on the graph on the graph of f(x), namely “P(1,f(1))” is instructed;  

𝝉𝑷𝒍𝒐𝒕 𝒑𝒐𝒊𝒏𝒕,𝑨𝑷,𝑻𝑷
𝒊 :  Type “P=(1,f(1))” in the Input Bar [→ Press Enter]. 

The gesture marked by [ ] is not instructed but necessary. In prolongation of this, it is 

asked what happens to the point, P, when the value of b is changed. It is further asked 

which relation there is between the coordinates of P and the value of b. Finally, a 

proof of this relation is requested through use of paper (i.e. not GG) with a hint of 

putting “x=1” into the functional equation “f(x)=b*x^a”. Here, it seems that the praxis 

of dragging a slider (for b) in GG is sought to motivate a description of the relation 

between P and b analytically. Especially, the proof of the relation between P and b can 

provide some explanation to the praxis, i.e. an establishment of a knowledge block. 

Further, an exercise of determining a and b values related to five given graphical 

representations of power functions (in a figure very similar to Figure 25, besides 

from the given domains for a), by using the sliders in GG, is given. A table is set up as 

answer field for the a and b values. Hereby, the praxis of dragging sliders (for both a 

and b) are put in relation to determining values of these constants for specific 

graphical representations - and thereby, it may work as a praxis leading to explaining 
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the specific looks of the graphs. Finally, an exercise of concluding on the domain, 

range, conditions of monotony and asymptotes for the five given types of power 

functions, with none instructed GG-work, is given. This exercise may lead to adding 

some further explanation to the look of the graph of a power function. There is a 

general priority traceable in these exercises; namely that of putting algebra in 

relation to the graphical representation of a power function and using the sliders of 

GG to realise what applies for the values of a and b in relation to the look of the graph. 

The last half of the module was spent on these exercises where the students worked 

in groups of two or three, made by TP, and TP circulated and guided the students 

individually when needed. Regarding the praxeologies of the students performed in 

relation to the exercises, 𝜏𝑆𝑙𝑖𝑑𝑒𝑟𝑠 𝑎𝑏,𝐴𝑃,𝑇𝑃
𝑖  could be a challenge for some of the students 

- at least for one of the PSs (PS1) (and partner (AS1)) for whom the input became 

“f(x)=b*xâ,x>0” instead of “f(x)=b*x^a,x>0” leading to a whole other output than the 

graph of a power function with sliders for b and a - namely that of a constant function 

with sliders for b and xâ (see A.8 Module 1 for the outcome). Subsequently, these two 

students did not have a proper base for answering the following questions since they 

trusted the output on PS1’s computer instead of the (right) output on AS1’s computer 

(who closed the lid and put it aside) and they continued doing the exercises on PS1’s 

computer without AS1 getting to perform any of the gestures related to the exercises 

in GG him-/herself. For instance, PS1 got the possibility of realising the typing of 

decimal numbers using dots rather than commas, when setting the interval for b, as 

well as spontaneously realising the difference between typing a lower- and uppercase 

letter “p” when trying to plot the point 𝑃 = (1, 𝑓(1)) - which in the first case leads to 

the vector65 as an output and in the second case; a point. Even though PS1 verbalised 

the problem in plotting the point to both AS1 and neighbours, AS1 did not get to 

perform the praxis of typing the input necessary for getting a point (and not a vector). 

Especially, the gestures of dragging the sliders of a and b were only performed by PS1 

while AS1 merely observed. At one point, they found out that the graphic 

representations looked different on some other student’s computer and then asked 

                                                        

65 The students have not yet been introduced to vectors at this level of high school. 
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TP for help. TP immediately announced that there had been a problem in typing the 

power and related it to Mac computers and called out to ask if anyone knew how to 

type the input on a Mac. Then another student announced that one should enter 

‘space’ after the ‘^’-sign whereby a first level orchestration took place. PS1 and AS1 

then started from the top in order to get the output right on PS1’s computer. They did 

not determine the intervals for a, for which the graph has different looks, in detail. PS1 

wrote however: ...increases and decreases when ‘a’ changes from being positive to 

negative and vice versa... (A.8 Module 1; Front page of PS1’s notes) about the graph, so 

something was deduced from dragging the sliders. For the proof of the relation 

between the point P and b, PS1 asked TP for help. Here, TP made an effort as to 

motivate PS1 into “calculating” by use of symbols instead of PS1 using the specific set 

value of b on the slider on PS1’s screen. This seemed challenging to PS1 who, to begin 

with, had written down the functional equation with the specific values of both b and 

a read directly from the sliders. PS1 did however succeed in writing down the relation 

analytically in prolongation of having asked TP for help - without any explanations 

made though (see A.8 Module 1; Back page of PS1’s notes). When reaching the 

exercise of determining a and b values using sliders in GG, PS1 initially only dragged 

the slider for a and let b be equal to a random set value (7.81) for the first couple of 

functions (see A.8 Module 1; Front page of PS1’s notes). For the next three functions, 

PS1 began to drag the slider for b as well but did not seem to understand the precise 

impact of b on the look of the graph since the only correct answer for b was given 

when PS1 heard it from a neighbour and was thereby not reached in dialogue with AS1 

(for k(x) representing 0 < 𝑎 < 1; see A.8 Module 1; Front page of PS1’s notes). PS1’s 

answers for a were however made in dialogue with AS1. These seem solely to have 

been made based on how the graph looks or curves (and not on the specific points 

lying on the graph) and the answered values were noticeably within the right 

domains of a (see A.8 Module 1; Front page of PS1’s notes). For another PS (PS2)66 and 

partner (AS2), their answers for this exercise were much more precise, especially 

with respect to the b-values, demonstrating a more successful outcome of the praxis 

                                                        

66 Screen recordings of PS2’s work was not successfully made - only field and handwritten student 

notes. 
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of dragging the sliders for both a and b in order to determine their values for specific 

functions based on their graphical representations (see A.8 Module 1; PS2’s notes and 

AS2’s notes). The answers for the subsequent tasks made by PS1 in dialogue with AS1 

reveal that it was challenging for PS1 to conclude on both domain, conditions of 

monotony and asymptotes in relation to the given graphical representations of the 

five functions - not least to specify the answers to be related to one or more of the 

functions. For PS2, it was however possible to conclude on all these terms more 

correctly if one assumes that the answers given are related to the function 

representing 𝑎 < 0 (i.e. 𝑓(𝑥)) which is not made explicit - since, in that case, it is only 

the answer of the y-axis being an asymptote which lacks. AS2 wrote down the 

conclusions underneath the columns representing each of the functions in the table of 

the previous exercise - demonstrating an awareness of the answers not necessarily 

being the same for each of the functions. AS2’s answers concerning asymptotes were 

the shakiest ones but apart from this, the answers were quite precise. It seems that it 

was the easiest to conclude on the range for these PSs and ASs. However, none of the 

students were able to realise that the range of the constant function (𝑚(𝑥)) was only 

the number 2. 

TP used the blackboard for the recap of these exercises, in the beginning of the 

subsequent module (2), to draw graphical representations for power functions as a 

reaction on the students’ input on how the graph looks when 𝑎 > 1, 𝑎 = 1, 0 < 𝑎 < 1, 

𝑎 = 0, and 𝑎 < 0. Further, a student got to present the proof of the relation between b 

and P on the blackboard where TP asked for explanations for the techniques, being a 

bit challenging for the student. Finally, TP and the students had a dialogue on the last 

tasks where TP used the drawn graph types (on the blackboard), related to the 

domains of a, as reference point. TP did not at any time in this recap refer to the use 

of sliders for a and b in GG and there was made no further recap on whether the 

students had understood how to perform the instructed gestures and techniques in 

GG of the exercises or if there had occurred any other realisations in connection 

thereto. 

For the modules (3 and 4) concerning regression/modelling of power functions, TP 

used the projector presenting the view of TP’s computer screen, to introduce in 
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plenum how to perform power regression in GG in relation to a specific example67 

where TP controlled the keyboard and mouse; i.e. a second level orchestration. The 

technique instructed here was 𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖 . TP subsequently had a brief dialogue with 

the students on the 𝑟2 value of a regression and what it expresses when a student 

mentioned it68. TP did however not introduce explicitly how to find the 𝑟2 value in 

GG. The students were then instructed to do some exercises in the exercise book (see 

A.7 Module 3) each involving a task of the type 𝑇𝐸𝑃5
 where 𝜏5.2,𝑆𝑉,𝑃𝑅

𝑖  is applicable. 

These exercises furthermore consisted of tasks of the types 𝑇𝐸𝑃1
, 𝑇𝐸𝑃2

 and 𝑇𝐸𝑃3
 as well 

as a singular task of plotting a given data set along with the graph of the functional 

equation derived through power regression of the data - for which no instructions 

related to GG has been made by TP. The tasks concerning regression were hereby all 

of type 𝑇𝐸𝑃5
, asking for power regression and not an assessment of the regression, 

which may explain TP’s choice of not prioritising the finding of the 𝑟2 value in the 

plenum dialogue. None of these tasks explicitly call for explanations, and thereby an 

involvement of a knowledge block, but are very technique minded, as also noted in 

section 4.2.2.  

For these exercises, TP circulated and answered questions, if any, while the students 

worked together with their neighbours. The observed student work was, possibly as a 

consequence of the formulations of the tasks, very technique oriented. For all of the 

PSs, the technique 𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖  seemed quite straightforward for them to perform for the 

tasks of type 𝑇𝐸𝑃5
. Noticeably, all of the four PSs (PS3-PS6) consciously chose to use 

dots instead of commas for decimal numbers in GG when typing the data. All of the 

PSs furthermore found and used the “Copy to Graphics View” icon in the “Data 

Analysis” View. To be noted, the PSs did however not make an effort as to explain the 

outcome of 𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖  which may cause a black box of GG in relation hereto, not 

knowing what power regression actually means only how to perform it. 

                                                        

67 Concerning the relation between diameter and length of a specific bone of African antelopes 

(Clausen, Schomacker, & Tolnø, 2013a, pp. 61–62). 

68 The students have noticeably already been introduced to regression and the 𝑟2 value for assessing 

data to be fitted for an exponential function earlier during this year of high school. 
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In order to solve the tasks of type 𝑇𝐸𝑃1
 and 𝑇𝐸𝑃2

, two of the PSs (PS5 and PS6) (working 

together) spontaneously performed 𝜏1,𝑆𝑉,𝑃𝑅
𝑖 , respectively a technique of entering 

different x-values in the box for this value in the “Data Analysis” View (see Figure 68) 

followed by clicking Enter, in order to approach the given y-value in the task of type 

𝑇𝐸𝑃2
 until they found themselves sufficiently close to the given y-value whereby the 

entered x-value was their answer - this technique will henceforth be denoted 𝝉𝟐,𝑺𝑽,𝑷𝑺
𝒊 . 

The techniques 𝜏1,𝑆𝑉,𝑃𝑅
𝑖  and 𝜏2,𝑆𝑉,𝑃𝑆

𝑖  are noted to be neither analytic nor graphic 

whereby there is a significant risk of a black box effect here, in the sense that the 

students neither know how nor why to solve tasks of the types 𝑇𝐸𝑃1
 and 𝑇𝐸𝑃2

. When 

trying to solve a task of type 𝑇𝐸𝑃2
 analytically, these two PSs noticeably came to a 

standstill when wanting to isolate x in the power function equation. The one of them 

(PS5) tried to use the logarithm for this, instead of root extraction (see A.8 Module 3). 

Root extraction had noticeably not yet been presented by TP as an analytic gesture 

for solving power equations with respect to the base of the power at this point of the 

course. PS3 (neighbour to PS4 who had AS4 as partner) as well as PS4 developed for 

these exercises, without instructions from TP, other instrumented techniques for 

solving tasks of type 𝑇𝐸𝑃1
 and 𝑇𝐸𝑃2

 in GG. These were graphic techniques performed 

within the Algebra Perspective, after having copied the function, derived through 

𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖 , to the Graphics View. Since they are very similar, the one used for the tasks 

of type 𝑇𝐸𝑃1
 is only presented here: 

𝝉𝟏,𝑨𝑷,𝑷𝑺
𝒊 :  Click on the icon  in the Graphics View Style Bar to add a grid to the 

  Graphics View → Click on the Point Tool  → Find via the grid the point 

  of the graph of f where 𝑥 = 𝑥0 (approximately) and click on this spot of 

  the graph to create a point (A) → Check if the first coordinate of A is 

  equal to 𝑥0 in the Algebra View (if not; adjust the point in the Graphics 

  View by dragging it) → Read off the second coordinate of the point from 

  the Algebra View. 

See A.8 (Module 3) for 𝜏2,𝐴𝑃,𝑃𝑆
𝑖  (developed by PS3 for tasks of type 𝑇𝐸𝑃2

) as well as 

screenshots of the outcomes of 𝜏1,𝐴𝑃,𝑃𝑆
𝑖  and 𝜏2,𝐴𝑃,𝑃𝑆

𝑖 . Noticeably, these techniques do 

not necessarily lead to a precise answer for the tasks of type 𝑇𝐸𝑃1
 and 𝑇𝐸𝑃2

 

https://www.geogebra.org/manual/en/Point_Tool
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(respectively). The placement of the point may namely be a bit imprecise since it can 

be difficult to drag the point on the graph such that it precisely has a specific first or 

second coordinate when using the Point Tool. The task of type 𝑇𝐸𝑃3
 was only reached 

by PS3 (as well as PS4 and AS4) among the PSs of this session. Here the following 

technique (𝜏3,𝐴𝑃,𝑃𝑆
𝑖 ) was developed spontaneously by PS3 (in dialogue with PS4 and 

AS4) within the Algebra Perspective and by use of a calculator outside GG. PS3 did 

however not succeed in performing the last set of (analytic) gestures necessary for 

solving the task fully (not necessarily instrumented) before the session ended. 

𝝉𝟑,𝑨𝑷,𝑷𝑺
𝒊 : Having a specific point (𝑥0, 𝑦0) plotted on the graph of 𝑓(𝑥) in the 

  Graphics View, calculate “𝑥0/100 ∙ (100·r) + 𝑥0” (denoted 𝑥1 here) on a 

  calculator, where (100 · 𝑟) is a given value → Zoom in on the 

  x-axis of the Graphics View to find the value 𝑥1 → Click on the 

  Perpendicular Line Tool  → Click on the x-axis at 𝑥1 [→ Use the Move 

  Graphics View Tool  to zoom out and drag the Graphics View in order 

  to see the intersection between the line 𝑥 = 𝑥1 and the graph of 𝑓] → 

  Click on the Point Tool  → Click on both the graph of the function f and 

  the line 𝑥 = 𝑥1 in the Graphics View to create the intersection point (A) 

  → Read off the second coordinate (𝑦1) of A from the Algebra View → 

  Determine the percentage increase from 𝑦0 to 𝑦1 (unfinished gesture). 

The gestures marked by [ ] are only performed to an extent making it possible to see 

the intersection point in the Graphics View (see A.8 Module 3 for a screenshot 

outcome of 𝜏3,𝐴𝑃,𝑃𝑆
𝑖 ). PS3 was not sure how to determine the percentage increase from 

𝑦0 to 𝑦1 analytically. AS4 had the bid of 32 %, but when PS3 tried to write down the 

required technique in Word in dialogue with AS4, s/he only managed to write down a 

calculation checking if AS4’s bid was right and not to write down a calculation leading 

to 32 % as a result (see A.8 Module 3 for PS3’s notes in Word). There are noticeably 

many similarities between 𝜏3,𝐴𝑃,𝑃𝑆
𝑖  and 𝜏3,𝐴𝑃,𝑃𝑅

𝑖 . Actually, the last set of gestures of 

𝜏3,𝐴𝑃,𝑃𝑅
𝑖  can be applied as the “unfinished gesture” of 𝜏3,𝐴𝑃,𝑃𝑆

𝑖 .  

An endnote for this session is that AS4 did not perform any gestures or instrumented 

https://www.geogebra.org/manual/en/Point_Tool
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techniques in GG but merely assisted and observed PS4’s work on PS4’s computer, 

using a hand-held calculator. 

Now, the only recap, related to GG organised as a 

second level orchestration by TP of the course, was 

performed in the subsequent module (4) and 

concerned the techniques applied for solving the 

above mentioned exercises of the exercise book. 

The recap was orchestrated by TP in a way that can 

be associated to the sherpa-student situation 

presented earlier (section 2.1.3) since TP let some 

of the students present their techniques for the 

tasks of the types 𝑇𝐸𝑃5
, 𝑇𝐸𝑃1

 and 𝑇𝐸𝑃2
. The chosen 

student namely got to use the keyboard and mouse 

connected to the computer of TP, the screen of 

which was projected for the whole class to see, 

whereby it was possible both to share techniques in 

relation to the given tasks and to get TP’s guidance 

or approval of these. TP asked the chosen student to 

put into words how s/he performed the gestures in 

GG. This may have given the other students and TP a better chance for keeping up 

with the performed technique. Figure 79 illustrates the situation. 

One student presented how s/he had solved the first task (of type 𝑇𝐸𝑃5
) in the 

exercises through 𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖  in GG and put into words which gestures s/he performed 

leading to a correct outcome. This may have worked as a repetition, of the second 

level orchestration on this technique made by TP in the previous module, for the 

other students. Later in the session, TP however encouraged a student to use another 

program than GG, named WordMat69, for solving a task of type 𝑇𝐸𝑃5
. TP did hereby not 

propose GG to be a mandatory CAS tool for solving tasks of type 𝑇𝐸𝑃5
. When another 

                                                        

69 WordMat is an add-on to (Microsoft) Word and can be downloaded via this link: 

http://www.eduap.com/wordmat/ (last visited 29.07.2016). 

Figure 79 The situation where one (red) 

student at a time (not necessarily 

everyone) gets to share his/her 

techniques in relation to a task 

concerning regression/modelling of a 

power function. The teacher is in a 

dialogue with the students - and 

especially the chosen student - on what is 

happening on the view screen. 
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student at some point got to present how s/he had solved a task of type 𝑇𝐸𝑃1
, s/he 

presented the graphic technique 𝜏1,𝐴𝑃,𝑃𝑅 
𝑖  which had not been presented before by 

either TP or another student in plenum (i.e. it was a spontaneously developed 

technique). Noticeably, 𝜏1,𝐴𝑃,𝑃𝑅 
𝑖  for certain gives a precise answer for the task of type 

𝑇𝐸𝑃1
 as opposed to 𝜏1,𝐴𝑃,𝑃𝑆

𝑖  performed by PS3 in module 3. To be noted, 𝜏1,𝐴𝑃,𝑃𝑅
𝑖  was 

not immediately the technique intended by TP who did not seem to have thought of 

the possibility of performing this set of gestures in GG to solve a task of type 𝑇𝐸𝑃1
. TP 

namely ended this part of the session by noting that one could also have put the given 

𝑥 = 𝑥0 into the functional equation and calculated this, but acknowledged that 

𝜏1,𝐴𝑃,𝑃𝑅 
𝑖  works as well. Hence, it seems here that TP has expected a technique of more 

analytic character - where the techniques 𝜏1.1,𝐶𝑉,𝑃𝑅
𝑖  or 𝜏1.2,𝐶𝑉,𝑃𝑅

𝑖  for instance are 

applicable in GG.  

The CAS View of GG is however used by a third student, when presenting how to solve 

a task of type 𝑇𝐸𝑃2
. Here, the technique was close to be of the type 𝜏2.1,𝐶𝑉,𝑃𝑅

𝑖 , only with 

the use of the Solve Tool instead of the Solve Numerically Tool. The output was not as 

expected and can be related to the output presented in Figure 63. When neither TP 

nor the students were able to see what has gone wrong in the performed technique, 

they agreed on the chosen student to perform the technique 𝜏2,𝐴𝑃,𝑃𝑅
𝑖  (developed here 

in plenum) instead. This choice seems to be a reaction to the just presented 𝜏1,𝐴𝑃,𝑃𝑅
𝑖 . 

The CAS View was noticeably not used henceforth in this session for performing 

(symbolic) calculations.  

At some point, TP became the one to control mouse and keyboard for some of the 

exercises with input from the students, starting with the exercise of plotting a specific 

data set along with the graph of the power function derived through regression. The 

regression was here performed in WordMat instead of GG. TP noted however 

thereafter that it is better to use GG than WordMat for plotting the graph and opened 

GG again. To be noted, TP verbalised here, among other, that one has to use dots 

instead of commas when typing decimal numbers in GG; a first level orchestration, 

confirming what some of the students may already had concluded (at least the PS3-

PS6). Within this part of the session, TP further asked how to solve another task of the 

type 𝑇𝐸𝑃1
. A student suggested here to put the given value of x into the functional 
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equation and calculate it but TP then proposed and tried to perform the graphic 

technique 𝜏1,𝐴𝑃,𝑃𝑅
𝑖  instead, in dialogue with the students. Noticeably, TP hereby 

learned to perform the technique in GG simultaneously with introducing it to the 

students as a repetition of the presentation made by the first mentioned student 

earlier in the session. When TP here at some point got stuck in getting an intersection 

point as outcome, a student noted that TP had made the point invisible and TP then 

found out how to make the point visible in order to answer the task. TP did however 

not verbalise this gesture.  

The only task of type 𝑇𝐸𝑃3
 was, in the end of this recap, noticeably not solved in GG but 

through an analytic technique proposed by a student, where TP performed it on the 

blackboard with input from the student, who had calculated the results on a hand-

held calculator. Spontaneously developed techniques in relation GG for this task, like 

𝜏3,𝐴𝑃,𝑃𝑆
𝑖 , was hereby not shared.  

It should be noted that in general, the CAS View of GG was not used by any of the PSs 

of this observation study, why it is only the cases where it was presented on the 

projector, orchestrated by TP, which work as data on how this aspect of GG was 

approached. The only other situation of the course, where this was the case, was in 

module 5, where TP actually made an attempt as to introduce some instrumented 

techniques in the CAS View of GG for solving equations (a second level orchestration). 

This took place as the first thing immediately after a break, where the students had 

worked with a GG document (see A.7 Module 5) concerning the covariation property, 

(·/·), of power functions before the break. TP introduced here briefly, through a 

couple of examples (2𝑥 = 4 and 3𝑥 + 3 = 5), the gestures of clicking either  or  

in the CAS View Toolbar and the difference of the output gained through these two 

gestures. After this orchestration, TP said that it was time for proving the property  

(·/·) and used the blackboard with input from the students. Further, analytic 

techniques, for some specific examples of tasks (of type 𝑇𝐸𝑃3
 and the opposite to 𝑇𝐸𝑃3

; 

asking for the percentage change of 𝑥 given the percentage change of 𝑓(𝑥)) where the 

(·/·) property is applicable, were performed by TP on the blackboard with input from 

the students. Here, the students got the possibility of calculating the results using 

calculators. TP did however not propose GG’s CAS View as calculator and the majority 

https://www.geogebra.org/manual/en/Evaluate_Tool
https://www.geogebra.org/manual/en/Numeric_Tool
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of the students were observed to use handheld calculators here (it was difficult to see 

all computer screens of the students though). The above mentioned GG-document, 

concerning the (·/·) property, was made by TP and noticeably it functioned more as a 

worksheet with an exercise of realising the (·/·) property analytically rather than an 

exercise of performing instrumented techniques in GG. This, since calculations were 

made for the user within cells of the Spreadsheet View - of k*x, f(k*x), f(x), f(k*x)/f(x) 

and k^a - when typing in specific values for x, a, b and k.  

As an endnote for this review, tasks of or close to being of the types 𝑇𝐸𝑃4
 and 𝑇𝐸𝑃6

 are 

not at any point in the course solved in GG itself by neither TP nor the PSs and tasks of 

type 𝑇𝐸𝑃3
; only to the extent achieved by PS3, PS4 and AS4. 

7.2.3 Teacher and Student Work in Relation to GG Worksheets 

The GG worksheets chosen by TP70 will here be reviewed for their involvement in 

connection with a significant part of the content of the theme - they are denoted 

Worksheet 1-8 (see Table 3). 

Worksheet 1 of module 2 concerns a click proof of 𝑇ℎ𝑚𝑎𝑏 and is an interesting 

example of a GG worksheet with an exercise in which a focus is put on relating 

knowledge and praxis (also presented in Figure 70). TP put an emphasis (verbally) on 

the fact that the students should try for themselves (in groups of two) before clicking 

for hints, and that the clicking for right answers should only take place if all progress 

in performing the exercises stalled. The PSs did however not manage to perform the 

steps of the proof without clicking their way through it and they seemed in general 

very impatient in their approach to the exercise - whenever it was the least 

challenging, they or a partner clicked for a hint and/or a right answer. Further, their 

answers did not include any explanations and noticeably, the application of a law of 

exponents (𝐿5) in section 4.2.1) as well as a logarithmic rule (denoted b) in section 

4.2.1) were not performed without clicking for hints and right answers (see A.8 

Module 2 for notes of PS7 (Word) and PS8 (handwritten)). PS7 and AS7 actually asked 

TP for help in connection with the logarithmic rule and TP then suggested that they 

                                                        

70 The GG worksheets are not developed by TP but selected from (Webpage: GG-worksheets, 2016). 
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should click for a hint and try to apply it after which TP left (seemingly a bit busy in 

circulating from group to group). But when the hint was not quite enough, for them to 

understand how to perform the step, they rapidly clicked for a right answer (on AS7’s 

PC) while PS7 wrote down the techniques in Word. The recap of this worksheet was 

made by TP in the subsequent module (3) where different students were asked to 

perform the steps of the proof on the blackboard after having had a couple of minutes 

to reconsider the steps of the proof. In those minutes, some of the PSs had a tendency 

to mark off both hints and right answers in the worksheet impatiently and maybe a 

bit frantic. TP put, in the recap by the blackboard, a lot of focus on why the techniques 

could be performed asking for explanations of the student by the blackboard. 

Moreover, TP tried to defuse and guide the praxis of performing these techniques 

whenever the student by the blackboard became confused, letting the student try and 

explain for him-/herself why it was okay to perform the technique. 

Worksheet 2 was introduced immediately after, in order for the students to use the 

formulas of 𝑇ℎ𝑚𝑎𝑏 for calculating several exercises with tasks strongly related to 𝑇𝐸𝑃4
 

(see A.7 Module 3). Here, TP introduced (using projector) the options of getting the 

answers confirmed, when they turned green, as well as the options of clicking for help 

in some boxes (providing right answers for the techniques to be performed). TP 

ended this introduction by reminding the students to use the formulas which they 

had just learned and finally noted that a and b were to be calculated by hand or some 

place on the computer. TP did hereby not propose GG as calculator. The PSs either 

used a handheld calculator or a basic calculator on their phone or computer for these 

exercises which however seemed challenging for some of them to use. One of the PSs 

(PS9) did not perform the calculations him-/herself but worked together with two 

neighbours where only one of them (AS9) performed the calculations. The option of 

getting hints was used more in the beginning than in the end of this session by PS9, 

whereas PS10 and PS11 (being neighbours) did not click for hints but tried to perform 

the techniques on paper (see PS10’s notes in A.8 Module 3). 

The Worksheet 3 of module 4 involves sliders and concerns the (%/%) property (see 

Figure 71). It was introduced by TP on the projector in plenum where TP presented 

the sliders of a, b and the percentage change (not explicitly noted to be of x-values), 
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through dragging the sliders and asking the class: What do the percent numbers mean? 

Here, a student answered that the x-value increases by a specific percent. Then TP 

asked for the meaning of the other percent value of the worksheet, and another 

student answered, that it tells by how much y increases, confirmed by TP. To some 

extent, this may be considered as both a first and second level orchestration when 

considering the dragging of sliders a gesture respectively a technique. The students 

worked together with their neighbours (approx. two and two) and TP circulated and 

guided the students in answering the tasks when needed. Here, the PSs dragged the 

sliders in order to answer the tasks of the exercise - they did this orally and some of 

them tried to explain their answers to each other by dragging the sliders to 

demonstrate what happens. Besides from the possibility of exploring the (%/%) 

property dynamically in a graphics view, the students here got the opportunity to 

reconsider the meaning of a for the look of the graph through the last task - which 

they did successfully. One PS (PS12) and partner (AS12) even spontaneously 

investigated the meaning of b through dragging this slider when having gone through 

all four tasks of the exercise - confirming AS12’s suggestion that it is the y-value for x 

equal to 1 (having forgotten it from module 1). Noticeably, only PS12, and not AS12, 

dragged the sliders in this worksheet. AS12 did not work by a computer but assisted 

and observed PS12’s praxis. PS12 and AS12 (as well as PS13; neighbour to PS12) were a 

bit unsure why it is called “percent-percent” growth (the first question of the 

worksheet) and asked TP. TP answered by asking for which type of growth is an 

exponential growth followed up by asking for by what y increases when x increases 

by a fixed number (i.e. referring to the covariation (+/·) of the variables). Thereafter, 

TP asked them to describe linear growth in a similar way, before asking them to 

describe power growth (referring to the (%/%) property). It was mainly a 

conversation between TP and PS13 after which PS13 told AS12 and PS12 how it should 

be understood. Hereby, an establishment of a knowledge block was sought through 

the first question of the worksheet. 

The recap of Worksheet 3 was immediately performed by the blackboard by TP 

without any recap on the praxis of dragging the sliders to be performed in relation to 

solve the tasks. TP put instead a great emphasis on the difference between linear, 

exponential and power functions in relation to the covariation of the variables. In 
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prolongation of this recap, TP however wrote the theorem on the (·/·) property of 

power growth. Then TP asked the students for the factor by which x is multiplied 

when it increases by a given percent (50 %), presented on the projector in Worksheet 

3. In dialogue with the students, TP here deduced that y is multiplied by 1.50𝑎  where 

a was read directly from Worksheet 3 (on projector showing TP’s computer screen). 

Then the students got to calculate the increase of y (where the majority used 

handheld calculators) and TP and the students reached an agreement that this 

increase agrees with what the percentage increase is given to be in the worksheet (on 

the projector). Hereby, TP proposed the use of Worksheet 3 to confirm the 

calculations made through analytic techniques on the (·/·)/(%/%) property - which 

seems to be an attempt of combining graphic and algebraic representations, 

confirming the (·/·)/(%/%) property of power growth.  

For introducing (direct and inverse) proportionality, TP for the first and only time of 

the course used (several) GG worksheets (Worksheet 4-7) presented on projector to 

introduce both technological-theoretical elements, examples and the graphic 

representation of inverse proportionality in dialogue with the students, instead of 

using the blackboard as usual. TP however summed up on the introduction by writing 

up equations for direct and inverse proportionality on the blackboard. Thereafter, 

Worksheet 7 (presented in Figure 72) providing exercises with strong relation to 𝑇𝐸𝑃6
 

(and the like; concerning direct proportionality instead) was introduced to the 

students on projector by TP, through asking the students for how to solve the given 

task. Further, TP marked off the boxes for right answers after receiving bids from the 

students in order to validate the bids. Before clicking on the “show graph” box, TP 

asked the students what they expected regarding its slope. Thereafter they went 

through a new task in the worksheet, concerning the other type of proportionality, 

before the students got to work with it the last few minutes of the module (6).  

They got to work with it again in module 7, after TP had made a recap in dialogue 

with the students, by the blackboard, on which type of functions inverse and direct 

relations are - reaching the conclusion of them being power functions.  

Thereafter some homework exercises in the exercise book (see A.7 Module 6, Opgave 

2080 and Opgave 2081) involving tasks of type 𝑇𝐸𝑃6
 (and the like) were reviewed in 
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plenum, before the students got to work with Worksheet 7 again. This, after TP had 

presented it briefly on the projector and shut it off again whereby the blackboard was 

visible presenting (among other notes) the formulas of direct and inverse 

proportionality (written earlier in the module). The students hereby got a significant 

amount of time to solve a bunch of the same types of tasks through the worksheet, 

working with neighbour(s). This actually lead to the PSs and their partners trying to 

put into words which (analytic) techniques in general worked for direct respectively 

inverse relationships in order to fill out the table. It was however very different to 

which extent, the PSs and their partners reflected on the look of the graph in the 

sense of trying to predict the look of the graph (before clicking for it) or even talk 

about the look of the graph (when having clicked for it).  

TP summed up by the blackboard by asking the students to tell how the graphs look 

like and relate it to the equations for direct respectively inverse proportionality 

where TP drew the graphs and wrote down the equations. It was easier for them to 

tell that direct proportionality is a linear function with a constant term equal to zero 

than describing the graph of inverse proportionality to be a hyperbola71 (verbalised 

by TP). In the end of this session, one student said that the latter looks like an 

exponential growth with the x- and y-axes as asymptotes. TP answered that it is not 

appropriate to describe it as an exponential growth, and after a break TP announced 

that the students have learned what they should on the theme of Power Functions. 

Hereafter, TP introduced Worksheet 8 (see A.7 Module 7) providing the option of 

seeing (and distinguishing) graphical representations of either linear, exponential or 

power functions in a random order (one at a time). Here, TP went through an 

example of the multiple choice exercises of the worksheet in dialogue with the 

students before letting them work with it. It was very different from PS to PS how 

patient they seemed to be when answering the exercises of this worksheet. Some of 

the PSs conversed with neighbours (PS14, AS14 and PS15) about the look of the graph 

before checking off an answer and put into words how the graphs look for different 

intervals of a. PS16 and partner (AS16) more rapidly went through the exercises, when 

                                                        

71 The notion of a hyperbola is noticeably not a part of C-B. 
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one of them had a bid on the answer, without talking much about why it was the 

answer in relation to the graph. It was easiest for PS16 to answer for linear functions 

and the most difficult to answer for power functions. Subsequently, the students got 

to play a homemade game (by TP) on the three elementary functions (see A.7 Module 

7), on their tables in groups of four where TP circulated.  

Worksheet 8 was used in the last module (8) as well, where TP started out by letting 

the students go through a lot of functions in the worksheet for around 10 minutes 

before recapping very briefly by asking how many of the students have got the three 

types of functions under control. Only some of the students lifted their hands. For the 

PSs of this session it was (still) the power function which was the most challenging of 

the three types of functions, especially when determining the domain of a. Noticeably, 

one of the PSs (PS17) got help from a neighbour (AS17) for distinguishing exponential 

and power function graphs, as AS17 noted that the graph of the power function was 

only in the one (pointing at the first quadrant) whereas the graph of an exponential 

was in the other as well (referring to the second quadrant). Hereby, AS17 had deduced 

something from the visualisation of the graphs of the different functions in order to 

distinguish the exponential from the power function. This, not necessarily with an 

awareness of the definition of the domains to be ℝ and ℝ+ respectively. Namely, it 

seemed that it was primarily the look of the graph and its placement in the coordinate 

system which was used as explanation for the answers made by the PSs in both 

sessions concerning Worksheet 8. 

7.2.4 Teacher and Student Work in Relation to the Take-Home Assignment 

TP ended the course by giving a take-home assignment (see A.7 Module 8) to the 

students to be handed in in groups of three-four students made by TP. The exercises 

of this assignment consisted of several exercises (the first four) concerning the 

algebraic representation of the power function where GG was not immediately called 

for to be applied but where a great focus was put on establishing a knowledge block 

through tasks of doing proofs and explanations. Thereafter, three exam related 

exercises were given, all of which consisted of tasks of type 𝑇𝐸𝑃5
. Further, tasks of type 

𝑇𝐸𝑃3
 (and the opposite of 𝑇𝐸𝑃3

), 𝑇𝐸𝑃1
 and 𝑇𝐸𝑃2

 were represented in some of the 

exercises.  
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From the group hand-ins it was not clear which (symbolic) calculator the students 

had chosen to use when calculating answers to the tasks of type 𝑇𝐸𝑃1
, 𝑇𝐸𝑃2

 and 𝑇𝐸𝑃3
. 

Several of the students noticeably chose to use the formulas for a and b from 𝑇ℎ𝑚𝑎𝑏 

to answer the tasks of type 𝑇𝐸𝑃5
, instead of performing the required regression on the 

data set. However, some of the students did regression and used GG successfully for 

this (seemingly 𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖 ) - a few even added the 𝑟2 value to their answers, without 

any explanation connected thereto though. The hand-ins were in general 

characterised by technical answers without explanations of why it is possible to 

perform the techniques and some did not even write down the gestures necessary for 

achieving the answers. Hereby the praxeologies clearly lacked involvement of the 

knowledge block and not all students demonstrated confidence within the praxis 

block either. 

Now, in prolongation of this review of the GG-related teacher and student work 

throughout the course, an outline of TP’s orchestrations as well as the students’ 

approach to GG-related work in terms of praxeologies will be made. 

7.2.5 The Teacher’s Orchestrations in Relation to GG 

In general, TP initiated GG-work in prolongation of having presented related 

technological-theoretical elements on the blackboard in dialogue with the students. 

The projector was often used by TP, either to introduce how to approach a GG-

document opened on TP’s computer, where gestures were executed in interaction 

with the students, or to present a GG worksheet and how to approach it - mainly first 

level orchestrations were made here, but also a few second level orchestrations. TP 

often instructed the students to work in groups of at least two persons when doing 

GG-related work and did not instruct them to work individually at any time. Nor were 

the students at any time explicitly instructed to work by a computer each. Under GG-

sessions, TP circulated and helped the students individually in approaching GG/GG 

worksheets and often asked them to put into words why and how they could perform 

the techniques. Here, first level orchestrations could occur where TP proposed a 

gesture or two, without solving the task at hand for them. The blackboard was used as 

a main presentation tool by TP when doing recaps on GG-work, sometimes supported 
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by projector presentations but not to the same extent as the introductions to GG-

work. In the recaps, TP often wrote on the blackboard which analytic techniques 

and/or answers, the students had or should have gained through the GG-work with 

an emphasis on explanations for the performed techniques as well as for the outcome 

in relation to the general properties of power functions, in dialogue with the students. 

TP did however not to the same extent sum up on the applicable instrumented 

techniques in GG for answering the exercises and did thereby not perform many 

second-level orchestrations. The especially prioritised instrumented techniques to be 

instructed and shared in the course, by TP, were the one for solving 

regression/modelling tasks of type 𝑇𝐸𝑃5
 as well as those for solving tasks of type 𝑇𝐸𝑃1

 

and 𝑇𝐸𝑃2
. The CAS View of GG was immediately proposed as an optional tool for 

(symbolic) calculations but TP did not prioritise it to be mandatory and did neither 

seem confident herein. 

As for TP’s choice of exercises within GG itself and within GG worksheets, it varied 

immensely to which extent, the exercises had a focus on praxis and knowledge - 

however always with a predominant focus on praxis. In general, the transition 

between the graphic and algebraic representation of a power function and its 

properties was often represented in these exercises. In several of the worksheets (2, 7 

and 8) it is possible to do several types of the same exercise through a click. These 

worksheets noticeably involve tasks of type 𝑇𝐸𝑃4
, 𝑇𝐸𝑃6

 (and the like) as well as the 

exercise of distinguishing the three function types linear, exponential and power 

functions. Regarding the dynamic aspect of using sliders in GG in order to realise 

specific properties of the power function, this is also represented in the GG related 

exercises - first, in relation to GG itself (in Module 1) and later, in relation to 

Worksheet 3. Hereby the praxis related to Worksheet 3 may work as a recap on the 

praxis related to GG in Module 1. Finally, there were several worksheets offering hints 

and right answers for the exercise of the worksheet (1, 2 and 7) which TP introduced 

only to be approached if one really did not manage to perform a gesture or technique 

in relation to the exercise. It seemed here that TP saw it as a possibility for the 

student to get some help when TP was helping another student and thereby not 

directly available. For the take-home group assignment, TP had not given any 
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exercises which explicitly called for instrumented techniques in GG, but the exam 

related exercises in the last part of the assignment did however allow techniques like 

𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖 , 𝜏1,𝐴𝑃,𝑃𝑅

𝑖  and 𝜏2,𝐴𝑃,𝑃𝑅
𝑖  (shared earlier in the course) and even techniques like 

𝜏3,𝐴𝑃,𝑃𝑆
𝑖  were possible to perform here for the students. 

7.2.6 Student Praxeologies in Relation to GG 

In general, the PSs were very technique oriented in their approach to GG-related 

work and when they verbalised anything on their work, it was often descriptions of 

the techniques rather than explanations of same. It was challenging for some PSs to 

relate algebra to the graphical representations obtained in GG - especially in the 

exercises of using sliders in GG to deduce which impact a and b have on the graphical 

representation of a power function. When approaching the GG worksheets offering 

hints and right answers for which techniques to perform, the PSs were in general 

more concerned with performing the right techniques and could be quite impatient in 

connection thereto, without considering why it was possible to perform the 

techniques. Herein lies a great risk of a black box effect of such worksheets. For the 

worksheets offering several exercises of the same type, there were noticeably some 

PSs who managed to try and generalise which (analytic) techniques to apply in 

relation to the involved tasks (especially in connection with Worksheet 7). It should 

further be noted that it differed greatly whether the PSs were patient in their 

approach to GG exercises whether in a worksheet or not. As an example, in relation to 

the tasks of type 𝑇𝐸𝑃1
, some PSs performed 𝜏1,𝑆𝑉,𝑃𝑅

𝑖  without performing gestures 

related to the functional equation - neither graphically nor analytically - whereas 

other PSs developed graphic techniques in GG’s Algebra Perspective instead of using 

analytic techniques. In general, it seemed that TP’s interference was necessary in 

many of the cases of GG related work in order to get the PSs to establish a knowledge 

block. As an endnote, regarding the optional use of (symbolic) calculators, it seems 

that the students were most confident in using handheld calculators (those who 

owned one) and it could lead to challenges for some of those who chose to use the 

basic calculator of the computer (or phone). The CAS View of GG was however never 

used by the PSs as (symbolic) calculator, regardless of the challenges faced. 
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8.0 Discussion 

In this section, the student and teacher work in relation to GG within both of the two 

courses will be discussed (in the sections 8.1 and 8.2) in order to answer RQ1-RQ3. 

Finally, a common discussion concerning the methodology of the collected data of the 

observation study will be made followed by perspectives for further studies (in 

section 8.3). 

8.1 The Trigonometry Course (L) 

In the following, a discussion of the analysed empirical data based on the 

observations made of the Trigonometry course will be presented in order to answer 

the RQs. 

Based on the analysis, the explorative environment set up by TT for the students in 

their work with GG can be said to both have potentialities and constraints. The 

potentialities especially lie in the option for the students to develop their own 

individual gestures and techniques in GG in their own pace. This flexibility in the pace 

is among other possible through the videos, manuals and click proofs provided for the 

exercises. Here, individual developed gestures/techniques cover both spontaneously 

developed and adopted instructed gestures/techniques. As for the constraints, the 

development of individual gestures and techniques may lead to challenges for the 

students when working together in groups since the gestures and techniques are not 

necessarily common. This may be difficult to grasp since the tool is new to them. On 

the other hand, the individual gestures/techniques developed can be an inspiration 

for the other students when working in groups. Especially, the demonstration of 

solving a task through different techniques may lead to a broader conceptual 

mathematical understanding, in the manner that the different techniques may give a 

perspective on the mathematical concepts involved in the specific task. 

One can raise the question whether the explorative environment set up by TT gave 

that much space for the students to develop gestures and techniques independently 

from scratch. This, since almost all of the exercises had a video with instructions on 

gestures and techniques attached and the PSs used these videos to a great extent 
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whereby these students developed the same instrumented techniques. Also the 

detailed manuals within the exercises can have had an influence on the students’ 

development of the same instrumented techniques. In addition, it is seen from the 

analysis that the PSs did not seem confident in the established environment by TT, in 

the sense that they would rather use formulas than the dynamic features of GG. This 

may be explained through three factors. The first factor is the fact that GG is newly 

implemented whereby the students have to get used to dealing with the program and 

its features - especially the dynamic ones. The second factor is that the use of 

formulas is a familiar way of dealing with tasks from elementary school for the 

students whereby this method is projected to solving tasks in high school. The third 

factor is that the students may be very concerned with the final goal in the form of the 

written examination. 

Regarding the work with GG in general, it seems that TT had the best intentions of 

intertwining the praxis and the knowledge block but from the observed (very short) 

recaps it does not seem to be succeeded. This, in the sense that the students 

separated the learned techniques in GG from the learned outside of GG. For instance, 

when determining the scale factor on the basis of the construction of two similar 

triangles in GG, the observed PS did not know how to solve the task in GG but did 

know how to solve it algebraically. Another example was the student approach to 

interior angles in GG. Even though it was verbalised, it was challenging for the 

students to transfer the knowledge of the construction of an angle to GG since they 

just randomly clicked on the legs or points in GG until the desired angle was shown. In 

connection hereto, the challenges in using GG, especially the dynamic features, which 

the students undergo may overshadow the potentialities of gaining conceptual 

mathematical understanding through the praxis.  

The separation, between techniques in GG and mathematical knowledge outside of 

GG, made by the students could maybe have been avoided by TT making more out of 

the recaps so that examples like the just mentioned became verbalised to everyone in 

the class. For this, TT could for instance have established something similar to a 

sherpa-student situation as an orchestration. According to the features of GG and the 

techniques to be performed in order to solve the given exercises - for instance making 
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the variables interdependent in order to construct a dynamic object - TT could have 

made use of the projector, like TT did when presenting the restrictions of the CAS 

View (like entering the degree symbol (°)). This, in order to secure a shared 

knowledge on how to approach GG as a tool in general. TT probably did not choose to 

do several of these orchestrations because of the orchestration made through 

presenting the gestures and techniques to be performed in GG through video and 

manuals. There is however a significant shortcoming in connection with this 

orchestration since the students were not patient in their approach to the videos and 

manuals which may explain their use of formulas and www.google.dk. 

The take-home group assignment may have been considered as a major, enclosing 

recap by TT in the sense that TT hereby got to both see the students’ approach to GG 

and give feedback. Moreover, the framework for the expectations to the students’ 

praxeologies in relation to GG can be said to have been established through this 

assignment. According to the learning outcome of the students in relation to this 

assignment it is however not certain that the students learn from their mistakes when 

they have a free choice of watching the feedback videos. The aspect of sharing the 

videos and thereby the techniques performed by all of the students in a common 

YouTube folder could have contributed to a common knowledge hereto. This was 

however not exploited since this was not explicitly articulated to be a part of the 

handling of the videos in the folder by TT. 

Regarding TT’s focus on the establishment of a knowledge block in relation to GG 

related exercises, this may be due to the lack of a textbook and the associated focus 

on the students taking their own notes. This has its strengths in the sense that the 

students are motivated to reflect upon their mathematical praxis. However, 

shortcomings can be found in such an orchestration since the students not 

necessarily write down the right explanations using the right terms - like the case 

concerning the median presented in the analysis as well as the copy paste procedure 

to the click proof in a worksheet. Hereby, they may take imprecise and maybe not 

fully understood notes which work as a reference henceforth if not accessed critically 

by the student, fellow students, or TT. 
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According to TT’s focus mentioned just above, it is probably a very deliberate choice 

of TT not to involve a triangle calculator, like the one in the worksheet presented in 

Figure 51, in the sense that the students get to learn the features of GG and on this 

basis reflect upon the praxis in order to deduce something in general and gain a 

conceptual mathematical understanding.  

In relation to the fact that this course was not observed until its end, the students’ 

management of the transition between the synthetic and the analytic geometry when 

considering cosine and sine with respect to an angle in the unit circle context, through 

constructions in GG and through worksheets, can be discussed. From the analysis, it is 

seen that a student is fully capable of considering cosine and sine with respect to an 

angle as the coordinates of the directional point in the unit circle in module 10. The 

challenges faced by the observed students in general in relation hereto throughout 

the course may therefore be explained by the course being an initial phase of the 

Trigonometry course. GG’s visualisation properties and dynamic features actually 

seem to have great potentialities in relation to both considering cosine and sine as 

being coordinates to a point as well as the transition between the two contexts (see 

A.6.2).  

Regarding the observation of the 10 modules, this part of the whole Trigonometry 

course is not greatly affected by the written exam as being a final goal (see Table 2). 

But as seen from the assignment of the theme part 3 (“3.del Vilkårlige trekanter. 

Opgaveløsning” in A.5), this merely concerns how to solve exercises and tasks in 

relation to arbitrary triangles which very well could be related to the types of exam 

tasks 𝑇𝐸𝑇1
- 𝑇𝐸𝑇5

 since they are concerned with arbitrary triangles. This can however 

only be speculated since this part of the assignment of the theme was not observed. 

8.2 The Power Functions Course (A) 

Within this section, the discussion of the RQs in relation to the Power Functions 

course will be reviewed. More specifically, the student work in relation to GG will first 

be discussed (in section 8.2.1) followed by a discussion of TP’s work in relation 

thereto (in section 8.2.2). The student work will especially be discussed in terms of 

the mathematical praxeologies established and which tasks they spontaneously 
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solved using GG. TP’s work is to be discussed in terms of the tasks instructed in 

relation GG as well as the orchestrations performed concerning both instrumented 

techniques and gestures in relation to GG. 

8.2.1 Student Work in Relation to GG 

Regarding the mathematical praxeologies established by the observed students in 

relation to GG, it is noted that one thing is to know how and another thing is to know 

why. The very technique oriented approach of the PSs to the GG related exercises can 

be put in relation to this problematique. The aspect of knowing why, herein 

explaining the techniques and/or generalising the outcome of the praxis, seems in 

general difficult for the PSs to do without TP’s intervention and guidance. This 

approach may be due to the goal of passing the written examination for the students, 

since the main part of this examination is to be solved with aids (where GG is an 

optional tool). More specifically, the priority for the PSs may be just to learn to 

perform the instrumented techniques in order to solve and answer the tasks for the 

examination whereas the establishment of a knowledge block is not prioritised to the 

same extent. It may however also be due to GG being considered as a tool for 

performing techniques and only techniques - i.e. not as a tool for establishing a 

knowledge block. For instance, regarding the realisation of the meaning of the value b 

in connection with Worksheet 3, this noticeably requires the students to be curious 

towards the praxis of the worksheet when dragging the slider for b since it is not a 

part of the exercises to answer this question. Both such curiosity and realisations are 

however also noted to be greatly influenced by how TP has orchestrated the GG work 

which will be discussed in section 8.2.2 below.  

In connection with this problematique, a question could be raised in relation to the 

case that the PSs did not prioritise explaining the techniques but rather put a focus on 

describing the techniques (if even done) - namely whether the students think they 

explain the techniques when merely describing them? However, putting into words 

how to perform the techniques may be an important step towards understanding why 

they can be performed, and for this step, the GG sessions of the course in general 

seemed quite appropriate. 



167 

 

Now, regarding the example of the rather impatient and uncritical attitude of PS1 

towards performing the commands in GG related to the technique 𝜏𝑆𝑙𝑖𝑑𝑒𝑟𝑠 𝑎𝑏,𝐴𝑃,𝑇𝑃
𝑖  as 

well as the subsequent exercises, this attitude may have been developed to be a bit 

more critical for future situations in GG when PS1 realises the mistake in the typing of 

the “^” symbol. For students like PS1, it may in general take some time for them to be 

confident enough in accessing GG as a CAS tool and thereby become more patient and 

critical towards the instrumented techniques to be performed. 

As for the case of the spontaneously developed techniques (by some of the students) 

being of graphic character in GG, this reveal an alternative way of solving tasks of 

types 𝑇𝐸𝑃1
 and 𝑇𝐸𝑃2

 as well as 𝑇𝐸𝑃3
 rather than performing pure analytic techniques. 

The students performing such graphical techniques may not be able to solve such 

tasks successfully when GG is not available as a tool. Therefore, GG may have had a 

positive influence on such students in the sense that they realise how to solve specific 

tasks in an alternative independently developed manner which works just as well as 

an analytic technique in order to solve the tasks at hand. An example, of a student 

showing more confidence in a graphical approach rather than an analytic approach 

for solving a task in GG, is PS3 in relation to 𝜏3,𝐴𝑃,𝑃𝑆
𝑖 . 

A general observation is that it seems more demanding for the PSs to consider the 

algebraic representation of a power function and its properties than considering the 

look of the graph. The latter is especially possible to do in the GG related exercises. 

The question is however whether the students in their work with GG are open 

minded towards GG being able to contribute to more than presenting the graphical 

representation of a power function and performing graphic techniques for solving 

tasks. Are they especially open towards making deductions on the relation to the 

algebraic representation of a power function as well as performing analytic 

techniques? This seems in general to be a challenge for the PSs of this study - some 

however try harder than other (e.g. PS14 and PS15 compared to PS16 in their approach 

to Worksheet 8). 

As a final note, regarding the aspect that some of the students did not confront GG but 

merely assisted and observed on a neighbours work herein, it may be problematic in 

regards to the learning and acceptance of instrumented techniques to be performed 
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in GG in relation to the given tasks. Such students may especially not develop any 

techniques - or at least not to the same extent as the one performing the 

instrumented technique. This does not immediately make it easier for such students 

to become more confident in using GG as a CAS tool. 

Now since the teacher’s orchestration has a great influence on the approach of the 

students, this will be discussed in the following. 

8.2.2 Teacher Work in Relation to GG 

Regarding the work of TP in relation to GG, there are without doubt many good 

intentions relating to the establishment of praxis blocks as well as knowledge blocks 

to be detected in the implementation of this throughout the course. TP’s recaps on GG 

related work had a great focus on the knowledge to be learned in connection to the 

content of the theme but the rationale of GG’s implementation in connection thereto 

may have suffered when TP did not relate the knowledge to the concrete gestures or 

techniques performed in GG or GG worksheets. TP was more concerned on 

orchestrations relating praxis and knowledge in the introductions to GG exercises 

rather than in the recaps. The students may however not have had the maturity in the 

introductions to GG-work as to understand such relations and thereby understand 

why they should perform the exact techniques or gestures in GG itself or in a GG 

worksheet. Therefore, recaps with a focus on this may also be beneficial for the 

rationale of the techniques or gestures as well as a sharing of such. According to the 

orchestration of the introduction to the technique 𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖 , made by TP on projector, 

TP possibly had a great influence here on the students’ approach to such types of 

tasks henceforth. TP’s main focus was here put on nothing more than the 

instrumented technique to be performed in GG without motivating further 

explanation of the praxis of performing regression. This may explain the lack of 

explanations in these kinds of tasks within the student work - even in the take-home 

group assignment where some students chose to note the 𝑟2 value without explaining 

what it means. The fact that there is no requirement of assessing the regression to be 

made in 𝑇𝐸𝑃5
 tasks may explain TP’s choice of orchestration in this situation. This, in 

the sense that TP is aware of the tasks to be solved in the written exam, in relation to 

power regression, as a main perspective for the learning outcome of the students - 
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nothing more, nothing less. The fact that many of the exercises set up by TP in 

relation to GG or GG worksheets throughout the course has a relation to all of the 

exam tasks 𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

 (see Table 3) further reveals a prevailing focus on the students 

learning to solve such tasks.  

In relation to GG itself, the sherpa-like situation orchestrated by TP in module 4 had a 

great potential of the students and TP sharing instrumented techniques in GG in 

relation to the tasks of type 𝑇𝐸𝑃1
, 𝑇𝐸𝑃2

 and 𝑇𝐸𝑃5
. This shows to be a success to the 

extent of performing graphical techniques for solving the tasks of 𝑇𝐸𝑃1
 and 𝑇𝐸𝑃2

 as 

well as students demonstrating a management of 𝜏5.2,𝑆𝑉,𝑃𝑅
𝑖 . The CAS View of GG may 

however have suffered in its rationale as a result of this orchestration, which can be 

explained by the fact that both TP and the students are quite new users of GG. 

Because of the latter mentioned aspect, a pursuit of repeating such types of 

orchestrations could likely have been beneficial for both TP and the students in their 

development of (common) instrumented techniques in relation to GG. Regarding the 

CAS View of GG, it may however require some more patience of TP to prioritise this as 

a (symbolic) calculator after the challenges met in the above mentioned orchestration 

- and therefore also of the students. The fact that some of the PSs seem confused in 

having the free choice of (symbolic) calculators may however reveal a need for a 

mandatory (symbolic) calculator. Now, since GG is accessible for everyone in the class 

as a CAS tool, it seems to be worth giving it a second chance, both by TP and the 

students. This could lead to more sharing of instrumented techniques in relation 

hereto which may be beneficial for both TP and the students as to enlarging their 

confidence herein. An important note to be made in prolongation of this, concerning 

the goal of teaching the students techniques in GG, is that this goal does not seem 

prevailing, especially with regards to TP not putting an effort in securing that the 

students work by a computer each when doing GG related exercises. The choice of not 

putting an effort in this, may be due to TP not intending to introduce GG as a 

mandatory CAS tool in general. This intention may further be due to the perspective 

of giving the students the option of choosing a CAS tool more freely to be the one 

found most intuitive to approach of the ones available (such as handheld calculators 

and WordMat, besides from GG). It can however be discussed whether this approach 



170 

 

is beneficial or not with regards to the future use and common acceptance of GG as a 

CAS tool for the mathematics teachings in this class. 

8.3 Common Discussion and Perspectives 

This section starts out by making a common note on the potentials of the 

implementation of GG worksheets in mathematics teaching. In spite of the possible 

shortcomings lying in the worksheets with click proofs being black boxes, it is worth 

crediting the limited user attention towards specific command frames to be made in 

GG, in order to create the objects in play within the worksheets. These worksheets 

therefore allow the user to be more focused on the conceptual mathematical 

knowledge, connected to the objects and exercises, rather than on which specific 

command to type or button to press in GG. 

Next, the methodology for the collection of the empirical data will be discussed and 

thereafter, possible perspectives on further studies are presented. 

The methodology for the collection of the empirical data 

The analyses and discussions on the praxeologies established in relation to GG of the 

students have been made with reservations to the fact that it was a small group of 

students that was observed with a maximum of three PSs per researcher. Hereby, the 

tool GG may have potentialities with respect to the praxeologies established by the 

students which have not been detected through this study. Further, an observation on 

more students could have shed light on to which extent, gestures and techniques in 

relation to GG that were managed by the students in the class. 

The reason why only a small group of students was selected for observation was the 

need to take field notes on the student work - especially in order to keep track on 

their articulations and gesticulations (e.g. pointing on the screen) in relation to their 

work and on whom was performing which praxeologies in the group work. The 

question remains however whether the observed student approach to GG and the 

computer in general was as natural as wished for, because of the possible 

acknowledgement of an observing researcher sitting close to them. In relation to this 

natural approach the question is whether the observed students would have initiated 

the observed gestures and techniques to the same extent if not observed 
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(greater/lesser extent). In relation to this question, the continuous interruption of the 

researcher requesting the PSs to save and start up a new screen recording every 

tenth minute may have had a negative impact on the natural use of - and approach to 

GG. This aspect was however difficult to optimise because of the restrictions in the 

write speed of the USB plugs and the lack of access to USB plugs with greater writing 

speed. 

Perspectives for further studies 

Regarding the very technique oriented approach to GG work of the students, it could 

be interesting, for further studies, to observe classes where GG is not as new a tool to 

the students and to the teachers as in the case of this observation study. Hereby, it 

could be possible to realise whether the students were able to be more keen on 

establishing a knowledge block in their praxis with GG without the disturbance of just 

getting to know its features. Also, a more confident approach to GG performed by the 

teacher would possibly have a great influence on the students’ management of and 

approach to GG. 

Furthermore, it could be interesting to observe on teaching in the same theme(s) with 

GG as a CAS tool on another high school(s) with a different teacher(s). This, in order 

to gain a perspective on the praxeologies possible to develop for the students as well 

as the orchestrations possible to perform by the teacher in relation to GG within the 

specific theme(s).  

According to the potentials of GG as a CAS tool in relation to mathematics teaching, it 

could also be interesting to compare the approach to this tool with the approach to 

another CAS tool on computer (also being newly implemented), for instance  

TI-Nspire or Maple72, at the same level of high school. This, in order to get a 

perspective on mathematical praxeologies possible for the students to establish in 

relation to a CAS tool as well as on the teacher’s exploitation modes of such a tool in 

the mathematics teaching. 

                                                        

72 For further elaboration and examination hereof, the following links (last visited 21.07.2016) can be 

pursued: https://education.ti.com/da/danmark/products/ti-nspire-produkt-familien/ti-nspire-cas-

elevsoftware/tabs/overview and http://www.maplesoft.com/products/maple/students/. 
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9.0 Conclusion 

From this observation study, it becomes evident that the implementation of a CAS 

tool like GG in the mathematics teaching of high school may unfold in very different 

ways. Such an implementation is apparently very dependent of the mathematical 

theme as well as on the specific teacher’s orchestrations thereof. It is however also 

very dependent on the students’ approach to such a tool and especially their 

openness towards the option that the establishment of the praxeologies, in 

connection with the tool, can be more than that of a practical block. 

The conclusions presented are noted to be based on what has been discovered both a 

priori and through the observations of the teachings. 

Through this study, GG has been noticed to be a versatile CAS tool in the sense that it 

consists of different Views where significant features, in addition to the classical CAS 

properties, are the visualisation property as well as the dynamic aspect. These 

features are considered beneficial in order to observe several examples of the 

mathematical object to be examined and in order to deduce something general 

thereof in an explorative manner. Moreover, it is possible to see different 

representations of the same mathematical object through the different Views selected 

in a GG document. Furthermore, several types of techniques are possible to perform 

in GG in order to solve the same task.  

Regarding the theme of Trigonometry, GG is especially suitable for construction work 

of triangles and of the unit circle as well as for accessing the objects dynamically 

within the Algebra Perspective. For the theme of Power Functions, GG is especially 

appropriate for providing a graphical representation (with possible dynamic aspects 

through sliders). Furthermore, the Spreadsheet View is applicable for performing 

power regression. The CAS View of GG has certain restrictions when performing 

(symbolic) calculations in relation to both themes. 

The aspect of GG worksheets, providing prefabricated exercises involving visual and 

dynamic constructions, hints and/or right answers concerning algebraic/analytic 

techniques and/or results, has both its strengths and shortcomings. A definite 

strength is the presentation of exercises where the objects to be considered are 
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constructed beforehand. This may namely move the user’s focus from the gestures 

required to construct the objects to the conceptual mathematical knowledge 

connected to the objects and exercises within the accessed worksheet. A striking 

shortcoming in relation to the student work with the worksheets has been observed 

in relation to those providing click proofs, since they may function as black boxes 

rather than tools for creating a connection between the praxis block and the 

knowledge block.  

A more general shortcoming concerns the very technique oriented approach of the 

students in GG related work where the students may not be able to relate the 

outcome of GG (or GG worksheets) to mathematical knowledge in general (i.e. 

establishing a knowledge block). 

An important note to be made in connection with the GG related work observed in the 

two courses is that TP prioritised the implementation of worksheets to a greater 

extent than TT. In the Trigonometry course, the instructed exercises for GG related 

work revealed a greater focus on construction work (and gestures related hereto) 

and the establishment of a knowledge block in relation to the specific praxis in GG, 

than in the Power Functions course.  

For the observed orchestrations, both of the teachers made use of projector, however 

in different ways. TP prioritised to demonstrate gestures and techniques in plenum as 

well as organising a sherpa like situation whereas TT did not prioritise such 

demonstrations to the same extent. TT however implemented videos and manuals for 

the GG related work which TP did not. TT primarily used the projector for introducing 

the exercises from TTW. Both of the teachers introduced the CAS View of GG in a very 

similar way and this was actually the only situation in which TT demonstrated 

gestures and techniques on the projector. The CAS View was noticeably not 

considered a mandatory classical CAS tool in either of the two courses and was briefly 

prioritised by the teachers. 

The recaps of GG related work performed by the teacher were very different in the 

two courses with respect to the articulation of the praxis performed in relation to GG. 

TT explicitly did this whereas TP did not. 
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Another significant difference between the orchestrations performed within the two 

courses was the design of the take-home group assignment given to the students. The 

assignment of the Trigonometry course focused solely on the approach to the 

construction properties and dynamic features of GG as well as the application of these 

in order to make explanations and deductions. In the assignment of the Power 

Functions course, no specific references to the application of GG were made but it 

involved exam exercises for which GG was possible to apply. 

Regarding the overall observation on the relation of the GG related work and the 

exercises and tasks of the written examination in the two courses, this was found to 

be curiously different. The GG related work in the Trigonometry course did not seem 

to be focused on the written examination. TT primarily instructed exercises through 

TTW where there is a significant focus on construction work and dynamic features of 

GG in relation to right and similar triangles. Moreover, it seems that the focus was put 

on getting to know how to approach GG rather than getting to know how to solve 

exam related tasks. However, such management of GG can be considered a foundation 

for being able to manage the exercises of the written examination. In contrast to these 

observations, the GG related work of the Power Functions course can be put in 

relation to the detected types of exam tasks 𝑇𝐸𝑃1
- 𝑇𝐸𝑃6

 to a significant extent.  

Overall, the aspect of the students’ technique oriented approach to GG calls for added 

attention of the teacher towards the establishment of a knowledge block in order to 

connect the praxis performed in GG to the conceptual mathematical knowledge. It is 

certainly a demanding job for the teacher to implement such a CAS tool without it 

solely being directed as a tool for the written examination. 
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Appendix 

A.1 Structure of the Thesis  
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A.2 Teaching material from TTW 

TTW 1: 

 

To be noted, the 𝑡𝑈𝐶,𝐴𝑃,𝑇𝑇 can be used to solve task 3. 

TTW 2: 
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TTW 3: 

 

TTW 4: 
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TTW 5: 

 

Noticeably, the technique 𝜏𝑀𝑒𝑑𝑖𝑎𝑛,𝐴𝑃,𝑇𝑅
𝑖  can be performed in order to answer task 

3. in exercise 1.2. 
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TTW 6: 
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A.3 Screen recordings 

For accessing these files, contact Line Sørensen: linesteckhahn@gmai.com or 

Anne Wellendorf: annewellendorf@gmail.com. To be noted, the screen 

recordings are in Danish. 

A.3.1 Trigonometry course: 

 
Module 1: 

 USB 1 (1 file) 

 USB 2 (1 file) 

 USB 3 (1 file) 

 USB 7 (1 file) 

 USB 8 (1 file) 

 

Module 6: 

 USB Gul (5 files) 

 USB 6 (5 files) 

 USB 7 (5 files) 

 

Module 2: 

 USB Blå (3 files) 

  USB Gul (3 files) 

  USB 6 (3 files) 

  USB 9 (3 files) 

 

Module 7: 

 No files 

 

Module 3: 

 USB Blå (4 files) 

 USB Gul (5 files) 

 USB 6 (5 files) 

 USB 9 (3 files) 

 

Module 8: 

 USB Gul (6 files) 

 USB 6 (4 files) 

 USB 7 (5 files) 

 

Module 4: 

 USB Gul (4 files) 

 USB 6 (4 files) 

 USB 7 (4 files)  

 USB 9 (4 files) 

 

Module 9: 

 USB Blå (4 files) 

 USB Gul (3 files) 

 USB 5 (3 files) 

 USB 6 (3 files) 

 USB 7 (3 files) 

 

Module 5: 

 USB Blå (3 files) 

 USB Gul (3 files) 

 USB 4 (2 files) 

 USB 6 (3 files) 

 USB 7 (2 files) 

 USB 9 (1 file)  

 

Module 10: 

 USB 5 (6 files) 

 USB 6 (4 files) 

mailto:linesteckhahn@gmai.com
mailto:annewellendorf@gmail.com
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A.3.2 Power Function Course 

 
Module 1: 

GG related exercises: 

    - USB 6 (PS1) (6 files) 

     - USB 9 (PS2): Screen 

  recordings failed  

 

 

Module 5: 

GG document: 

- USB 6 (1 file) 

- USB 7 (2 files) 

- USB 9 (2 files) 

  - USB Blå (2 files) 

 

Module 2:  

Worksheet 1: 

    - USB 6 (PS7) (3 files) 

     - USB 7 (PS8) (3 files) 

  - USB 9 (3 files) 

Module 6: 

Worksheet 7:  

  No screen recordings

 collected here. 

Module 3: 

Worksheet 1 (reconsidered): 

     - USB 6 (1 file) 

   - USB Blå (2 files) 

   - USB 9 (1 file) 

 

Worksheet 2: 

     - USB 6 (PS9) (2 files) 

     - USB Blå (PS10) (2 files) 

     - USB 9 (PS11) (neighbor   

to PS10) (2 files) 

 

Regression/modelling exercises from 

the exercise book: 

     - USB Gul (PS3) (3 files) 

     - USB 5 (PS4) (3 files) 

     - USB Blå (PS5) (3 files) 

     - USB 9 (PS6) (2 files) 

Module 7: 

Worksheet 7: 

- USB 6 (2 files) 

- USB Gul (1 file) 

- USB Blå (2 files) 

 

Worksheet 8: 

- USB 6 (PS14) (1 file) 

- (USB Gul) (PS15): 

Neighbor to PS14 (No 

recordings collected) 

- USB Blå (PS16) (1 file) 

 

 

 

 

 

 

 

Module 4: 

Worksheet 3: 

     - USB Blå: Screen 

  recordings failed  

     - USB 6 (PS12) (1 file) 

     - USB Gul (PS13) (1 file) 

 

Module 8: 

Worksheet 8: 

- USB 7 (PS17) (1 file) 

- USB 5 (1 file) 

- USB Blå (1 file) 
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A.4 Scheme for the field notes 
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A.5 Assignment of the theme of Trigonometry 

 

Temaopgave: Trigonometri 
 

Formålet med forløbet er at få redskaber til at løse geometriske problemer. I 
skal kunne opstille og udforske geometriske modeller og lave 
forholdsberegninger i ensvinklede trekanter samt trigonometriske 
beregninger i vilkårlige trekanter. 
 
En temaopgave har samme tema som undervisningsforløbet og dækker 
forløbets faglige mål. Ved at få opgaven udleveret ved forløbets start, kan I 
følge med i og sikre jer at I lærer det der kræves. Besvarelsen af opgaven 
fungerer som en efterbehandling og sammenskrivning af det, der er foregået 
i timerne. Temaopgaven vil indgå i et eller flere eksamensspørgsmål til 
mundtlig eksamen. Det er derfor vigtigt at I formulerer svarene med jeres 
egne ord, så I selv kan forstå og bruge dem senere hen. Af samme grund bør 
I skrive kildehenvisninger til alle relevante afsnit i besvarelsen. 
 
1.del af temaopgaven skal forberedes individuelt og fremlægges mundtligt i 
grupper i en skærmvideo. Beviserne i 2.del evalueres i videoproduktioner 
med en responsgruppe, mens opgaverne i 3.del laves i en individuel, skriftlig 
aflevering. Det er en fordel i undervisningen at holde øje med hvilke 
oplysninger I skal indsamle for at kunne besvare temaopgaven. 
 
1.del: Ensvinklede og retvinklede trekanter 
Produktkrav: Skærmvideoer i grupper (1,5 times omlagt elevtid d.18.april). 
2,5 times elevtid hjemmefra som forberedelse til gruppearbejdet: Nå så 
meget som muligt af temaopgavens 1.del (deadline d.14.april). 
Skærmvideo i grupper: Bliv enige om hvilke opgaver fra temaopgavens 1.del 
I ønsker at demonstrere. 
 
• Hver gruppe skal lave én video på højst 10 minutter. 
• Alle gruppemedlemmer skal have lige lang taletid på videoerne. 
• I skal præsentere jer selv, når hver ny person siger noget (det kan være 
svært at genkende jeres stemmer). 
• Videoerne uploades på holdets YouTube kanal 
 
Det er et krav at i anvender GeoGebra dynamisk (med bevægelse) i 
skærmvideoen; det kan være jeres egne geometriske konstruktioner, eller en 
applet. I må ikke lave en skærmoptagelse med en færdig tekst, som er 
skrevet på forhånd. 
 
➢ Beskriv hvad I ser. 
➢ Fortæl om I arbejder med hhv. en definition, en sætning eller et bevis. 
➢ Forklar hvad der sker. 
➢ Husk til sidst at konkludere på opgaven. 
 
Opgaver: 
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(a) Definér begreber til beskrivelse af trekanter, herunder højde, 
vinkelhalveringslinje, median, 
midtnormal, topvinkler, samt hosliggende- og modstående side. 
(b) Gør rede for ensvinklede trekanter. 
Undervejs skal du inddrage skalafaktoren og nogle sætninger der gælder for 
ensvinklede 
trekanter. 
(c) Giv et eksempel på et geometrisk problem som kan løses ved brug af 
forholdsberegninger i ensvinklede trekanter. 
(d) Definér begreber til beskrivelse af retvinklede trekanter, herunder 
hypotenuse, hosliggende og modstående katete. 
(e) Opskriv Pythagoras' sætning og angiv i hvilken type trekanter den kan 
anvendes. Oversæt Pythagoras' sætning fra symbolholdigt til naturligt sprog. 
Undervejs skal du anvende ordene: hypotenuse, katete, sum og kvadrat. 
(f) Bevis Pythagoras' sætning. 
(g) Giv et eksempel på et geometrisk problem som kan løses ved brug af 
Pythagoras' sætning. 
(h) Definér begreberne cosinus, sinus og tangens. Undervejs skal du 
anvende enhedscirklen. 
(i) Opskriv sætningen om cosinus, sinus og tangens i en retvinklet trekant 
ved brug af ordene: 
hypotenuse, modstående- og hosliggende katete. 
(j) Bevis sætningen om cosinus, sinus og tangens i en retvinklet trekant. 
(k) Giv et eksempel på et geometrisk problem som kan løses ved brug af 
cosinus, sinus eller tangens i en retvinklet trekant. 
(l) Angiv de kilder der er anvendt til besvarelsen af temaopgavens 1.del. 
 
2.del: Vilkårlige trekanter. Sætninger og beviser. 
Produktkrav: Videoproduktion af bevisfremlæggelser i grupper med 
responsgrupper. Klassen formulerer i fællesskab nogle fokuspunkter til 
videoerne, som responsgrupper efterfølgende giver feedback på. To 
tilfældige videoer vil blive vist for alle i en efterfølgende time. 
 
Bliv enige om hvilke beviser fra temaopgavens 2.del I ønsker at demonstrere. 
Hver gruppe skal lave én video på højst 10 minutter. Alle gruppemedlemmer 
skal have lige lang taletid på videoerne. 
Videoerne uploades på holdets YouTube kanal.  
 
Videoproduktionen er en træning i at gå til mundtlig eksamen: 
• Lav relevante forberedelser inden i optager: figurer og formler. 
• Mellemregninger skal skrives og forklares mens I optager. Det kan f.eks. 
gøres ved en tavle. 
 
Disposition for beviset: 
1. Introduktion: Hvad siger sætningen – hvad er det, vi skal komme frem til? 
2. Indfør notation. Hvordan navngiver du trekantens sider og vinkler? Tegn 
og skriv på figuren. 
3. Argumentationen som udgør selve beviset. Hvilke kendte sætninger 
anvendes undervejs? Hvordan udføres de matematiske udregninger (med 
bogstaver)? 
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4. Afrunding: Hvordan beviser dette den relevante sætning? 
 

 
Opgaver: 
(m)Definér begreberne spids og stump vinkel. Angiv nogle egenskaber for 
cosinus- og sinusfunktionerne, som gælder for to vinkler som tilsammen er 
180º. 
(n) Opskriv sætningen om beregning af arealet i en vilkårlig trekant ved brug 
af sinus. Beskriv med ord hvilke oplysninger du skal have om trekanten for at 
kunne anvende denne formel. 
(o) Bevis sætningen om beregning af arealet i en vilkårlig trekant ved brug af 
sinus. 
(p) Giv et eksempel på et geometrisk problem som kan løses ved brug af 
arealformlen. 
(q) Opskriv sinusrelationerne. Beskriv med ord hvilke oplysninger du skal 
have om trekanten for at kunne anvende denne formel. 
(r) Bevis sinusrelationerne. 
(s) Giv et eksempel på et geometrisk problem som kan løses ved brug af 
sinusrelationerne. 
(t) Opskriv cosinusrelationerne. Beskriv med ord hvilke oplysninger du skal 
have om trekanten for at kunne anvende denne formel. 
(u) Bevis cosinusrelationerne. 
(v) Giv et eksempel på et geometrisk problem som kan løses ved brug af 
cosinusrelationerne. 
(w)Angiv de kilder der er anvendt til besvarelsen af temaopgavens 2.del. 

3.del: Vilkårlige trekanter. Opgaveløsning. 
Produktkrav: Skriftlig, individuel aflevering med facitliste som Google 
spørgeskema. Der er 4 timers samlet elevtid og deadline er ved lektionens 
start d.10.maj (uge 19). 
 
(x) Løs opgaverne i dokumentet: ”Trigonometri_Temaopgave 
1yMA1516_Opgaver.pdf” 
(y) Angiv de kilder der er anvendt til besvarelsen af temaopgavens 3.del. 
 

 
Faglige mål 
Faglige mål fra læreplanen: 
 

 Håndtere formler, herunder kunne oversætte mellem symbolholdigt og 
naturligt sprog, og selvstændigt kunne anvende symbolholdigt sprog til 
at beskrive variabelsammenhænge og til at løse problemer med 
matematisk indhold. 

 Opstille og udforske geometriske modeller og løse geometriske 
problemer både ved hjælp af et dynamisk geometriprogram og på 
grundlag af trekantsberegninger samt kunne give en analytisk 
beskrivelse af geometriske figurer i koordinatsystemer og udnytte dette 
til at svare på givne teoretiske og praktiske spørgsmål. 

 Redegøre for matematiske ræsonnementer og beviser samt deduktive 
sider ved opbygningen af matematisk teori. 
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 Anvende CAS-værktøjer til udforskning af og til løsning af givne 
matematiske problemer. 

 
 
Kernestof fra læreplanen: 

 Ligningsløsning med analytiske og grafiske metoder og med brug af it-
værktøjer. 

 Forholdsberegninger i ensvinklede trekanter og trigonometriske 
beregninger i vilkårlige trekanter. 

 Ræsonnement og bevisførelse. 
 
Ved forløbets afslutning skal du kunne følgende: 

Skriftligt – med formelsamling 
 Anvende Pythagoras' læresætning. 
 Foretage beregninger i ensvinklede trekanter. 
 Opstille enkle formler og ligninger ud fra en sproglig beskrivelse, dvs. 

anvende symbolholdigt sprog til at beskrive variabelsammenhænge. 
 Anvende begreber til beskrivelse af trekanter, herunder højde, 

vinkelhalveringslinje, median, midtnormal, topvinkler, hypotenuse, 
katete, samt hosliggende- og modstående side. 

 Anvende formler for vilkårlige trekanter, herunder areal og vinkelsum. 
 
Skriftligt – med CAS 

 Bestemme funktionsværdien af cosinus, sinus og tangens til en given 
vinkel, samt bestemme værdien for de inverse funktioner til cosinus, 
sinus og tangens. 

 Anvende sinusrelationer og cosinusrelationer til at bestemme sider og 
vinkler i vilkårlige trekanter. 

 Anvende arealformlen for i en vilkårlig trekant ved brug af sinus (dvs. 
uden at kende trekantens højde). 

 Tegne skitser af situationer med geometriske problemer ved hjælp af et 
dynamisk geometriprogram (GeoGebra). 

 Udforske og løse geometriske problemer ved hjælp af et dynamisk 
geometriprogram (GeoGebra). 

 
Mundtligt 

 Definere cosinus, sinus og tangens ud fra enhedscirklen. 
 Bevise Pythagoras' sætning. 
 Bevise sætningen om cosinus, sinus og tangens i en retvinklet trekant. 
 Bevise arealformlen i vilkårlige trekanter. 
 Bevise sinusrelationerne i vilkårlige trekanter. 
 Bevise cosinusrelationerne i vilkårlige trekanter. 

 
 
Årsprøvespørgsmål (1.g) 
Geometri. 
Gør rede for udvalgte emner fra projekter og temaopgaver i forløbene: 
Geometri I-II.Undervejs skal du inddrage: 
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a) Definitionen af cosinus, sinus og tangens ud fra enhedscirklen. 
b) Et bevis for sinusrelationerne. 
c) Eksempler på anvendelse af sinusrelationerne. 
 
 
Geometri. 
Gør rede for udvalgte emner fra projekter og temaopgaver i forløbene: 
Geometri I-II. 
Undervejs skal du inddrage: 
a) Definitionen af cosinus, sinus og tangens ud fra enhedscirklen. 
b) Et bevis for cosinusrelationerne. 
c) Eksempler på anvendelse af cosinusrelationerne. 
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A.6 Trigonometry course. Exercises proposed by TT 

A.6.1 

Worksheet concerning the Pythagorean Theorem (dynamically by use of a 

slider); https://tube.geogebra.org/m/UjZFKMNu: 

 

A.6.2 

The proof of cosine and sine in right triangles via GG worksheet (click proof) 

https://www.geogebra.org/m/238691  

 

https://tube.geogebra.org/m/UjZFKMNu
https://www.geogebra.org/m/238691
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A.6.3 

Worksheet for the area formula (click proof): https://tube.geogebra.org/m/2297493 

Figure 1: 

Figure 2: 
  

https://tube.geogebra.org/m/2297493
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A.6.4 

The exercise 1.1 presenting drawing an arbitrary triangle as a task: 

 

 

A.6.5 

The exercise 𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇1,𝐴𝑃,𝑇𝑇: 

 

 

A.6.6 

The exercise 𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇2,𝐴𝑃,𝑇𝑇: 
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A.6.7 

The exercise 1.4 in which the techniques 𝜏𝑃𝐵,𝐴𝑃,𝑃𝑆1

𝑖 and 𝜏𝑃𝐵,𝐴𝑃,𝑃𝑆2

𝑖 can be 

performed in order to answer task 3.: 

 

 

A.6.8 

Exercise 3.1 providing a manual for the task 𝑡𝑆𝑇1,𝐴𝑃,𝑇𝑇 (in “Opgave 1”) and the 

specific task 𝑡𝑆𝑇2,𝐴𝑃,𝑇𝑇  (in “Opgave 2”): 
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A.6.9 

Notes made by a PS in relation to a task similar to 𝑡𝑆𝑇2,𝐴𝑃,𝑇𝑇; How to determine 

the side length a1, when the sides a, c, and c1 are known?: 

 

 

A.6.10 

The exercise presented here is 𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇3,𝐴𝑃/𝐶𝑉,𝑇𝑇: 
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A.6.11 

Notes made by a PS in relation to “Øvelse 3.47”; 𝑒𝑥𝑒𝑟𝑐𝑖𝑠𝑒𝑅𝑇3,𝐴𝑃/𝐶𝑉,𝑇𝑇: 

 

A.6.12 

Here the task 𝑡𝐶𝑜𝑠𝑖𝑛𝑒 𝑡𝑜 𝑎𝑛𝑔𝑙𝑒,𝑊𝑜𝑟𝑘𝑠ℎ𝑒𝑒𝑡,𝑇𝑇  is presented in point 10. Of exercise 6: 

 

  



XXIII 

 

A.6.13 

Notes of a PS in relation to the worksheet presented in A.6.2: 
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A.7 Power Functions course. Exercises proposed by TP 

Module 1: 
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Module 3:  

Worksheet 2 with exercises of calculating a and b knowing two points with the 

possibility of getting to see hints and right answers (intermediate calculations); 

https://tube.geogebra.org/m/148843: 

 

 

Regression/modelling exercises from the exercise book (Gyldendals 
Gymnasiematematik. Arbejdsbog B1) 

 Øvelse 278 (p. 61), translated from Danish (including the decimal numbers 
notation (from using “,” to “.”)): 
 
The table presents measures of the time of oscillation y seconds for a bullet 
which is hung up in a cord of x metres and it oscillates back and forth. The 
time of oscillation can be expressed by the formula 𝑦 = 𝑏 · 𝑥𝑎 . 

The length of the cord  
(x metres) 

0.50 0.75 1.00 1.25 1.50 

Time of oscillation  
(y seconds) 

1.4 1.7 2.1 2.2 2.5 

 
 a) Determine the numbers a and b through regression. 
 b) What is the time of oscillation if the cord is 2.00 metres? 

c) How long shall the cord be if the time of oscillation is to be 2.0 
seconds? 
  

 Opgave 2046 (p. 84) translated from Danish: 
 
The table presents, for a series of windmills, how much power the mill is 

https://tube.geogebra.org/m/148843
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able to produce. In a model it is expected that the power P(x), measured in 
kW, can be expressed by the relation 𝑃(𝑥) = 𝑏 · 𝑥𝑎, where x is the wing 
diameter, measured in meters. 

Wing diameter (m) 20 29 47 86 120 

Power (kW) 100 225 660 2500 5000 

 
a) Determine the numbers a and b through power regression 
b) Plot the given points and the graph of the function found in the same 
    coordinate system. 
c) Determine the power from a mill with wing diameter of 100 m. 
d) What shall be the diameter for the power to be 1800 kW? 

     
 Opgave 2047 (p. 84) translated from Danish: 

 
For certain trees it is possible to apply a model of the type 𝑚(𝑥) = 𝑏 · 𝑥𝑎  for 
the relation between the diameter of the tree x (measured in cm) and the 
weight of the tree m(x) (measured in kg). The table presents some values 
for this relation. 

x (cm) 10 20 30 40 50 

m(x) (kg) 16 62 140 250 390 

 

    a) Determine the numbers a and b through regression. 

    b) Determine the weight of a tree with the diameter 25 cm. 

    c) Over some years, the diameter of a tree has increased by 15 %. By 

  how many percent has the weight increased? 
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Module 5: 

GG document made by TP: 
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Module 6: 

Worksheet 4: 

http://tube.geogebra.org/m/XFMRVbgg?doneurl=%2Fsearch%2Fperform%2F

search%2Fproportionalitet#material/gHDSpgmf 

 

 
Worksheet 5: 
http://tube.geogebra.org/m/XFMRVbgg?doneurl=%2Fsearch%2Fperform%2Fsearch%2
Fproportionalitet#material/ArUVcAMy  

 

 

http://tube.geogebra.org/m/XFMRVbgg?doneurl=%2Fsearch%2Fperform%2Fsearch%2Fproportionalitet#material/gHDSpgmf
http://tube.geogebra.org/m/XFMRVbgg?doneurl=%2Fsearch%2Fperform%2Fsearch%2Fproportionalitet#material/gHDSpgmf
http://tube.geogebra.org/m/XFMRVbgg?doneurl=%2Fsearch%2Fperform%2Fsearch%2Fproportionalitet#material/ArUVcAMy
http://tube.geogebra.org/m/XFMRVbgg?doneurl=%2Fsearch%2Fperform%2Fsearch%2Fproportionalitet#material/ArUVcAMy
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Worksheet 6: 

https://tube.geogebra.org/material/simple/id/79879 

 

 

Homework: Exercises related to direct and inverse proportionality  

(from the exercise book; Gyldendals Gymnasiematematik. Arbejdsbog B1 

p. 89): 

- Opgave 2080 (translated from Danish): 

Two variables x and y are proportional. Finish the filling of a table as the one 

below: 

x 2 4 
 

y 3 
 

15 

 

- Opgave 2081 (translated from Danish): 

Two variables x and y are inverse proportional. Finish the filling of a table as the 

one below: 

 

 

 

x 2 
 

16 

y 24 8 
 

https://tube.geogebra.org/material/simple/id/79879
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Module 7: 

Worksheet 8: “Graphs and equations of functions on growth”: 

http://www.geogebra.org/m/3153079: 

 

 

  

http://www.geogebra.org/m/3153079
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Homemade game by TP on the three elementary functions: 

 

Den har en 
hældningskoefficient 
  
 

Hver gang x vokser med 
1, ganges y med 2,3 
 

Når x vokser med 1, 
vokser y med 3 

Den eksisterer ikke, når 
x<0 
 

Når x vokser med 2%, 
aftager y med 4% 

  
 

Den har en 
fremskrivningsfaktor 

  
Punktet (2,-4) ligger på 
grafen 

   
Den har en 
halveringskonstant 
  
 
Den går igennem 
punkterne: 
(-3,4),  (0,8)  og (3,16) 
 

Når x vokser med 5, 
bliver y halveret 
 

 
Forskriften er f(t) = 
23 - t 
 

Forskriften er  
g(x) = 32 * x 

  
 
 
For alle punkter på 
grafen gælder, at 
x>0 og y>0. 
 

Forskriften er  
h(x) = (2x)3 

  
Forskriften er 

y = b * ax 

 
Forskriften er 

f(x) = 2,3 * 102 

 

 
Grafen indeholder 
punkterne 

(0,1), (1,3), (2,5) og 
(3,7) 
  
Når x vokser med 
112, 
bliver f(x) ganget 
med 2 
 

Alle y-værdier er 
positive, men x-
værdierne er også 
negative 
 

Forskriften er  
N(v) = 2*v6 

  
Når y aftager med 
5%, 
er x vokset med 1 

  
 
f(x+1) = a*f(x) 
 
 
 

g(x+1) = g(x)-3 
 
 

f(1,2*x) = 1,2a * f(x) 
 
 
Hver gang x 
vokser med 3, 
vokser y med 4 
 

Hver gang x 
vokser med 5, 
vokser y med 45% 
 
 
Grafen er en ret 
linje 
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Spilleregler: 

 

Brikkerne lægges med bagsiden opad på bordet. 
Spillerne (man må godt være to sammen!) trækker efter tur en brik, hvis 
de ikke har en fra en tidligere tur. 
Hvis spilleren har en brik, der passer på det felt, man er kommet til, må 
den lægges: 
l  betyder ”lineær funktion” og giver 1 point 

e  betyder ”eksponentiel udvikling” og giver 2 point 

p betyder ”potensudvikling” og giver 3 point 

Hvis der ikke kan lægges, gives 0 point, og det er den næste spillers 
tur. 
Hvis en brik lægges forkert, fratrækkes det tilsvarende antal point, og 
brikken skal tages tilbage - hvis nogen kan påvise fejlen! 
Når målet er nået, er vinderen den, der har flest point. 
Spillet kan evt. gentages… 

God fornøjelse! 
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Module 8: 

Take-home group assignement:  

 

Potensvækst 

 

Projektet skal udarbejdes som et gruppearbejde og afleveres senest den 29.4.  

Rapporten skal forsynes med en forside, der foruden jeres navn fortæller om 

rapportens titel og indhold.  

 

Opgaven skal indeholde følgende: 

 

I.  

Lav en skematisk oversigt over de tre forskellige slags vækst - ved at udfylde et 

skema som bilag A.  

 

 

II. 

Bevis for potensvækst formlerne for bestemmelse af a og b ud fra to punkter på 

grafen. 

 

III. 

Bevis betydningen af b i forskriften for potensvækst. 

 

IV. 

Bevis sætningen f(k*x) = ka * f(x) - og forklar betydningen af denne sætning. 
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V. 

Løs følgende opgaver fra STX-B-niveau (om modeller med potensvækst): 

 

5.003, 5.004 og 8.040. 

 

God arbejdslyst! 

 

  

The formulation of the exercises given in V. above:  
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8.040: 

 
Bilag A: 
 Lineær 

udvikling 
Eksponentiel 
udvikling 

Potensudvikling 

Regneforskrift 

 

 

 

 

   

Beregning af 

konstanterne i 

regneforskriften 

ud fra to 

punkter 
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Hvad angiver a 

i forskriften? 

 

 

 

   

Skal ikke 

udfyldes 

 

(jf. opg. IV) 

Hvad angiver b  

I forskriften? 

 

 

 

   

Hvad afgør, om 

udviklingen er 

voksende eller 

aftagende? 
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A.8 Power Functions course. Student notes and outcome of 

screen recordings 

Module 1: 

Screenshot of the outcome of the technique performed by PS1 when trying to 

perform 𝜏𝑆𝑙𝑖𝑑𝑒𝑟𝑠 𝑎𝑏,𝐴𝑃,𝑇𝑃
𝑖 : 
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Front page of PS1’s notes: 
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Back page of PS1’s notes: 
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 PS2’s notes: 

 

 

  



XLIII 

 

AS2’s notes: 
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Module 2: 

PS7’s notes in Word for Worksheet 1: 

 

PS8’s notes for Worksheet 1: 
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Module 3: 

PS5’s notes in Word: 

 

The technique for solving tasks of type 𝑇𝐸𝑃2
 developed by PS3: 

𝝉𝟐,𝑨𝑷,𝑷𝑺
𝒊  :  Click on the icon   in the Graphics View Style Bar to add a grid to 

  the Graphics View → Click on the Point Tool  → Find via the grid 

  the point of the graph of 𝑓 where 𝑓(𝑥) = 𝑓(𝑥0) (approximately) 

  and click on this spot of the graph to create a point (A) → Check if 

  the second coordinate of A is equal to 𝑓(𝑥0) in the Algebra View (if 

  not; adjust the point in the Graphics View by dragging it) → Read 

  off the first coordinate of the point in the Algebra View. 

  

https://www.geogebra.org/manual/en/Point_Tool
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Screenshot of the outcome of 𝝉𝟏,𝑨𝑷,𝑷𝑺
𝒊 : 

 

Here, the given value of 𝑥0 is 100. 

 

Screenshot of the outcome of 𝝉𝟐,𝑨𝑷,𝑷𝑺
𝒊 : 

 

Here, the given value of 𝑓(𝑥0) is 1800.  
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Screenshot of the outcome of 𝝉𝟑,𝑨𝑷,𝑷𝑺
𝒊 : 

 

Here, point 𝐶 = (𝑥1, 𝑦1) = (28.75, 129.22) (i.e the point called A in 𝜏3,𝐴𝑃,𝑃𝑆
𝑖 ) and 

 𝐴 = (𝑥0, 𝑦0) = (25 , 97.9). 

 

 

PS3’s notes for 𝜏3,𝐴𝑃,𝑃𝑆
𝑖  in Word: 
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PS10’s notes for Worksheet 2: 

 

 

 

 

 

 

 

  


